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Welcome to
Linux Answers!

oy, have | learned some stuff about Linux recently. I've been so wrapped up in
the world of Windows98 for so long, I'd forgotten what it was about computers
that made me get into them in the first place. It was the sense of community, of
mutual support and advice and, of course, the chance to hack some code.
Computing has become so big now that, in a sense, a lot of the above has

become irrelevant. Computing these days is less about the enthusiasts who - lest we not
forget - created the whole business, and more about the corporate market. So it’s been

fantastic to rediscover a community
of computer enthusiasts, full of
passion, missionary zeal and a real
sense of adventure about Linux and
why it's great.

Through Linux, I've rediscovered
the sense that computing can be
fun, subversive, pioneering,
challenging, and empowering, and

You are now holding in
your hands the UK's very

first Linux magazine!

that it need not he about pandering to the slicing-and-dicing approach of modern
marketing-driven corporations. Thanks to the Internet, seriously large numbers of like-
minded people can now get logether and actually challenge these corporations with better

products, on their own turf.

There are interesting times ahead for Linux as it begins to grapple with the ditfering
requirements of the corporate and desktop markets. I want to see Linux do well on the

desktop, to give Windows a run for its money, and it's obviously going to have to become
much easier to use. To do this, it will have to hide much of the stuff that
makes it so attractive to coders, so it's been interesting to see Corel Linux

(see page 14) and what it promises.

So why Linux Answers?

New magazines are always difficult to get right and a Linux
magazine doubly so. Striking a balance between the needs of existing
Linux fans and providing an easy way in for new users has been
tricky. So I hope we've got the balance right. Even if we haven't, no
just write in and tell us what you think as there's plenty
of scope to tweak things so it's exactly what you want in future.

We hope this issue is going to fly ofT the shelves and give us the ammo we need to do it

matter

on a more regular basis, so here’s hoping. I'd like to thank all those people who helped put
the mag together and gave their advice so freely. Cheers!
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Our promises

@ Our objective is to provide information
and tutorials to all Linux users in as clear a
manner as possible. This is the complete
guide to Linux and its uses.

@ We want you, our reader, to feel this is
your magazine, so please write in with your
views and opinions, article suggestions,
reviews, tips and tutorials and we’ll try to
include them in any future issues. Contact us
at linux.answers@futurenet.co.uk

@ We fully support the aims of the Open
Source movement

@ Please note that Linux was developed
under the umbrella of the GNU software
project and, as such, its correct full name is
GNU/Linux. However, within this magazine,
for reasons of readability, we have used the
shortened version, Linux. Find out more
about GNU at www.gnu.org

/,

Nick Merritt
linux.editor@futurenet.co.uk

Technical support

Please note that, due to certain
constraints, we are unable to offer any
technical support for our Cover CD or
answer Linux-related technical queries. So
please don’t phone or email us. Instead,
we strongly suggest you look in these
places for advice:

@ the forums on our Web site — visit it at
www.linuxanswers.co.uk

@ the pcplus.linux newsgroup

@ the extensive collection of HOW-TO files
on our CD

@ the Red Hat Web site at
www.redhat.com

® www.linuxcare.com
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CONTENT

How to get the most
from Linux, quickly
and easily!

50 Secrets of the GIMP

Create great images with this tutorial and
our great CD software!

- 56 20 KDE solutions

We show you how to get the most from

Linux’s easy-to-use graphical user interface

61 Gobbledegeek

Those tricky Linux terms explained and
made easy

62 Mastering Bash

The Linux command-line interface, Bash, is

Heviews

34 PC World Advent Linux PC

Is this PC the ghost of ‘Christmas Past’ or
the shape of things to come?

35 ApplixWare

Linux needs a great application suite. Applix
reckons it has the solution

36 Definite Linux

A UK Linux distribution is aiming to punch
with the big boys. Is it Prince Naseem or the
Artist Formerly Known As Prince?

37 Quake Mission Pack

It's ain't all command lines and bewildering
error messages — Linux has games too,
including the best game of all time, Quake...

unnerving for newcomers. We explain its
mysteries and unravel its commands

64 How to install applications

Installing software is easy with Linux's
RPM and this handy little tutorial...

66 Reinstalling the kernel
It's the heart of Linux and periodically
you'll need to upgrade it. We reveal all

70 Quicker, better, slicker

Discover how you can make more of your
existing Linux installation

38 Freeware
rounda-up
Some of the best
Linux software is
free. We take a
critical look at the
latest batch of
candidates for your
precious disk space

40 Linux Device Drivers
If you find Linux is having problems with
hardware, this may be for you

43 Coderoom superstars
We put six of the most popular Linux
distributions to the test
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Your complete guide to
Linux starts on page 16!
So grab the CD off the
front cover and get
ready to roll

17 What is Linux?
What’s it for? Why is it great? Is it really
better than Windows? Find out here

18 Will Linux run on my PC?
Will your hardware handle it? Do you need
extras? What does Linux need to know?

19 Preparing your hard disk
Before you can install Linux, you need to
grab some space off your hard drive...

20 Making a Linux partition
It’s easy when you know how. Happily, we
do indeed know how

21 How to install Red Hat
It’s on our CD, and with everything
prepared, it’s time to get installing

26 How to install
applications

You’ll find over 600 applications on our
CD. We show you which ones you need

27 Configuring your system
Get your hardware and video working with
Linux rather like this...

29 Connecting to the Net
Linux needs the Web. We show you how to
make it happy

In this issue

6 Linux in action
Find out how Linux is used to
create Hollywood blockbusters

8 The Source

News, Web sites and user groups!
12 Opinion

Paul Ferris explains where Apple
and Microsoft have got it wrong
14 Corel Linux preview
The operating system of the future?

30 Rebels with a cause
We speak to the three key figures of
the Open Source movement

Join the Linux community with our
round-up of UK user groups on page 10

74 Technical support
Dave Coulson, one of the UK's top
Linux experts, solves all your
common problems!

distribution Red Hat 6.0,

Your CD

Get started with Linux —
everything you need is
on our CD!

Includes the world’s
leading Linux

Corel WordPerfect 8, the
wonderful GIMP image editor, KDE, 10
essential Linux tools and utilities, the
complete Linux HOW-TO help

archive and much more! 80
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LINUX
IN ACTION

ux wins an Oscar!

What happens when you mix the effects team behind Titanic, a bit of Linux
and Robin Williams in full syrup mode? What Dreams May Come, the hit
movie now out on video, managed a stunning representation of the afterlife,
thanks to a bit of Linux jiggery-pokery from the team at top effects house

Digital Domain. Its in-house compositing program NUKE was written for
Linux and has helped it win Oscars for this and its biggest hit, Titanic.
* Find out more at www.d2.com

Images: © Digital Domain
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What's happening on Planet Linux...

COMPILE
TIME

Chew the Phat

Two teenage kids are bringing out
Phat Linux, their own Red Hat-
based distribution. Find out whether
you'll be hangin’ with the homeboys
at www.phatlinux.com

Definitely maybe

Definite Linux is on general sale
throughout the UK in two different
boxed sets, standard and advanced
Internet server, with UK installation
support. Derived from Red Hat, it's
aimed at the professional/server
market. (See our review on page
36.) www.dlsl.demon.co.uk

New SuSE

SuSE 6.2 has finally hit the shelves.
Grab yourself a copy at your
nearest distributor.

Xpresso Linux
A new British Linux distribution is

out now. Xpresso Linux is aimed at
the desktop user and you can find
out more details at www

Xpresso.org, or see our batch test
on page 43.

Linux Alpha C

Lucky'Linux users with access to an
Alpha processor are being asked to
help Compag with a beta test of its
new. C and Fortran compilers. It's
available in RPM format, and has so
far been tested under Red Hat 5.2,
with some testing under Red Hat
6.0. Get yourself along to
www.unix.digital.com/linux/
software.htm for downloads.

New spreadsheet

package for Linux

Business Logic has released Xess
Spreadsheet for Linux Standard
Edition 4.2. Xess Spreadsheet for
Linux is the first spreadsheet
designed specifically for X Windows
and Motif. Offering Windows-style
ease-of-use, it provides a full range
of mathematical, statistical,
financial, matrix and string
functions. Visit www.blcorp.com

8 LiNUX ANSWERS

Sun devours Star

STAROFFICE 5.1 Sun Microsystems to target Office2000
users with StarOffice giveaway

The news that Sun Microsystems
has bought the top application suite
StarOffice has given Linux yet
another boost, but all may not be
whalt il seems.

Sun is continuing to give
StarOffice away, which on the face of
it seems pretty public-spirited, until
you realise who Sun’s target is.

Enter, incvitably, Microsoft, 40
per cent of whose revenues derive
from its own Office97 and
Office2000 applications. Despite
denials from Sun’s CEO Scott
McNealy, Sun’s move will be seen in
Redmond as a direct threat to
Office’s dominance and strengthens
Sun’s ability to sell its server
products against Microsoft’s.

StarOffice 5.1 is compatible with
many of Office’s most widely-used
file types, and Sun's move will give
Office users planning to upgrade to
the 2000 version pause for thought.

But Open Source advocates have
been wondering if this move is

File Watcher
filewatcher.org/cat/New_Files.html
This is home to pretty much all the
Linux files, games, applications and
50 on you could want.

Track the latest updates and
download them here. It's one of the
most comprehensive depository of
Linux stuff on the Weh.

Linux hardware.net
www.linuxhardware.net/

If you are looking to upgrade your
PC and want to know if Linux
supports it, find out here. Driver
information, help and more is
available as well.
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necessarily a good thing for Linux.
Inspection of the StarOffice licence
agreement reveals that Sun is
releasing StarOffice under the same
proprietary terms as Java.

However, in the short term, the

LinuxApps
www.linuxapps.com/

New Linux utilities and tools
available for download right here.

Linux Hardware Database
hd.datapower.com/

Got a compatibility problem with a
piece of hardware? Check this site
and find a solution.

Koules
www.paru.cas.cz/~hubicka/koules
[English/koules.html

It’s already been described as a
classic Linux game; now it’s time to
try it for yourself.

backing of a large commercial
concern for one of Linux’s killer
apps has to be a good thing -
provided Sun doesn’t decide to
change its mind and charge for it in
the future.

(B LT\ 11 Y
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The best-selling
software at PC World
for September 1999

We had to stick this in... check
number 10 and you'll see why

. Tiberian Sun

. Office 2000 Pro. Upgrade

. Windows 98 Upgrade v2

. Office 2000 Premium Upgrade

Norton SystemWorks v2
. Instant Accounting 2000
. Viruscan Classic
Textbridge Pro 98 & Paperport

1
2
L
4
5. VoiceXpress Professional
6
7
8
5
10. Linux-Mandrake Deluxe 6.0

Have you got the latest kernel! If not upgrade to 2.2.12 now at kernelnotes.org
0000009000090 O0COCO®O®O0E®O®®®O®OPOODTOPSPOPOPODODPS O OO
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GNU beats the snoopers

PRIVACY Linux users worldwide finally get 128-bit encryption

Linux users worldwide now have
access to near-unbreakable 128-bit
encryplion, thanks to the GNU free
soltware project.

GNU Privacy Guard (GnuPG)
has been developed outside the

1
1
1
I
1
I
1
]
1
1
[
[}

United States. It uses no patented
algorithms, and is therefore exempt
from infamous export restrictions on
128-bit encryption technology. This
means that anyone in the world can
have access to the most powerful

GnuPG features in a nutshell

@ Full replacement for PGP (Pretty
Good Privacy)

@ Does not use any patented
algorithms.

@ GPLed, written from scratch

@ Can be used as a filter program

@ Full OpenPGP implementation

@ Better functionality than PGP
and some security enhancements

ﬁ% {@‘M =

ARy
v

L\‘

@ Decrypts and verifies PGP 5.x
messages

@ User id is created in a standard
format for compatibility

@ Support built in for a key
expiration date

® Online help

@ Integrated support for HKP
keyservers (www.keys.pgp.net)

commercially-available software.
Brian Youmans, from the Free
Software Foundation, commented:
“This was all developed outside the
US, and that was done deliberately
so GnuPG could be distributed hoth
inside and outside the US. The
project is not a formal project of the
Foundation itself, and we didn’t
actually pay anyone to work on i,
bul we are certainly very glad that
it happened.”

Gnul’G has been in beta lor

nearly a year
www.gnupg.linux.it

and is also
available for
Windows98 in trial form.

Who's been mukmg waves in the world of Llnux...

Dell gets the Linux taste

Dell Computer is adding Linux to its
popular Dimension

desktop PCs. Linux

will be offered as an

option alongside Microsolt's
Windows95, 98 and NT.

KOffice strengthens team

The team behind the KDE interface
is tcaming up with Mandrake to
develop KOffice,

an office package
for Linux. KOffice

currently includes a word processor
with some desktop publishing
features, a spreadsheet, a
presentation application, a vector
drawing program, a diagram creator,
a formula editor and an image
viewer. IU's also possible to embed

1
1
1
1
]
1
1
1
1
1
1
1
1
[}
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
]
1
1
1
|
|
|
1
1
|
1
1
1
I

any KOffice component in a different
KOffice application — mixing a
spreadsheet and a word processor
document, for example.

Linux addresses 4Gb RAM
Teams from SuSE and Siemens have
completed a Linux extension which
allows the use of up o 4Gb of
memory on Intel-based servers. Grab
the patch at the SuSE FIP server
(sce www.suse.com/ftp_new.html).

KDE sponsorship boost

KDE got a boost earlier this month
when the second developer meeting
was supported by SuSE and Caldera.
Fifty KDE core developers from all
over the world came together to
work on the future development of
KDE. Waldo Bastian, KDE core

developer, said: “Although we are in
constant contact via the Internet,
most of us have never met each
other in person.” SuSE commented:
“By supporting events like this we
make sure that the KDE team can
continue its marvellous work at an
even [aster pace.”

Inprise hot for Linux

Inprise, maker of Borland
development tools, is suppurting'
Linux, with C,

C++ and Delphi
on their way.

Borland is also to team up with
Corel to joint-promote each other’s
forthcoming Linux products. Finally,
J-Builder, Borland’s Java compiler, is
available now for preview at
www.borland. com/jbuilder/linux

State of play

The GNOME versus KDE debate
has been raging wildly on the
peplus.linux newsgroup, so it's great
to be able to quote some real
numbers (thanks to Linux Journal)
and further wind up one set of

protagonists over the other. Sadly it's
had news for the GNOMEite faction.

Matt Chapman’s site at www.plig
.org/xwinman/others.html lists a
bunch of window managers. In a
recent volte, the favourite was
Window-Maker (35% of votes cast),
followed by Afterstep (16%). KDE
strolled in with 16%, But despite
GNOME’s rugged good looks, the
poor thing staggered in bleeding
with just 5%. We don’t want to say
any more... (ducks quickly).

Gartner Group
reported that in
1998, 65% of
developers identified
Windows as their
primary target
platform. In 2000,
Gartner is predicting
that number goes
down 10 40%. Why?
The developers want
alternatives to a
shrinking Windows
base

— Bob St John, Serenity Systems

ESSENTIAL LINUX 4 books you simply must read

Teach Yourself Linux in 10
Minutes
John Ray

ISBN: 0-672-31524-6
RRP: £10.99
Tel: 0845 147 3626

This is aimed at Linux
beginners to people
who have some Linux
knowledge. Work your
way through basic Linux commands
and learn about the Linux
environment, file utilities and
customising your environment.

iit] [] Winites

The Artists’ Guide to the
GIMP
Michael ] Hammel

ISBN: 1-57831-011-3
£27.03
Tel: 0845 147 3626

Find your way round

the GIMP, the

Photoshop-quality
image-manipulation

program, with this cleanly laid out
getting started guide, Plus find all the
tools you need to get creative on the
accompanying CD.

Linux Installation and
Getting Started
Matt Welsh

ISBN: 0-916151-78-6
£13.00
Tel: 0845 147 3626

This concentrates on

the Slackware distros

of Linux but is |

applicable to all & !
variants. It comes with a tutorial for
the beginner and moves on to cover
more technical stuff such as net-
working with TCP/IP for the expert.

Linux Undercover
Edited by Eric S Raymond

ISBN: 1-88817205-3
£25.00
Tel: 0845 147 3626

You'd have to be

pretty dedicated to

Linux to read all

2,000 pages of this

tome. That said, it

has sections for beginners and
experts alike, covering everything
from the history of Linux to the GNU
Public Licence. A big read.

Premiére issue
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vities, abou

To fmd out what s haﬁfemng
nea“r \you, take a look af this -
gmde (Thanks to all- those who
| responded to our, requests for
. information.) To see the full
.. uiser group list, visit
www.lug.org.uk

)

There’s also a list called

Contact: tynelug-owner@egroups.com
Web: www.egroups.com/group/ivnelua/

What's happening: the Web site cont

and advice

TYNESIDE

members so fz

. bits@lists.lug.org.uk where S
| you'can place your “wanted” = 2. @Rt o
77 and “for sale” items for barter..~ -
““You'll have to subscribe first as' - BEW i
: it a closed list. Good luck! A

ity of Leeds
ures, demos

: John Heaton john@manchester.ac.uk

Web: www.manlug.man.ac.uk
i Mailing lists: manlug@mcc.ac.uk,

Mailing list: wylug@scs.leeds.ac.uk
B linux-users@mcc.ac.u

Web: www.scs.leeds.ac.uk/wylug
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x
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X -
b
o
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8l ji@scs.leeds.ac.uk

MANCHESTER

Next meeting: 20.11
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By your co

A command line is a
different animal: it
demands training; it
demands that you
read manuals; it
demands patience
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have this thing about
command line operation.

I love it. I'm crazy, of course. Any ‘modern’

operating system is GUI based. Everyone knows

that. Everyone, that is, apart from me and a few

million other UNIX/Linux fanatics. The so-called
‘modern’ GUI is a Bad Thing™. That said, [ have become
fond of GNOME and KDE: both are fine examples of
modern GUIs; both are going to attract scores of new
Linux converts.

I'm not suggesting a GUI is to be done away with.
On the contrary, | use my GUI to open terminal windows
and type commands, edit text, create HTML and so on.
No, I'm attacking the assumption that it’s a more modern
method of computing. A GUI is not a command line
replacement. If anything, a GUI is more a way to
automate some commonly executed tasks. It's this
automation that makes it attractive, but it’s this very
automation that also makes it a hobbling device.

One of the reasons that I'm an avid Linux supporter
is that the system was built [rom the ground up on the
assumption that the underpinnings would be UNIX-like,
with a good, solid command line interpreter (o manage
things. This is important because, aller years of working
with computing, I've found that
while | can gel extremely far with
my automation ol UNIX, my fellow
Windows and Mac users are still
plodding along fighting some of the
most basic automation tasks. A lot
of them are unaware of command
line-based tools in their toolboxes.

My synopsis is that if you
present a new user with a GUI, and
they never touch a command line,
they begin to associate that GUI
with the operating system itself. If
they can’t do the task the way that the GUI designer
intended, and have no experience with command line
operation, they are limited to the thoughts that the GUI
designer had in mind while creating the heast. At best
it’s just what the doctor ordered: easy completion of a
commonask. At worst, it's demoralising. It's taking
away the control that the user has and placing it in the

mind of the person who coded the interface.

Big on demands

A command line is a different animal: it demands
training; it demands that you read manuals; it demands
patience. But, in the long run, it delivers so much more.
AL best it's very efTicient - often a good command
line operator can surpass the efficiency of a GUI inter
face. At worst it's an animal thal requires more (raining
or more study. But it is in the pinches and trenches ol
mis-operation that a command line shines. A good

[ B B B BN BN BN BN BN BN BN BN B BN AN BN BN N OB N
Premiere issue

I
I
I
I
]
]
I
1
]
1
1
1
i
1
]
i
[}
!
I
]
1
1
1
L]
1
]
1
]
1
1
1
1
1
1
1
1
1
1
1
1
I
1
L}
1
1
1
1
1
1
1
1
[}
1
1
L}
1
1
1
I
1
I
1
i
1
I
1
|
1
I
1
1
1
I
I
!
I
1
1
I
I
1
1
I
I
|
1
I
I
I
I
I
I
I
I
|
I
I
I
I
I
I
I
I
|
I
[
I
I
I
I
[
]
]
1
I
]
]
1
1

command line user can work around a problem or
accomplish a task in a multitude of ways that would be
missing from a GUI - even a well thought-out one.

And so back to where [ started: Linux as compared
to Mac or Windows. Although Windows-based sysiems
ship with something that is referred Lo as a command
line interpreter, the truth of the matter is that this is to
be treated as a last resorl. With the advent of the so-
called New Technology (Windows NT), the command line
is only partially capable of accomplishing total
configuration ol the operating system. In other words,
Microsoft inhaled Apple's smoke.

Learning while doing

By embracing this paradigm, Microsoft shut out the
ability for end users to learn more than just what was
available at the time of programming. I'll even go one
step further here: both Microsoft and Apple removed the
power for the user to innovate on the desktop. They
removed the tools needed to create automation on the
Mly. I'm not talking joke items like the hokey Windows
macro recorder here; I'm talking real automation that
you can count on day in and day out, automation based
upon standards that don’t change in the wind.

And they still don’t get it. Microsoft will make
available Korn shell for Windows 2000 (part of a UNIX
option pack heing rolled into the NT series), but it hasn’t
embraced the power of Linux - NT still has a lot of tasks
that are totally GUI-centric.

Thinking outside the box entails a lot. It means
giving up on ideas that limit perception and therefore
limit the possibilities available. Giving a user just a Gl
is like providing them with a car but removing the gas
pedal: they can get there, but mysteriously it's just not

LINUX

e Paul is a columnist for Linux Today :

as last as you think it could be,

Apple thought it had laid this ghost to rest. Paul Ferris disagrees
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Got something to sell? Looking for a great buy?
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Computers © Electronic equipment® Sports memorabilia * Books, );
Music & Movies * Antiques ® Coins & stamps ¢ Collectibles ¢ Dolls * .
Jewellery * Pottery & glass ® Toys * And much more... -

e-mail us at ukenquiries@ebay.com



PRE-TEST: COREL LINUX

Is this the Linux to take on Windows98?

A new Linux is coming which has big
company backing, is compatible with
Windows applications and promises to be
easier fo use than anything else out there.
Chris Jones asks: is Corel Linux the next
big thing or is it too good to be true?

ouldn't it be great to have a version of
Linux for desktop PCs that's as easy to
use as Windows, has few installation
hassles, and plenty of applications
ready to go?

This is what Corel is hoping to achicve with the
release ol Corel Linux. We've been lucky enough to have
the chance to see an early version of it - the complete
installation should be available in January.

Early versions of Linux used complex installation
processes and quickly gained a reputation for being hard
to get to grips with. While most have opted for simple
text-based installers, a few have started to use graphical
installers in the hope of making the process easier and
morc in line with what people are used to. Corel is
addressing this in some depth. One example is that it
will no longer be necessary to partition the hard drive
when installing Corel Linux alongside Windows.

Getting going

The two remaining key areas where Linux fails to make
the grade for a desktop operating system are applications
and the desktop itself. Without the former, the operating
system serves no useful purpose, and without a friendly

Does Windows emulation work?

No matter how good Corel Linux is, there is a staggering number of
applications out there that need Windows to run on. To combat this, Corel
has chosen to ship WINE with its distribution. WINE is a project that aims to
allow unmeodified Windows programs to run seamlessly on Linux. It does this
by providing a Linux implementation of all the Windows system functions an
application needs to run, access files, print, etc.

The WINE authors have set themselves a mammoth task, especially
considering the size of the Windows libraries they have to replace.
Development has been underway for several years, and since January this
year, Corel has had a team of developers working with the WINE authors to
speed up its progress (being an Open Source project, all the
changes/improvements Corel makes to WINE are freely available).

At the time of writing, around 90 per cent of the total project had been
completed and it runs Corel’s existing Windows applications very well - as
fast, if not faster than in Windows with the same features and the added
bonuses that Linux brings. This is a real boon for all users of Linux, not just
Corel’s users, as they can run all their applications, Windows and Linux from
a single operating system.
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desktop interface, it is hard to use and presents a huge The Control
learning curve to inexperienced users. Centre provides a
Corel Linux will be the easiest operati tem o Sopla-hirema
inux wi ; siest operating sys l’l'.ﬂ n Kiliiface to the
the market. After booting from the CD or a boot disk, more complicated
you are presented with a few simple questions, after configuration
which the software is installed (this can take as little as t!"“‘mts"':
four minutes on a reasonably capable machine). A reboot c:::l:'[xg'usrlil;g ;s
later and Linux is installed on the machine and ready to Windows' display
use, (IU's worth noting that apart [rom a substaniial core modes
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change like a kernel upgrade, everything on a Linux i
machine is configurable withoul having to reboot.) :
Confliguring the system is also easy, thanks to the -
single GUI-based control centre, something you will need |
to use if you are connected to a network. The Corel !
installer configures as much of the system as it can |
without user intervention using Linux's Plug-and-Play |
support, but you do have to enter some setiings (such as i
network IP addresses, ete). !
One of the areas in which Linux has traditionally :
been unhelpful for new users is that of drives and :
printers — unlike in Windows, inserting a CD-ROM is not |
enough (o access it, the operaling system must be told it |
is there before it will allow you to use i, Corel has done |
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£SOURCE

away with this, and when a storage medium of some
kind is inserted (cg a CD-ROM, Zip Disk, etc), it will he
available for use straightaway.

| B9 control Contor
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Support

A downside of something as complex as Linux is that
there is a lot that can go wrong, from misconfigurations
to incompatibilities with hardware. Some of the existing
Linux distributors provide limited installation support
and the facility to purchase [urther support as required.
Corel will be offering a similar support structure, but has
the advantage over other distributors of having several
years of experience supporting its own applications.

It is working with the existing Linux support
company LinuxCare to provide its users with access to
the best Linux support available and a range of support
plans from per-incident charging to 24x7 support
contracts. It also supplies high-quality online help and

B samba Configuration
PPrinters
- Bwindows
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forel Monx Instatlas .uu- ;m i.n choost: 84
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printed manuals to guide you through the installation ] I | | As with the
2 - : ‘saznor to oash Inetall sechod ! .
and introduce you to Linux. e Tl s e k{14 abost aach cgtLeas ! Control Panel in
. Windows,

‘Weing the gsontrols balow, BOlodt thu type of
nformatis f you l.iht.ohmmm mm

| everything can be

o ! configured from a
1
pl‘ll‘llll‘!g . single point, in
Using the experience gained from creating WordPerfect i i this case,
(which is renowned for its excellent printing support), ek Sy i o networking

Corel has enhanced the printing and font capabilities in
Corel Linux to make it not only easier to use than the
somewhat archaic printing systems Linux inherited from
the UNIXes, but also to make it more powerful and
higher quality, especially font rasterising - the process of
turning the text seen on screen into an image that looks
the same on paper.

A big problem with distributing software for Linux
and Linux distributions is that there is still litfle support
from retail chains (although this is changing, particularly
in the USA), and while a typical local computer shop
may have hundreds of Windows software titles available,
it probably only has one or two Linux ones.

While it may appal the ‘old guard’ UNIX and Linux
users that their operating systems are becoming easy to

_._I._~.-.-|_-.__J_"_°1L|

Some simple questions and a few
minutes of installing are all that stands
between you and Corel Linux
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Corel Linux at-a-glance

Here’s a brief comparison of what To come: Corel Package Manager
Linux currently offers and how provides easy click-and-install
Corel Linux is aiming to improve it: access to upgrades and so on

use, Linux is flexible enough that it can suit all users, Installatlor! ) Applications
from the most expericnced kernel hacker (o the beginner. Now: unintuitive and complex Now: mostly freeware with the odd
Corel Linux promises to be very much what procedure involving partitioning, commercial-type application such
the-desktop PC has been crying: otk for LiNUX configuration, unfriendly prompts as StarOffice
which can take an hour or more To come: support for a raft of

. s . To come: no partitioning, simple Corel’s application suites such as
Core.l Linux is cf"rently ina c!osed graphical installation, aim is a four- WordPerfect Office, CorelDRAW!
public beta testing stage and is expected minute installation. Plus Plug-and-  and QuattroPro

to be released in lanuary with Play-style hardware configuration

ibili
WordPerfect Office 2000 for Linux to O D

Hardware detection, drivers Now: limited cross-fertilisation
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follow in February. Now: UNIX-style ‘telling Linux between Linux and Windows files
what is there before it can be Te come: Corel Linux will ship
5 accessed’ with WINE, the powerful native
New ways to manage flles : To come: auto-mounting Windows emulator. This means you
CD-ROMs, ZIP disks, etc should be able to run nearly all
Most Linux users are used to accessing their files via shell commands typed your current Windows applications
into a terminal window, rather than the visual process that the majority of File management within Linux as fast as in Windows
Windows users are familiar with, and this is another concern Corel has Now: access to files by typing shell
addressed by developing the Corel File Manager. Working in a similar commands into a terminal window Open Source
fashion to Windows Explorer, CFM makes it easy to view and manipulate the To come: Windows Explorer-style Now: concerns in several quarters
contents of local and network drives (as well as having an integrated Web file management, integrated FTP that Corel would commercialise
and FTP browser). and Web support aspects of Linux to the detriment of |
The network drive support includes SMB (Windows sharing) and NFS (a the Open Source movement
UNIX file sharing system), something that will make integrating a Linux Installing software To come: enhancements above,
machine into an existing network simple. The graphical login presented Now: use of the package manager like the Corel File Manager, are
when the system boots also allows the user to log into their network to install and remove programs and being released under the Open
‘domain’ (a facility used widely on Windows networks). upgrades Source licence
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[llustrations: Eddie Bowen

Whether you want to dip your
toe into the water or jump right
in up to your neck, the time to
discover Linux has arrived. Over
the next 14 pages, we explain
what Linux is, what you can use
it for and how to install it from
our Cover CD. Vince Veselosky
reveals all

\

START HERE!
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1 What is Linux!

Developed by enthusiasts and given away for free, it's the
fostest-growing operating system in the world. But why?

elcome to Linux, the
fastest-growing
operating system in the
world. Linux is brilliant
and we're going to
show you why millions of people around
the world agree.

Linux is a variant of UNIX and was
created in 1991 partly as a reaction against
the poor quality of operating system
design from Microsoft, and partly as a step
in support of the Open Source movement
(see page 30).

Poor operating system design isn’t just
a technical issue - it aftects a PC’s
performance and locks people into
expensive upgrade cycles. Most of us have
suffered the frustrations of Windows
crashing at the most inopportune moment,
and many of us have cursed at having to
upgrade our hardware because the latest
release of Windows is so bloated it will
hardly move without the newest gear.
Linux avoids all this.

Linux offers the user unrivalled control
over PC hardware, but the trade-oft is that
it is still some way short of the case of use
offered by Windows or MacOS$§ (although
this is changing fast). This manifests itself
in several ways. First, there are six or so

major Linux distributions (or versions) and
countless other minor ones, not all of them
100 per cent compatible with each other
(see page 43).

Second, most of the Linuxes, being
hased on UNIX, use an unintuitive set of
DOS-like commands. This won’t worry
computer scientists but it does provide a
barrier if you are used to graphical user
interfaces (GUIs) like Windows. The Linux
community has recognised this and there
are now numerous GUIs available. The
two main ones are GNOME and KDE.
Both have their fans and detractors but, at
the final count, each is probahly as good
as the other. :

However, in the interests of simplicity
and for the purposes of this feature, we're
going to concentrate on KDE.

What is the kernel?

The most important part of Linux is the
kernel. This handles the computer’s most
fundamental input/output operations,
schedules processing, deals with the
memory and contains the major hardware
drivers apart from graphics.

The kernel is the most frequently
upgraded part of Linux and the same

Why you’ll want to give it a try

kernel is common to all the different
flavours of Linux around. It is able to
maintain this coherence because its
definitive form is edited and tweaked by
Linus Torvalds himself from submissions
from a number of kernel developers
around the world.

New versions of the kernel are
periodically released over the Internet.
Therefore, it's important to know which
kernel you have and how to upgrade it
when a new ane appears.

The most up-to-date kernel is version
2.2.12. The first number is the major
version. The second is the minor version.
The third is the revision level. As you
might expect with any software product,
the revision level frequently changes.

Any kernel whose minor version is an
odd number is a beta and is probably
unstable. Don’t install it. Conversely, an
even number means it's stable. Version
2.4.x is just around the corner and you’ll
be able to upgrade it yourself with the help
of our guide on page 66.

Now il's time to look at Red Hat 6.0
(on our Cover CD) to see what Linux can
do for you. Installing it takes about an
hour and requires some planning, so let’s
get started.

So is Linux really better than Windows?

DID YOU
KNOW...1
The
smallest
penguin
today
weighs in
at 1Kg
and is
40cm tall

If you use Windows for little more than word
processing, then swapping to Linux is not for
you... at least, not yet. However, if you are more
of a power user, there are ten good reasons why
you may want to make the switch:

Linux rarely crashes and any bugs that are

found are fixed immediately by the Linux
community. Patches can be available within
hours. This means you don’t have to back up or
maintain your distribution to the same extent

Most Linux distributions come with

hundreds of pounds’ worth of quality
software for free, including WordPerfect 8,
StarOffice and GIMP the Photoshop-quality
image-editing program (see page 50)

Linux is small and fast — you can happily run
it on a 486

Linux removes you from the Wintel upgrade
cycle as core elements of the operating
system can be upgraded separately for free

Free user support — many Linux distributions
provide you with free technical support and
advice, unlike Microsoft

Linux handles multiple processors; also
facilitates sharing of computing resources
over a network

Multiple customisable desktops each with its
own high level of security, beating Windows’

User Profiles hands down. Plus you can pick the
version of Linux that most suits your needs (see
page 43)

8 True multi-tasking

Customisable source code — this won't

interest any but the most committed Linux
enthusiasts, but this allows you to rewrite the
kernel yourself to adapt it your PC's own

particular quirks

1 Linux comes with the ability to install
and run it alongside Windows. This

allows you to continue to access your important

Windows files — the best of both worlds
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START HERE!

~ 2 Will Linux

IT'S ON
THE €D

run on my PQ?

Before you can crack on and install Red Hat Linux
on your PC, you need to find out some essential

ed Hat Linux has been the
most popular distribution of
Linux for many years now.
One of the reasons for this is
that the Red Hat installation
process is one of the casiest. However,
installing an operating system still requires
a fair amount of knowledge and skill, and
there are bound to be bumps along the
way. This tutorial should help to smooth
them out.

For this tutorial we are assuming that
you have a computer that already has
Windows installed and that you want to
share the computer, or dual boot, between
Windows and Linux rather than replace
your existing operating system. We are
also assuming that you have a fair amount
of computing knowledge and expertise —
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info about your PC...

this is not for computer beginners. If you
arc installing Linux on a fresh system
without another operating system, this
tutorial will still get you there - you will
just need to skip a few steps that are
specific to a dual-boot arrangement.

Before you start you need to check
that your hardware is
compatible with Linux.
Go to ‘Support’ on Red
Hat’s Web site and check out your
machine’s specs.

WHAT DO | NEED
TO DO FIRST?

Before you can run Linux
successfully on your PC, Linux

How to find out what hardware is installed in your PC

Hardware item

What you need to find out

Where you'll get the information

needs to know some important
information about the hardware
you are using.

You can get nearly all this information
from Windows95 or 98, so grab a pen and
paper because you're going to need to
write some things down. Take a look at the
table below to sce what you need to find
out, and where to look. (When accessing
the Windows Control Panel, remember to
click on the relevant item to get the
information you need!)

Once you have collated all this
information, hang on to it for the moment,
because you'll need it later when installing
Linux on your system.

Okay, that done, you are now ready to
move on to stage three.

Hard drive

RAM

CD-ROM drives

Any SCSI adaptors

Mouse

Video card

Monitor

1) Number, size and type of each drive

2) Which drive is primary, secondary, etc

3) Which drives are IDE or SCSI
4) BIOS settings for IDE drives

Amount

Make & model

any serial port settings

Make & model, video RAM

Horizontal and vertical refresh rates

Make & model of non-IDE/non-SCSI drives

Type, protocol, number of buttons,

BIOS

Windows: Control Panel/System/System Properties/General

Windows: Control Panel/System/System Properties/Device Manager

Windows: Control Panel/System/System Properties/Device Manager

Windows: Control Panel/System/System Properties/Device Manager

Windows: Control Panel/System/System Properties/Device Manager

Card documentation

Monitor documentation or Web site

LA A A B A RS EE N R E R N N N N N R E R R EE Y
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START HERE!
3 How do | prepare

my hard disk!

Before you can install Linux alongside Windows,
you need to grab some hard drive space from
Windows. Luckily, there’s a tool to do it...

ver the next few pages we're

going to talk about how to

resize your Windows

partition in order to create

space for Linux. Then we'll
talk about how to use that reclaimed space
to create a new partition for Linux.

We're assuming that you have only one
partition at the moment (the Windows
one) and that it's Scandisked and healthy.

First, the background to what what
we're going to do: as Windows is hogging
the entire hard drive at the moment, we
need to shrink this Windows partition to
make room for our new Linux ones.
Unfortunately, most operating systems do
not have the built-in ability to resize their
own partitions.

However each Linux distribution
comes with tools for resizing Windows
partitions. For Red Hat, that tool is FIPS,

before you can resize your Windows
partition using FIPS, you must do the
following things:

Delete any files from your hard drive
H that are not being used, for example
any old files in the C:\windows\lemp
folder, and then empty your recycle hin.

Check your file system for errors

using Scandisk.

Make a note of how much space is

available on your hard disk. If this is
less than the space required to load Linux
(600Mb - 1.6Gh, depending on what you
want to install), you will need to delete
more files or uninstall some software to
make room.

Finally, defragment your hard drive.

The purpose of this step is to
consolidate all your data at the ‘“front’ of
the drive so there is room at the ‘back’ for
your new partition. Remember that the
new partition will contain only empty
space, so the free clusters on your drive

Theretore, make sure the Defragmentation
Method is set to ‘Full defragmentation
(both files and free space)’.

If you are using Windows98, uncheck
the option ‘Rearrange program files so my
programs start faster’ to achieve the same
effect. This process can take from a few
minutes to several hours.

If a six-fool penguin clamps your
PC, lie down, take a few days off
work and see your doctor

We need to shrink
the Windows
partition to make
room for our
new Linux ones

the First Interactive Partition Splitter. You
will find FIPS on your Red Hat Linux CD-
ROM in the directory called DOSUTILS.

We'll show you how to use FIPS
overleaf - it’s not the easiest piece of
software to use in the world, so if you have
PartitionMagic, or something that performs
a similar resizing function, we suggest that
you use that instead. However, if not,
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must be adjacent to each other to be used.

WARNING

FIPS is an
experimental
product. As such we
cannot accept any
responsibility or
liability for damage
resulting from your
use or misuse of
FIPS. Before you
begin, make sure
you back up your
system and that your
backup is usable
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START HERE!

~ 4 How do | make a
Linux partition?

With the hard drive prepared and ready for partitioning,
you can now create the Linux partition itself
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The dangers of dating a girl
from www.linuxchix.org soon

became apparent
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emember that the aim of

using FIPS is to create space

that will then be used for the

Linux partition. Before using

EIPS, read the FIPS.DOC text
file which accompanies the program. Also,
when running FIPS you should carefully
read all the messages it displays. Most
importantly, FIPS comes with no warranty.
Although it has been used safely many
times, there is always the chance it could
damage the data on your hard drive. So
back up your data now.

For safety, vou'll need to create a DOS
or Windows boot disk to work from. Then
you'll need to copy the working files for
FIPS to the floppy. The files FIPS.EXE,

Premiére issue

RESTORRB.EXE, and ERRORS.TXT are
mandatory. You may also want to copy the
documentation files included with FIPS.
You can find all these files on our CD
under the DOSUTILS directory. If more
than one version of FIPS is present, you
should usc the most recent version to get
the best support for Windows98 FAT32
drives. When your data is backed up and
you are ready Lo go, reslarl your computer
and boot from the new floppy.

When you arrive at the A:\>; prompt,

type FIPS and press Enter, The first

thing you will see is a warning
about using FIPS in
multitasking environments
such as Windows. As we
booted from a floppy we are
safe here, so press Enter. Next
FIPS will analyse your
cxisting partitions. It may
pause for a long time at
‘Checking FAT" and
‘Searching for Free Space’.
This is normal, so just wail,
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The bigger your hard drive, the longer this
takes. When FIPS is done with its analysis,
it displays the results. You may get a
warning of something wrong with your
FAT. Read the message carefully and you
will find that this is normal with large hard
drives and won't prevent FIPS from
working properly. (Remember, always read
the messages!)

Making adiustments

Next FIPS will show you how it plans to
split the existing partition and you will
have the opportunity to make changes. By
default, FIPS appears to take two thirds of
the available free space for the new
partition it creates. You may want to adjust
the partitions to allow Windows to keep
more space, especially if you plan to install
any new software on Windows. Adjust

If you value your
data, back it up
before you begin

yours based on your own needs, but we’d
recommend using at least 1,024Mb for
cach operating system, space permitting.
Use the Up and Down arrow keys to
make large changes (10 cylinders at a time)
and the Left and Right arrow keys for
small ones (1 cylinder at a time). The size
of the existing partition is shown on the
left and the size of your new partition on
the right. In the middle is the cylinder
number where the split will take place.
When you are satisfied with your new
partition plan, press Enter. FIPS displays
information about the new partitions and



asks permission to write it to disk. Your
hard drive has not been altered at this
point. You may choose to write this
configuration to disk or re-edit the
partition table, which starts the process
over from the beginning. On our test
machine, when we chose to re-edit we
received an error message that said FIPS
couldn’t find some files it needed. If this
happens to you, just press Control-Alt-
Delete to reboot from the floppy and start
over, This did not cause us any trouble.

Time to back up

When you choose to write the new
partitions, FIPS will offer to make a
backup ol your existing boot sector. Unless
you like living dangerously, you should
definitely do this. The backup file it creates
is only 1K in size, and it will be invaluable
if anything goes wrong.

Alter FIPS completes its work it
displays another message instructing you

2920090000 OPO®OPDPO®OS

Unless you like
living dangerously,
you should
definitely back up

to run Scandisk on your old partition. We
found that Windows sometimes
miscalculates the used and free space on
our drive after using FIPS, but Scandisk
corrects this problem. If you choose to
restore your original partition scheme
using the RESTORRB utility, you should
run Scandisk after this as well.

After FIPS was done, we received
another error: ‘Memory Allocation Error,
Unable to Load COMMAND.COM’.
Apparently this is a common message and
nothing to he alarmed ahout. If you see
this, just press Control-Alt-Delete to

0 SO0eOOCOOCOODPEOEOOES

reboot and all should be well. Your hard
drive should be unaffected by this.

At this point, FIPS has made space and
has created a second partition using this
space. Both partitions will be designated as
‘Primary’. The second partition, the one
we've just created, is now occupying the
space where you'll want to install Linux.

Now for the slightly confusing bit: the
Linux setup utility, when it's run, will want
Lo create its oawn partitions in this space, so
you need to delete the partition you've just
created (it’s the space we're interested in
at the moment, rather than the partition
itself, so don’t worry aboul it).

Do this now by booting from a DOS
boot floppy and running the DOS utility
FDISK from the DOS prompt. Note: this is
not the same utility as the similarly-named
Linux utility fdisk!

Be careful! Do #ot delete the first
partition. That is where Windows lives!
If you do, you will lose all your
Windows programs and data.

5 How to install

Red Hat 6.0

With your hard drive prepared and Windows resized,
it'’s time to insert our cover CD and get going!
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1) RUN LINUX SETUP

This is the program which installs
Linux for you. This is what you'll
need to do:

First pop in the Linux CD and reboot.
Linux setup will begin automatically. (You
may need to adjust settings in your PC’s
BIOS Setup utility. Consult your hardware
documentation [irst.)

If this doesn’t work, you will need to
make boot floppies from the image files on
our CD. This is vital as it protects your PC
from crashes and lost data.

On our CD there’s a directory called
‘images’, which contains a series of floppy
disk image files. For Red Hat Linux, there
are two primary hootable disk images:
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boot.img is uscd for local installations (eg
from a CD-ROM); bootnet.img is used for
installing Linux across a network or the
Internet. There is also a pcmcia.img for
laptop installs that require the support of a
PCMCIA device (eg a network card).

On a DOS or Windows system, you
cannot simply copy one of these files to a
floppy disk. You must use a special utility
called ‘rawrite.exe’, which you will find in
the DOSUTILS directory on our Cover CD.
This is a simple program and very easy for
beginners to use.

Just start it by typing its name at the
command prompt (you may need to type
the complete path name or change to the
dircctory where rawrite lives).

It will then prompt vou for the name of
an image file to use (full path name
required) and a destination drive. Wait a
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IT'S ON
THE €D
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g

DID YOU |
KNOW...! !
Older
penguins |
can be |
more
faithful to |
their mate |
- if both |
survive |
the winter
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STAGE A: What you'’ll see first

The first stages
of installation

The first phase of the Installation concerns making
sure your PC can recognise what's going on:

The first screen is merely a boot screen. You can press the
different function keys and read about what it can do. When you
are ready to begin, hit Enter

Note at the bottom of the screen the list of available keys. This is
consistent throughout the install process, so if you are not sure
what to do next, check the bottom line for options. It does not
mention that Enter can be used to select items as well as Space.
Sorry, no mouse support in the setup program. Press QK to continue

| 9 First you are

| asked to select
| a default language
and keyboard

| layout. Your choice
| should be obvious

4 Select an installation method. Most will install from the
CD-ROM, but if you downloaded Linux from the Internet, or if
your CD-ROM is not supported by Linux (unlikely but possible),
you can install Linux from files on your hard drive. If you see
options here like FTP, SMB, etc, you made the booinet.img
floppy when you wanted the boot.img floppy. Select Local
CD-ROM and you will be asked to insert the Linux CD. Once the
CD is in place, press 0K

few minutes, and you've got yourself a
boot disk.

2) PLANNING THE
LINUX PARTITION

If you've reached step 8 in the
box above, you'll need to know
more about your Linux partition
and how to construct it...

create the partition).

If you are new to Linux, and you like to

Linux partitions. These three partitions
shall be called swap, root, and home.

Root (/)
Swap

Linux reserves space on your drive to be

works.) This space is commonly called
‘swap’'space. The amount of swap space
required is a matter of religious argument
among geeks and hackers, and entire
volumes could be written about the
subject. To keep it simple, create one swap
partition of either 64Mb or 128Mb (vou
may have to use 127Mb instead,
depending on the program you use to

Il you are short on RAM with plenty of
drive space, go large. I you're short on
drive space and have 32Mb or more of
RAM, then go small. ~

The root file system is represented by a
forward slash (/). It is the top of the
directory tree, and contains Linux and

who is the administrator of the system.
That’s a different kind of root!)

The size of vour root partition will vary
depending on what you plan to install.
Check your distribution’s documentation
and reserve enough space for a maximum
installation, plus at least 100Mb more for
temporary space and installation of new
software. If you plan to download and try
oul lots of different software, leave more
space. If you have a small hard drive, you
can trim back on your installed packages
to save space.

The installation we perform in this

mileage will vary. of course. If vou have a
giant hard drive, then leave room for
future expansion.
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used as virtual memory. Virtual memory d
allows your computer to run large i
programs and perform complex tasks even |
if' it does not have enough physical RAM i
to do the job. (It is a lot slower, but it i
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everything that you install with Linux. This
is roughly equivalent to your “C:\" drive
under DOS or Windows. You must create a
partition for the root directory. (Don't
confuse this with the “root” user account,
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Home (/home)

The third and final partition you should
create will hold your /home directory. This
is the place where all your personal files
will be stored. It is roughly equivalent to



we will assume a new Install

Here you can choose what type

of installation to perform. This Is
one of the real strengths of Red Hat
Linux. If you choose the Workstation
installation, it will do all the tricky
work of creating partitions and
choosing default packages for you.
For the new Linux adopter, this
clears some of the highest obstacles
to installing Linux.

The Server installation class

assumes that you are building a true Linux server. Don't choose this for
a dual-boot system. It will destroy all your existing partitions, including

your Windows partition.

For this tutorial, we will use the Custom installation class, so that
you can see what goes on during a Linux installation and gain a deeper

understanding of how Linux works

If you are installing a new copy of Red Hat, choose Install. To
upgrade an older version of Red Hat Linux, choose Upgrade. Here

¥ You are now asked whether you have any SCSI adaptors in your
system. If you do, Setup will probe for them and try to load the

drivers automatically. If the automatic probing fails, you may have to

specify what driver to use and what parameters the driver needs to

communicate with the card, such as the 10 address and IRQ.

Tip: the 10 address Is almost always listed in hexadecimal

notation, and the number should be preceded with Ox. For example: 10 I

Address = 0x300 For purposes of this tutorial, we’ll use the more
usual option of no SCSI adaptors

 Now’s the time to turn the space on your hard drive into a proper

Linux partition. Most users will want to use Disk Druid (see page
24). However if your hard drive is over 8Gb in size, you will have to
use the Linux utility fdisk (NOT the same as the DOS utility FDISK!)

the *‘My Documents’ folder on a Windows
PC. On a multi-user system, each user will
have his/her own directory under /home.

Strictly speaking, it is not necessary to
create a separate partition for /home. If
you do not create a separate partition,
your personal files will reside on the root
partition like everything else. If you are
cramped for space, you may need to
configure your machine this way.

The reason we recommend creating a
separate partition is that if you are a new
Linux user, you are bound to want to play
with things, experiment, push the limits of
your system. Before long, you will break
something so badly that you will need to
reinstall, or you'll just want to reinstall with
different options or try a different Linux
distribution. Having /home on a separate
partition makes it pretty easy to wipe out
and reinstall Linux without losing any of
your valuable data,

Everyone, no matter how experienced
they are, hoses up their system at least
once, and [or the beginner, reinstalling is
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often the casiest way to fix it. So just plan
on it and make it easy for yourself.

Keep your data on a separate /home
partition, or keep it backed up on some
other medium, and be sure to create the
boot floppy when prompted to do so
during the installation process. Having a
boot floppy has saved my system more
than once.

Don’t get the wrong impression of
Linux here. This reinstall problem is
common for new users because we lem‘I o
break things while we are learning. Six
months from now your system will be
purring like a nursing kitten, and you’'ll go

If you like to tinker
with things, you
should add a third
partition
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weeks or months without rebooting, let
alone reinstalling.

3) HOW TO CREATE
THE LINUX PARTITION
FOR REAL

Now that you've done all the
planning, it's time to get on and
create the Linux partition itself.

To create the Linux partition, you can use
one of two tools. We recommend you use
the Disk Druid option il you can. Turn
over for a walkthrough on how to use it.

Your alternative, if your drive is over
8Gh in size, is to use the altogether trickier
Linux utility fdisk.

Confusingly, there is also a DOS ulility
called FDISK which you may previously
have used to delete the partition FIPS
created. FDISK and fdisk are not the same!
Now turn over for details on how to use
fdisk to create your Linux partitions.
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GOT A
LARGE
HARD
DRIVE?

If you have a large
hard drive, you may
need to create a
small (12Mb) /boot
partition below the
1,024th cylinder,
otherwise LILO will
not be able to boot
Linux. See section
2.8 of the Red Hat
manual in the
\docs\rhmanual
\manual folder on
our Cover CD.
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WARNING

If your hard drive is
larger than 8Mb, do
NOT use Disk Druid
to create your Linux
partitions! Use fdisk
instead. See section
4.7 of the Red Hat
manual (start from
\docs\rhmanual\
manual\index.htm
on the CD) and the
large disk mini-
HOWTO (in \docs\
HOWTO\mini\Large
-Disk). You can still
use Disk Druid to set
up your mount
points once the drive
is partitioned
[Ee————————— ]

STAGE B: How to create your Linux partition

How to partition Linux

using Disk Druid

Disk Druid will suit most people - if it's not right for
vou, see the boxout on fdisk...

Now that you've decided what Linux partitions you need, it’s time to
choose a tool for the job. Most people will want to use the Disk Druid
tool because it is more visual and easier to use.

If your hard disk has more than 1,024 cylinders (8Gb for LBA mode

Flenigl FZ-Hdd HES Fa-Edit Fa Fool FI2 0k HY

The first screen of Disk Druid shows your available drives and

existing partitions. Currently we have a Windows partition only.
To create new partitions for Linux, choose Add. You are then asked to
edit the new partition. First we will create a swap partition. Leave the
“Mount Point” blank for now and set the Size to 64. Tab over to Type
and use the arrow keys to select Linux Swap. Note that the Mount
Point changes when you do this. Select 0K

hard drives), and you need to make Linux partitions past the 1,024th
cylinder, you will have to use fdisk as Disk Druid does not support
these large hard drives. fdisk is an ‘old-school’ UNIX program, with a
character-based command line interface. See the boxout below for more
details on using fdisk.

Note: if you have not already deleted the empty partition created by
FIPS, you should do this now.

Point /, the root directory. You will need at least 400Mb, but
allocate as much space as you like. If you want the partition to take up
all the free space on the disk, select the Grow to fill disk option by
highlighting it and pressing the Spacebar. The partition type should
remain Linux native. If you decided to create a separate partition for
your data, follow the same steps, setting the Mount Point to /home

For large hard drives...

How to use fdisk to make the Linux partition

On running fdisk, you will be asked to :
pick a hard drive. Select the one where :
you want Linux installed and choose edit. |
The interface can be intimidating at |
first. Just move slowly and read carefully. |
Nothing you do is written to the disk until |
you give the command to do so. If yougo |
wrong, type q to quit and start again. !
Typing m gives you a menu of available i
commands, as follows: |
I

|

|

|

|

]

Command and Action
a toggle a bootable flag
b edit bsd disklabel
¢ toggle the DOS compatibility flag
d delete a partition
1 list known partition types
m print this menu
n add a new partition
o create new empty DOS partition table

your hard drive.

p print the partition table

q quit without saving changes

s create a new empty Sun disklabel
t change a partition’s system id

u change display/entry units

v verify the partition table

w write table to disk and exit

x extra functionality (experts only)

Use the p command to see your
Windows partition. The numbers you see
will be different from this example; they
depend upon the size and configuration of

You now need to create some new
partitions for Linux. Type n for ‘new’. You
will be asked whether this will be an
extended partition or a primary partition.
To create more partitions, you need to
create a special “extended” partition,

\ which is made to contain sub-partitions
| called “logical” partitions.

] Here we will create an extended

| partition with e and call it partition

| number 2. (Partition 1 contains

{ Windows). The first cylinder of a new

| partition should always be the first

| available cylinder, so type 452. Since this
i is a small hard drive, and the extended

i partition is meant to be a container for

i other partitions, we will set the last

| cylinder to the last available cylinder,

| “1015” in this case. If you need to do so,
| type p again.

1

1

1

Creating a logical partition

Now you need to create some partitions
for Linux. Type n. This time fdisk asks
whether you want to create a primary or
logical partition. Type I for ‘logical’. Again

24 LiNUX ANSWERS
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The tallest

Notice that Disk Druid shuffles the partitions to create them

optimally on your drive. Once you are satisfied with your
partition layout, select OK or press F12, You are asked to verify that
you want your changes saved to the disk. If you answer No, the disk
will remain unchanged. Select Yes when ready to proceed

You are now

asked to format pengu"‘
any partitions you
have created. It is ever was
recommended that you
format all the Linux 1.7 metres
partitions. If youare ||
re-installing Linux, you = ta“

may have saved your /home partition from your previous
installation. Be careful not to format that partition if you have
already placed data on it. All data is destroyed during the format. If
you select the option Check for bad blocks Linux will check the
hard drive for physical errors as well. This may take a long time. Use
your own judgement here

-~

you wish to use. Type L 1o see a list of all

fdisk asks for starting and ending

cylinders. It is best to create your swap
partition first. For this, we will start at
the first available cylinder “452”, and
allocate a size of 64Mb with +64M. Type
P again to review the changes.

Here you must make a change. The
partition was created as a “Linux
native” type by default. For all
other partitions you create,
this will be the correct type,
but the swap partition is
different. You need to
change the type to
“Linux swap”. Enter the
t command and choose
partition number 5.
Next fdisk asks for the
hexadecimal code of
the partition type e

g =

the supported partition types and their
codes. As you can see, fdisk can create
just about anything you need. Choose
code 82 for Linux swap and type p to
review changes.

Nearly done...

Follow the same steps to create the other
partitions you require, leaving the type
set to 83, When you are satisfied, use the
w command to save the
partition table.,

You will then be
returned to the Red Hat setup
partition list, where you may choose to

edit other drives or make changes to
this one again. When you are finished,
select Done. You may be asked to
reboot at this time.

STAGE C: Just in case...

How to make a
boot disk

No matter how careful you are, sometimes things
go wrong. You need a bit of backup in case the
worst should happen...

Create a boot disk for your system. Do not skip this step! If
the boot loader LILO fails to install correctly for some
reason, this disk will be your only way to start Linux

Now you must configure LILO, the Linux Loader. This is the

program that will start Linux on your system. Usually you will
want to install LILO in your Master Boot Record. This will give you
the opportunity to choose an operating system each time you boot
your PC. You can also install LILO to the boot partition (where Linux
is installed). This means you will need to make that partition active
using fdisk in order to boot Linux. Otherwise, Windows will remain
your default

LILO can pass
special

| parameters o the
| Linux kernel at
boot time. Leave
this blank unless
| you know what

| you are doing

Here you can configure LILO to boot your new Linux

installation or your old Windows installation by default. You
may want to edit the label used for each operating system so it is
more appropriate

-
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"6 How to install
applications

or a typical home system, you
will want to install the following
components (fig 1). This is a list
of fairly standard applications.
some of which we will be
talking about later on in the magazine:

@ Printer support

@ X Window System

@ KDE and/or GNOME

@ Mail/WWW/News Tools

@ DOS/Windows connectivity
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| @ File managers
| @ Graphics manipulation
i @ Dial-up workstation
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@ Emacs and Emacs with X Windows

Il you have some extra space, you may
want to install these optional components:

® Console Games

® X Games

@ Console Multimedia
® X Multimedia Support

If your Linux system is to be connected
1o a LAN (local area network), you should
include these:
® Networked workstation
® SMB (Samba) Connectivity
@ [PX/Netware Connectivity

The server components need only be
installed if you are planning to use Linux
as a server for email, Web, fip, etc.

You don’t need the development
components unless you plan to write
programs for Linux. These components
can take up a great deal of space.

On the other hand, if you have more
than 1Gb of space devoted to Linux and
want to learn everything there is to know
ahout it, scroll down to the hottom of the
list and select ‘Everything” (see fig 2).

Setup now automatically formats your
partitions and begins to fill your hard drive
with software.

Getting straight into it

Linux applications you can use today

Is it on the CD? Yes, see pages 80-81 for "
more information

It's all very well having a new OS to play
with, but what can you actually run on it!

Linux is great — we’re all agreed on that. But a
raw 0S by itself isn’t much use to anyone. One of
the reasons for Linux’s success has been the
development of some impressive software, all of
which is free and much of which is on our CD.
What it is: a Photoshop-level
image-editing package

What you can do with if: provides full image-
editing capabilities; includes effects filters;
supports a wide range of image formats

What it can’t do: it's a little weak in the pre-
press arena, specifically colour separation,
although this is being addressed

Is it on the CD? Yes, see pages 50-55 for a
complete tutorial

GIMP

StarOffice

What It is: a Microsoft
Office-style application

suite

What you can do with it: the full range of
Office-style tasks, from word processing to
spreadsheets and presentations. Supports the
major Microsoft file formats

What it can’t do: lacks some of the most
powerful Web-integration features of Office2000

Is it on the CD? No, but see ‘The Source’ on

page 8 for the latest news on StarOffice

Corel WordPerfect 8

What it is: Powerful word
processor with Word-style features

What you can do with it: full WP facilities plus
basic layout

What it can’t do: it's not the WordPerfect suite
found on Windows, just a bit of it

orimnratien (siae |Fiaceenent Geeeral |7rd
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The GIMP will probably become your favourite Linux
application. It's powerful and easy to use
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7 How to configure

your system

Remember those hardware details you wrote down earlier?
Dig them out, you're about fo use ‘em...

Select the correct time zone. For most PCs, the

hardware clock will not be set to Greenwich Mean
Time (GMT), so leave this field blank unless you have
adjusted this yourself

After the Linux files have copied to your system,

setup will try to detect your mouse. If it guesses
wrong, you may select the correct mouse from the list
presented. For two-button mice, select the Emulate 3
Buttons option to simulate a middle mouse click by
pressing both buttons at the same time

Now configure your system services. Generally, the

defaults should be fine. You can highlight a service
If you installed the Networked Workstation and press F1 to learn what it does if you want to play.
package, you will be asked if you want to set up You probably should not disable atd, crond, inet,

the network. Setup will attempt to detect your network keytable, Ipd, or network as these provide essential

card, and you will be asked to provide network address services and hardware support, although your Linux

information, so have this ready system can operate without them

You are also given the opportunity to configure a

printer on your system. It's a good idea to get this
out of the way during the install, even if the printer is
not yet connected. Linux can print to local and network

You will need to select a hostname for your : :
rinters. Normally you would have a local printer
system. Call it whatever you like 4 2y pr

B9 Linux requires a name for the print queue. The

default name for printers on most UNIX systems is
Ip. Keep this name and spool directory unless you have
a good reason not to. Setup will try to detect the
parallel ports on your system. If it guesses incorrectly,
give the correct port from the device list shown

Select a driver for your printer. Many printer

drivers will have additional options that can be set
to correct minor printing problems. These settings can
also be adjusted after the printer is installed using
printtool. Setup then gives you the opportunity to
review and change the printer configuration before
saving it

Choose a root p i. The user root is the

administrator of your Linux system and has
complete control over everything. Do not forget this
password! You must have it to login to Linux the first
time. You'll then be asked to choose an Authentication
Configuration. You should only enable NIS if you have
a Sun authentication server on your network. Shadow
passwords and MD5 passwords enhance the security of
your system, so leave them on

..l.....l....I.ll.....l.........l...................l..b
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" 8 How
igure video

Now setup will attempt to detect your video card.

Most cards are automatically detected. If yours is
not, you may select it from the list presented. If your
card is not on the list, choose Unlisted Card. Setup
will prompt you for the X server needed for your card.
You should choose VGA16 for unsupported cards. This
is the least common denominator and should work
with all VGA-compatible cards

Next you will be asked about your monitor. If your

maodel is on the list, just select it. If not, select
Custom, and then pick the highest resolution
supported by your monitor, and then the vertical sync
range supported by your monitor. This information
should be provided in your monitor’s documentation.
Some very old monitors can be damaged if you select
the wrong numbers here, so be sure to consult your
hardware documentation, don’t just guess! If in doubt,
choose the lowest numbers

Setup can optionally probe for the amount of video

memory on your card. Some cards do not allow
probing, so you may need to choose the amount
manually. If prompted, leave your clockchip
configuration set to No Clockchip Setting. Choosing
the wrong setting can damage your hardware

Setup will now try to probe to determine the best
video resolution to use. You may choose Skip to
pick your screen settings manually

And finally...

Reboot and go!

Now that you've installed everything, you need to
reboot — you will see a ‘LILO:’ before any
operating system loads. If you've selected the
defaults during installation, type ‘dos’ here to
boot boring old Windows, or ‘linux’ to boot your
funky new system.

Linux will scroll some very impressive text
across your screen, and finally give you a box
asking for your Login and Password. The first
time you boot Linux, your login will be ‘root’ (all
lowercase) and your password the one you chose

turn some funny colours and finally

Setup will now test your video
configuration. Your screen will

display a confirmation box. If you

in stage 7, point 9. Type them in, click Login, and
you're there. You may be given the chance to
choose your deskiop environment. KDE tidies up
your desktop and makes it much easier to
navigate your way round Linux. To set up KDE as
your default GUI, run the script lastart which is
on our CD. This script also allows you to set up
other user accounts, so you don’t have to keep
logging on to Linux as root.

There's no shortage of alternative GUIs but
for the sake of simplicity we recommend KDE

can read it and see the buttons to
press, it worked! Setup will then ask manually start KDE from the
you if you want to start X

automatically every time you boot.

Choose YES, or you will have to

command line. Now reboot and
prepare to enter the world of Linux
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You need to connect fo the
Net fo get the most from
Linux. Here’s how...

inux, having been developed by the

Internet community, comes with a full

set of Internet tools. Even if you don’t

plan to use the full range, you will

definitely want to get online as soon as
possible. This is because nearly all support, help,
programs, patches and updates are not available
anywhere else.

Before you can connect to the Net, you need
to be sure your modem works with Linux.
Unfortunately, the majority of internal modems
bundled with modern computers are ‘Winmodems’
(or similar ~ Winmodem is actually a trademarked
name for one particular type, but we use it here to
describe them all). Winmodems will NOT work
under Linux.

Is your modem OK!

Go to www.o2.net/ ~ gromitke/winmodem.html to
see if your modem is compatible. Basically, if
you've got an internal modem that came with your
compulter, though, it is almost certainly a
Winmodem. So now what?

Well, if you need to buy a new modem, your
safest bet is an external one. Before buying, ask if
the model you settle on works with Linux.

Now that your modem is sorted, let’s configure
your system to access the Internet.

First, you need an Internet service provider
(ISP). For the purposes of this tutorial we’ll assume
you already have an ISP and are already
connecting to the Net via Windows. We'll use
Freeserve as an example.

WARNING

Once you've split your partitions, if you use a
program in Windows that affects the MBR,
the Master Boot Record, you will lose Linux
and have to reinstall. (You will be warned if a
program is going to do this.)

co_nnsct'-lm J freeserve j
Login 1D: l!ump arfsnet.co.uk
PNMI’G‘ i I. e

' show Lag Window

aut | see | wep | comneat |

When connecting to the Net, you'll be using the

dial-up program kppp (you can find it under KDE
by clicking the K icon on the toolbar on the bottom-
left), and selecting the Internet folder. Running it
brings up this box. We've already entered our details.
To do the same, click on setup

accounts | Dovice | Modam |PPP | Grapn |janout |
i~ Aecount Sehup : . -

i L

2

]

[ e |

Select the Accounts tab and then click on New.
Now you can enter your Internet service provider's
connection details

ol [ip | oS | Gamvay | LaginSeipt | Accouing: |
i mu:w

Cannackon Hamp: |rm=orve

Fisond Humbar [5 0645 075 6693

- Authnse atinn PAP b

¥ Stare password

Click on the dial tab and enter your ISP’s name
and connection telephone number (there's a 9
there because we are using our company's internal

h system to connect). Then click OK

¥

START HERE!
9 How to connect

to the Internet

T e |

Now click

the IP tab
and make sure
your details
match these. Then
dick OK

Now enter

the ISP name
again and your
DNS details,
Freeserve uses
two DNS servers;
it's possible your
ISP uses less or
more. Click 0K

Click OK and
return to the

Wodesitsdca | [wmmoinn || ||| Screenshot found
— in step 3. Click
Fhe Cortred: | s Bl
O s : the device tab
FERTm e, 2o and select your
Conmastonpasa [116200 5], connection speed.
Then click 0K
I~ 20 Lok Fita
acam Timaout: ]‘T Sacond
T |
Cormnits froows 8
Lopn I0: Iwmnmnncwr
P snow Lag wingow .

Now when you want to connect to your ISP, run
kppp and enter your username (in the Login ID
field) and your password and click connect. To browse
the Web, run Netscape once you have a session
opened. (If you find you are having problems running
programs after connecting to the Net, run the program
first, then connect using kppp.)
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OPEN SOURCE REVOLUTION

Meet the new revolutionaries, the people behind Linux. Linus Torvalds,
R M Staliman and Eric Raymond tell us why liberating yourself from the grip
of giant corporations is the way forward for your PC. Cotton Ward reports

hat happens when the
worlds of Open Source
software and
commerce collide, and
when programmers
who give code away come into contact
with programmers who sell code for profit?
The question arose when Red Hat sent
out at least 1,000 emails to software
developers who'd contributed to certain
Open Source products, and offered them
shares in its upcoming flotation.
Unfortunately, these were only available

through E-Trade who

required a $1000
deposit, and at least

$1200 to buy a 100-lot of shares. Needless
to say, many hackers couldn’t afford this,
and missed out.

We decided we had to find out more:
how did people feel about seeing their
freely-donated code appearing in
commercial products? Was there any
chance of this heralding - even in a small
way - the beginning of the end of the
Open Source/free software dream? The
results surprised us.

We began by posting questions to two
newsgroups - comp.os.linux.advocacy and
alt.os.linux - to sec whether people are
happy or disgruntled with Red Hat’s IPO
and whether they think the company still
encourages “Open Source” principles.

A CAUSE
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guess there Will
always be
anarchists who
despise structure

and orgunis@g

Instead of being deluged by hundreds of
hacked-off hackers, we only received two
responses, from people who hadn’t been
involved in the TPO at all.

This was encouraging for the Open
Source movement, if not our hopes for a
lively story. So we asked some of the
industry heavyweights what they thought
about Red Hat's IPO and the company’s
influence on Open Source principles
instead. First up, of course, is Linus
Torvalds, the former Helsinki University

“You don’t win a battle by asking,
‘Will we win?’You win it by doing
your best to win.”

2000000000000 QC0CRCOOCOCOOORO0ROPOCRO0C0OC®OOGO GO

— R M Stallman

1
1
]
1
1
1
[}
1
]
I
I
I
1
I
I
I
I
I
I
I
I
I
I
I
I
I
|
|
I
|
|
|
|
|
|
|
|
I
|
I
1
I
|
|
I
1
I
1
1
]
1
]
1
1
1
I
1
1
]
]
I
1
1
1
I
1
I
1
I
1
|
1
|
I
I
I
|
1
I
|
I
1
|
|
I
I
|
|
I
|
I
1
I
I
I
I
I
1
I
I
|
1
I
I
1
1
|
1
I
1
1
I
1
1
1
1
1
1
1
1
1
1

student who began developing the Linux
kernel in 1991. He used the Free Software
Foundation’s toolkit while many other Net
hackers also contributed to the
development of Linux. Torvalds said he
scored some shares in Red Hat, but “no, it
didn’t make me ridiculously wealthy™.

In it for the money?

He defends the rights of companics such
as Red Hat to exist. “The commercial
ventures have been critical to the success
of Linux, The reason is that they work in a
completely different dimension. The
‘hardcore’ development that happens on
the Internet tends to focus on fundamental
problems, performance, and on the
technical details. That's not something that
most commercial software houses
necessarily want to do at all - and you can
add a random snide remark about
Microsoft here! What the commercial side
brings is ease of use, ‘polishing’, 24x7 (24-
hour by 7-day) support contracts, and
distribution - all the small details you need
to be successful, but which aren’t really all
that exciting.”

He says he’s not worried about Red
Hat being overly dominant in setting
standards. “I think the US is mainly Red
Hat-oriented, and many people don’t see
that Linux is much more than Red Hat.
Yes, Red Hat is big, and it'll grow bigger
still, but so will a number of other Linux
distributors, and nobody really controls the
market. And Red Hat doesn’t tend to
dominate in the Linux Standards Base area
- technical and practical issues do. So |
don’t really see the
reason for heing all
that nervous. One of
the points of Open Source is that you can't
ever unilaterally control the market,
because even the extensions will always be
available to others.”

As to some people’s comments that
Red Hat is trying to keep other players out
of the market, Torvalds says: “l grow
rather weary of this line of reasoning.” He
declined to clarify this point any further.

He points out that the concept of Open
Source to Linux users is so important
because it “keeps
control in the user’s
court”, He adds:

“Whatever happens, Open Source means
that you can always fix whatever issues
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WHAT IS
OPEN
SOURCE?

Open Source is a
name given to
software developed
by programmers,
peer-reviewed by
other programmers,
then distributed for
free to anyone who
wants it. The code is
owned by the Open
Source community as
a whole and is
therefore non-
proprietary. The
advantage over
commercial software
development is that
code can be written
and fixed faster and
is often better-
written. Open
Source-type software
has its roots in
academia and been
around for as long
as the modern
computer, but many
feel that the rise of
commercial software
concerns, proprietary
standards and
patents is a threat to
the health of
computer science.
The rise of the
Internet has allowed
talented
programmers to
form online
cooperatives which
are large enough to
compete with
commercial concerns.
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REBELS WITH
A CAUSE

-

GIVING
IT ALL
AWAY

People and
companies who've
decided to give
away their software

JANUARY 1998
Netscape releases
the Communicator 5
browser on its
Mozilla.org Open
Source project. Few
people were able to
get through the 17
million lines of code
and no major third-
party products have
been developed.
Read Jamie
Zawinski's
resignation from
Netscape at
www.jwz.org/
gruntle/nomo.html

JUNE 1998

IBM ‘buys’ Apache
software from a
group of 20
programmers, who
insist the source
code remains freely
available. In return,
IBM agrees to share
hacks with Apache.

SEPTEMBER 1999
Sun gives away
StarOffice Suite for
free. It's a fully-
functional office
suite which
competes against
Microsoft Office.
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plague you.” What about the various
strong personalities, though, who all have
to work together?

“Egotistical people doom themselves. If
you don’t play together with others, you
don’t get the henefit of co-operation, and
you'll end up being just another person in
a world where there are hundreds of
competitors willing to do better.”

Death of a community

Next up, we contacted Richard Stallman
who first began working at the MIT
Artificial Intelligence Lab in 1971, when
sharing software was the norm and
everyone pitched in, to improve programs.
When proprietary software was introduced,
people had to sign non-disclosure
agreements saying they would share or
change the software.

The last straw was when someone
refused to give Stallman and the MIT Al
Lab the source code to control the printer,
and he decided he never wanted to treat
someone else in this way. He left MIT in
1984 to develop a free UNIX-like
operating system and founded the Free
Software Foundation and developed the
GNU General Public Licence (GPL).

“I hope this magazine won't repeat the
usual mistakes such as: ‘Linux is an
operating system that was developed in
1991 by Linus Torvalds,” Stallman points
out. “In truth, Linux is a kernel; the
operating system as a whole is basically
the GNU operating system, which we in
the GNU Project started developing in
1984. In 1991 it was almost finished,
missing only the kernel. People put it
together with Linux to make the
combination GNU/Linux, which is the
system people use.”

“Most users don’t realise this, because
they typically hear the whole system called
‘Linux’. So they don't realise that the GNU
Project was the origin of this system, and
that our idealism
made it happen. I
hope you'll give us
equal billing by calling the system
GNU/Linux, It's an important point.”

He didn’t get any shares in Red Hat's
IPO. “What happened with Red Hat shares

up
with us, even if

they go op@ ’

is a side issue of a side issue. What Red
Hat does with a small fraction of its stock
won't make a major difference to our
community’s future. The most important
question about Red Hat is, will it
contribute to building the free software
community or weaken it?

“So far it has done a substantial
amount to help build the community by
hiring people to develop [ree software. But
it has also done things that weaken the
community, such as including non-free
software, in varying amounts, on most of
its CDs.”

Stallman continued: “Red Hat is just
one of many companies that will affect our
community. How much companies help
build our community, and how much they
weaken it, will depend on what we are
prepared to accept from them. It will
depend on our values, How much do we
want freedom, and how much arc we
willing to give it up for other things such
as convenience? And when companics
market non-free software to us, will we
reward them with our custom or deny
them success?”

Stallman points out he has declined to
join the Open Source movement. “This
was because it only talks about strictly

istic

=

practical values, such as convenience and
reliability, and studiously avoids raising
deeper issues, such as freedom and
principle. That makes its philosophy
painless and easy to sell. [ think freedom
and values are important, and should not
be hushed up. I belong to the Free
Software movement, where we encourage
people to think ahout those issues.

“The Open Source people have a right
to promote their views, but the Free
Software movement, which launched the
system people call ‘Linux’, is still here, and
the two movements are different.”

The patent crisis

The biggest current threat to the Free
Software movement are sofltware patents. If
you start getting patent infringement
lawsuits for including a “Save as”
command or using different colours to
show different items, you'd never be able
to afford the legal defence costs. “The
battle is just beginning, and it will take
time,” Stallman says. “You don’t win a
hattle hy asking, ‘Will we win?' You win by
doing your best to win. Good citizenship
means taking the side you think is right,
not the side you think will win.”

He says it's important for UK Linux
users to lobby against trivial and broad
software patents being introduced here.
“Most countries have their own
independent patent systems, so the issue is
usually decided on a country-by-country
basis. A solution in the UK has to come
from people in the UK.” He recommends
supporting the European-oriented Free
Patents Web site.

“| advocate legally exempting, [rom
patent infringement claims, the use of
software installed or
installable by the
user on general-
purpose computer hardware, when the
hardware itself does not infringe, and the
idea that is patented is in nature a matter
of computation or processing.” He says we
also can promote the issue of free software

by “discussing it”. “The more you talk

about it, the more you show people that it
can and should be done.”

Enter Eric Raymond

Meanwhile, high-profile Internet developer
and writer Eric Raymond says his research
has helped explain the decentralised Open

Source model of
www.tuxedo.org/~esr

software
development. His

own projects include one of the Internet’s
most widely-used email transport
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programs, and his essay “The Cathedral
and the Bazaar' inspired Netscape to make
its source code freely available,

He's also renowned for getting hold of
and annotating two internal Microsoft
white papers on the company’s attitude
towards Open Source software, which are
referred to as the ‘Halloween Documents’.

Commerce is cool

Eric managed to snaffle a few Red Hat
shares after "getting through the maze of
idiotic SEC requirements™ but pointed out
that generally he gives his software away
“in the knowledge that outfits like Red Hat
might use it to make money”. He adds:
“I'm cool with that notion.” Raymond also
co-founded the Open Source Software
Group because of concern that the Free
Software Foundation’s anti-business
undertones were hindering the spread of
the message.

However, the two groups happily
coexist. “The open-source community
needs healthy distribution companies, such
as Red Hat, with strong capitalisation and
Wall Street’s respect, to accomplish what
we're really after - replacing the present
software infrastructure with one that
doesn’t suck.

“I think there has been a lot of smoke
blown about Red Hat setting standards
unilaterally, but very little fire. As long as
they’re not even trying to stop outfits like
CheapBytes from reselling their
distribution for $1 a pop, there isn't any
problem with market domination.”

Breaking monopolies
He says the concept of Open Source is
important to “anyone who never wants to
see a Blue Screen of Death again. Open
Source has turned out to be the only way
to produce reliable, high-quality software
consistently. It’s the only way to produce
software that evolves fast enough to stay
current in Internet time. Also, Open Source
puts the power where it belongs - in the
hands of individuals and software users,
rather than corporate monopolies and
software vendors”,

He doesn’t think Microsoft will ever
release any Windows code. “I doubt it, and
I don’t think it matters much. We're
already ahead of Microsoft in everything
but marketing. I don’t think it'll be able to
catch up with us, even if it goes open.”

From the other side of the fence, we
spoke to Cygnus
Solutions’ co-founder
Michael Tiemann.

Cygnus is the largest Open Source-based

00000000 QCOPCEOROPOOCOOCOPOOROROOCOOROOEODROOEO®E®

company and started trading in 1989. Its
biggest-selling product is the GNUPro
Developer's Kit.

Tiemann told Linux Answers: “The
reason there is so much Open Source
software available today is because
motivated programmers have access to
world-class development tools that are
being continuously improved and
supported by Cygnus.”

“I'll note that Cygnus is not the
exclusive maintainer of the GNU tools, but
we contribute the majority of the work in
all areas: ports to new microprocessors,
features, optimisations and bug-fixes.

“Linus Torvalds has written about the
importance of the GNU compiler. What he
basically says is that the portability of the
kernel is not due to any particular
intelligence on his part, but due to the
awesome capabilities of the GNU compiler.
Compilers and development tools are not
sexy in the way that operating systems are
sexy, but they are every bit as important to
getting apps to market.”

Tiemann admits his name is “all over”
the GNU C++ source code and he
continues to submit bug-fixes 1o GCC,
G++ and GDB, but he hasn’t “done any
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actual Linux kernel work”, so didn’t get
any Red Hat shares. “I believe they
scanned only Linux kernel sources to find
‘friends of Red Hat’,” he speculates.

He disagrees that people who
contributed to the development of Linux
should have been given shares without
having to pay cash upfront. “This would
probably violate tax and securities laws in
some countries, I think Red Hat did the
right thing by using existing mechanisms.
A wise person once said ‘one revolution at
a time’; 1 think Red Hat is following this
maxim to the letter.”

Positive reactions

He continues: “There are definitely people
who resent the fact that Cygnus doesn’t do
more for them for free, as we are actually
quite expensive to hire, but I think that’s
their problem.”

As for Red Hat’s detractors, Tiemann
remarks: “I think there are a few loud
voices that do not appreciate all the good
things Red Hat is doing,. 1 guess there will
always be anarchists who despise structure
and organisation.

“Cygnus has drawn far less Mack than
Red Halt but, then, we are a lower-profile
company. I hope that some day we will be
profitable enough to do some amount of
community-oriented work. I really wish I
had $100bn to give to charity.”

As for the likelihood of Microsoft ever
releasing any Windows code, Tiemann
says the chances are pretty remote. “I
consider it as likely as a 9.8 earthquake
destroying all of San Francisco. If it
happens, it happens, and there’s not much

that can be done. Incidentally, | m

tlon’t live in San Francisco.”
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THOSE
KEY
PLAYERS

Linus Torvalds is the
creator of the Linux
kernel (that is, the
code that sits at the
heart of Linux and
controls most of the
basic processes). He
started work in

1991 under the
aegis of the GNU
software project
whose founder was...

... R M Stallman.
His GNU manifesto,
created in 1984,
helped kick-start the
Open Source
movement. An aim
was to develop a
universal operating
system which was
not owned by any
commercial concern
and could be
adapted by anyone
who wanted to.
GNU/Linux was the
result.

GNU/Linux is the
full title for Linux,
although in the
interests of
readability we have
shortened the title to
Linux elsewhere in
the magazine.

Eric Raymond is a
well-known Open
Source programmer
and advocate whose
writings have helped
influence a number
of commercial
concerns to adopt
the Open Source
model of
development. His key
work ‘The Cathedral
and the Bazaar' is
being published by
0’Reilly around
about now.
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™
(1LY HARDWARE

Linux PC

C World Advent 8707

PC World has made the first steps of providing a Linux PG for the
masses, but what does it offer over a more traditional machine?

' he largest problem PC World would have faced |
. when putting this machine together would )
1 have been getting hardware to work, because |
1 so far hardware hasn't been designed with :
i Linux in mind. This means Linux drivers i
| either don't exist or are unstable. There are two answers |
i (o this — ship with the latest hardware and expect lots of [
| angry phone calls or ship hardware that's known to !
' work, as PC World has dane here. -
; The [irst evidence of this is the graphics card - an !
| aged AGP Xpert98 Rage Pro from ATL The 8Mb of !
| onboard memory does allow X Windows to run at up to |
{1,600 x 1,200 in 32-bit colour, but apart from that |
there's litlle Lo gel excited about. You :
* ] would need a high-quality monitor to |
SPECIﬁcatlons display this resolution and E
HARDWARE: Intel Pentium III untnrtul:lt;u.ly ,UI-;!}L:VF!IH SL?UJ’ docsndt E
450MHz, 64Mb RAM, 100MHz come with one. : :I'( highest supporte !
el i resolution we managed to get X ! e
SDRAM, Philips 17-inch 107E, Windows booting in was 1,152 x 864 | ; is the first PC to
6.4Gb Ultra ATA/33, 8Mb ATI at 32-bit, and even at this speed there | | be sold that
Xpert98 Rage Pro, was noticcable slowness with ! either be needed. Open the case and you'll find that the | comes with Linux
SoundBlaster 64 Value, refreshing the screen. ! space is well-organised with plenty of upgrade potential, | Pre-installed.
Creative Speakers, 40X ATAPI The 17-inch Philips 107E monitor | The 6.4Gb Ultra-ATA hard drive sits under the 3.5-inch : :;;?::::::::1::1 2
CD-ROM drive has a recommended display of 1,024 x | bay slots with room for an extra hard drive above it, 5 hefty price-tag...
LINUX DISTRIBUTION: Linux- 768, although it should support up to i although we would have heen happier to see at least a !
Mandrake v6.0 Deluxe 1,280 x 1,024 at 60Hz. Four buttons E 10Gh drive used, :
SOFTWARE: StarOffice 5.1, X control image quality, brightness and ! The BX motherboard is from the well-respected :
Windows Server v3.3.3.1, contrast settings. The image quality is. | Gigabyte, so there should be litile incompatibility !
GNOME 1.0/Enlightenment, acceptable, lacking the crispness of a | problems with the main chipset. Expansion-wise there -
KDE v1.1.1, WINE Windows professional monitor, but is well in line | are three free PCI slots and one free ISA slot. '
emulator, 3 Linux books in PDF | with monitors supplied with new PCs. | Software-wise you gel a copy of Linux-Mandrake 6.0 i
= et — The other sign that the hardware i Deluxe, which is set up to boot straight into KDE i
has been carefully selected to be i (GNOME and Enlightenment are provided, too). i
! compatible is the 1SA-based modem. This is a 56K E Everything in KDE is set up well and we had few i
I device, bul because it sits on the 1SA bus, the transfer | problems on this front, although the modem wasn't set :
! rate between the modem and the rest of the system is a | up optimally. You get a copy of StarOffice 5.1 with !
! little wanting. PC World is going to replace this modem | Mandrake, although this isn't installed by default. PC )
! with a PCI version later this autumn. ! World is also intending to supply Quake Il Colossus. i
| The SoundBlaster 64 Value soundcard, although not | For a one-stop solution, this is an ideal, if slightly .
| cutting edge, should provide you with enough sonic i expensive, way of getting a Linux machine. i
i pleasure. It is also in the wonderful position of being a E Alan Dexter i
i compatible standard - causing the least amount ol 1
i pruh}]f.‘l‘ns when it comes to stim(i under Linux. i MANUFACTURER:
i ! PC World
i m | WEB: ANSWERS
. Well proportioned | www.peworld.co.uk _
L R . stvling has | DISTRIBUTOR: Performance loYoYoYoY§
| The healthy proportioned tower with subtle styling has i
! three 5.25-inch drive bays and two 3.5-inch slots. One of | PC World Features QQ& é
! each type is used by default, the 40x CD-ROM drive | CONTACT: Value for money cl é é ¢
i accupies the top of the tower and the standard floppy E 0990 464464
| drive takes up one of the smaller bays. This lcaves plenty | PRICE: £938 Inc VAT, é é & &
i of room for a CD-Writer and a backup device should | £798.30 exc VAT uVERAlL

l..C.l.l..l.l.l.l..I....l....l.l....Il.l.lllll.......'..
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SOFTWARE [ (e ii8)}

Office suite

ApplixWare for Linux v4.42

Linux needs a great application suite — is this the answer to our problems?
Well-known UNIX developer Applix reckons so...

any of the companies that distribute i N VS P i e et e ‘| 1 Complex
Linux (such as RedHal, Caldera and Pelallmoiel «age B Bzl e it} technical

L |
AR diagrams are a

y breeze and they
can be enhanced
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: Corel) are making strong efforts to

! extend its reach to the desktop market.
| To be able to make this transition, it is
i vital that there are plenty of useful applications.

! The current front-runners are StarOffice and Corel
I
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pictures

Office (due for release carly next year), And now comes

Applix. Applix has a strong tradition on UNIX machines

for producing low-cost, high-quality applications. Its

e ey
P

REREZE0 e

release of ApplixWare for Linux brings it into the

competition for the market. The preview version we've

seen consists of a word processor, spreadsheel, email

client, presentation creator, database querying tool and
the “Builder” visual object-oriented

~can Shure programming application - there is just
documen's in a ahout everything you will need to handle

office-related procedures, all available from

common formu" a single starting point.

From the moment you start using

across I'I'Ill|l'|p|e ApplixWare, you'll notice the integration of
the different components of the suite. For
platforms : ;

though, comes from ‘Builder', a system that
lets you create your own custom applications
based on a number of supplied objects and
simple scripting. This has profound
implications for a business environment
where you need database-driven, real-time
apps running across multiple platforms, but
example, you can emhed any documents retaining common file formats and interface styles.
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w“‘hout endless created with any of the components into a1 The database querying tool in ApplixWare and the
]

G document in another. This integration is | suite’s ability to update data in real time means that this
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The ability to
embed objects
from one program
within another
will enhance your
documents and
presentations

supported further with the availability of is simply a matter of linking objects together and writing
ApplixWare for Windows, so that you can some code to move the data around.
share documents in a common format Unfortunately, not every component piece of
software is as good as each other, specifically the mail
client. It has all the features you would normally expect
from a mail client as well as several other useful
additions - for example, if someone sends you an
ApplixWare document as an attachment, it can
automatically display it for you - but it has a highly
unfriendly interface.

While it may be aimed at business users, ApplixWare
would suit a home user, too. Unlike Sun's StarOffice and
many of the other office suites available or planned for

across multiple platforms.

A major gripe in this area is that many of the
buttons in the application toeolbars are not labelled (ie
they don’t say what they do). There are small pictures
that give an idea of what they do, hut beyond that you
have to refer to the documentation to keep track of
which buttons are which.

Words and pictures

‘Words', the word processor contains just about every Linux, ApplixWare is not free - it is available from
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i feature you are likely to need. It is Tully WYSIWYG with Applix via its Web store for $99.
i a well-chosen sclection of fonts. The usual spell checking Chris Jones
: and thesaurus tools are present, as are tables and a
i myriad other features. Printing is something that both
) Linux and the UNIX in general have never quite grasped
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but you'll be fine if you own a PostScript printer.

MANUFACTURER:
ApplixWare
DOWNLOAD FROM:

www.applix.com
DISTRIBUTOR: Applix Performance FoYoYoYoYe

PRICE: $99 Features = {3 &6 45 5

Value for money

81, (V) @ RATIN

- ANSWERS

‘Graphics’ is a structured drawing application that
allows you to create complex diagrams and illustrations
with ease, which can be easily resized without any loss
of quality.

If you are familiar with a powerful office suite, you
will instantly recognise most, if not all, these features
and will do the same with the spreadsheet and
presentation applications. The real power of ApplixWare,

OVERALL: A A A é
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Linux distribution

Definite Linux 7

It's the first Linux boxed-set built and produced in the UK, with support to match.
Will it put UK Linux developers on the map?

Definite Linux
comes with every
Internet tool
you'll ever need,
including
Netscape
Navigator 4.61

36
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ith the current interest in non-
Windows operating systems and the
huge upsurge of interest in Linux in
general, we've seen our favourite 0S
move from a propeller-head minority
interest to become a mass-market product for all of us.

One of the biggest factors in this transition has to be
the boxed versions of Linux you can buy in any major
PC shop. There are lots available, with distributions from
Red Hat, SuSE, Caldera and Macmillan all vying for shelf
space next to Windows.

All come with hefty manuals that ease you through
the installation and configuration of your new Linux
box, and all include something revolutionary for Linux -
free technical support for if you get stuck. The fly in the
ointment is that this support usually involves either
calling another country or using email - no Linux boxed
set comes with genuine UK support.

Until now, that is...

Definite Linux is based around the popular Red Hat 6
distribution with tweaks and enhancements - more on
this later. It's been around for a while in the form of a
CD-only distribution, and becomes a true mass-market
product with the arrival of this fully boxed version of
Definite Linux 7. There are two packages available - the
standard edition, which we're looking at here, and the
Advanced Server Edition priced at £150. )
Installation is as easy — or as awkward - as.
Red Hat 6. The Red Hat base has a very long list of
supported kit, and Definite Linux expands on that to
include even more. There's still no direct support for
USB or more recent developments such as DVD-RAM,
but this is owing to the state of development of the
Linux kernel itself rather than a deficiency in Definite
Linux. As a desktop 0S, Linux has come a long way in
recent months. Gone are the days of spending most of

Jagen Clittord Consulting
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your time at the textconsole - in common with all
modern Linuxes, Definite installs the most recent
XFreeB6 server, along with efficient and visually
pleasing interfaces like GNOME and KDE.

A wonderful workstation environment it may be, but
Definite very much excels when put into use as a server.
If you're looking for a file, print or even Internet server
for a PC or mixed Mac/PC network, Definite is up to the
job. Linux is a fast, robust OS to begin with, and
Definite's enhancements have done nothing to impact on
that superb stability.

Disk RAID

Definite runs around the 2.2.12 release of the Linux
kernel, the most recent stable release version as we went
to press. It include patches to improve speed and support
for hardware aimed at the server market, including RAID
hardware controllers for large disk arrays. Also included
is direct support for ISDN, something missed by almost
every rival distribution.

With rivals like SuSE offering six CDs full of
applications, you have to look carefully at what you
want. If you're after a robust system backed by strong
UK support at a price cheaper than Red Hat, then there
really isn't any other option.

Frank Charlton

MANUFACTURER:
Definite Software
WEB:
www.definitelinux.com
CONTACT:

0161 4774235

ANSWERS
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PRICE: £39.99 inc VAT Value for money

| Definite Linux

brings out the

i GIMP In you
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Shoot-'em-up

Quake Mission Pack

Quake needs no infroduction. It's the meanest, most ass-kicking, blood-lefting nuke-
‘em-up ever made. But has it managed to convert to Linux with its style intact?

Linux vs Windows

If you've played the DOS and Windows
versions of Quake, chances are you'll
want to know what the differences are
between those and the Linux version. In
a word, none — not in gameplay terms,
anyway. At this stage in the
development of Linux, it isn't as easy as
Windows to play games under. Windows
has advantages like DirectX, which
enable developers to produce games
without worrying about details like
sound and video drivers like they had to
in the DOS days. As we've already said,
Linux Quake suffers from clunky
installation and some awkward |
configuration Issues. Once you get past |
that, the versions are virtually identical

— Linux Quake even uses the same data
files as the Windows version.

hile the entire world is fouting Linux
as the next generation 08 for serious
waork, a lat of us like to relax after
hours with a quick session of rampant
annihilation. A lot of people would
have you believe that Linux can't play games, unless you
count the numberless versions of solitaire and Tetris
which seem to come with every Linux distribution. Ha,
Wrong, wrong, wrong.

Not only can you play [ull-screen games with 3D
acceleration, you can get to grips with commercial titles
such as the new Kingpin and Civilization: Call To Power.
More and more game developers are porting their titles
to Linux, and Macmillan has released the game which
kickstarted the first-person 3D shooter market - Quake.

A huge box reveals a single CD and two small
manuals lurking within. As well as the full version of the
original Quake, Macmillan provide two full mission
packs, both of which were originally sold as extras for
the Windows version - Scourge of Armagon and
Dissolution of Eternity. For the price, that's a serious
amount of guality gaming.

“Kill them all!”

To run Quake under Linux, you'll need a F100 or greater
with at least 16MB of memory and a soundcard which is
100% SoundBlaster compatible. You'll also need between
54 and 130Mb of diskspace, depending on whether you
install both mission packs or not. A 3D accelerator card
isn't needed, although Quake will run with a 3Dfx-based
card if you have one - Voodoo 1, 2
or 3 and both Voodoo Rush and
Banshee are supported, Installing
isn't difficult, since Macmillan
provides a simple seript to unpack
and copy the files to the correct
location. Great stuff.

The game comes in three
versions - the standard Quake,
which runs full-screen from a
console and uses a software
rendering system, an X11 version
which runs in a window using the
Mesa 3D libraries, and an
enhanced Mesa version which
renders via a 3Dfx card. You'll
need to have SVGALIb installed
to use the first, and the second
two require the Mesa 3D libraries
- none of these are supplied with
Quake, s0 you'll need to chase
them up if you don't already have
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Look — a Linux game which doesn’t
involve penguins or playing cards

them. The 3Dfx version also
requires the Linux Glide drivers,

and they aren't supplied either. Again, a trip to the Net
to download the latest versions is needed - at least the
manual does tell you where to go. Luckily, we had both
Mesa and the Glide drivers installed on our system, but it
irks us that Macmillan choose not to supply them in any

way - even older versions would get
you started.

In play, Quake was very smooth,
with the soltware render engine
providing slightly better performance
than the one supplied with Quake for
Windows. We had no problems
installing and playing either of the
mission packs, and the game ran
without hassle - excepting the fact
that forcing it to quit with CTRL-C
often left us with a black screen and

no way to recaver other than a rehoot.

Quake may not he state of the art, but
until we see the likes of Half-Life for
Linux, this'll do nicely, thank you.

Frank Charlton
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Quake for free! 2

If you've already spent money on
the Windows version of Quake, do
you have to fork out to play it
under Linux? Nope — you can
download the necessary patches
and applications, and use them
together with your Windows
Quake CD. Fire up your Net
connection and surf to
www.linuxgames.com/quake/
for details and some excellent
instructions on how to install and
configure Quake for Linux.

ORIGINATOR: = =

id Software X

DISTRIBUTOR: LIN!,‘,!;};; RAT'NGS
Macmill

D;‘\;‘N:gﬂl): Performance & (5 {3 {
www.qualityimage.com Graphics é {3 (} (f
PRICE: free Gameplay (5 6 é 6

ovERAL: A A A D
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Freeware

The best new freebies

Not enough software jewels in your Linux crown? Get your mitts on this little
load of downloadable sparklers, says Frank Charlton

Bluefish is an
integrated Web
development
environment for
HTML authors,
and it's very slick
indeed

lot of the pro-Windows crowd will tell you
that the main failure of Linux is that there
just isn’t a big enough selection of
applications available for the platform and
that Windows has it all. Er, rubbish.

Linux has programs available by the thousand, and
the big plus is that most of them are free. Yes, free -
alter your download costs, you can use them for
absolutely nothing.

Whatever task you have in [ront of you, there's a
Linux program to do it. Over the next two pages we're
taking a look at some of the more esoteric ones which
caught the big, beady Linux Answers eye...

BLUEFISH

Function: HTML editor
Download: http://bluefish.linuxbox.com

ardened Wehmasters like to write HTML by hand

- none of these overloaded, wizard-driven, hand-

helding FrontPage packages here, thank you.
Writing pure HITML gives the highest level of control
over how a page looks, and it's not as difficult as you
might have been led to believe,

You can write HIML with any text editor, but a pure
editor designed for the purpose is way belter - and
Bluefish is such a beast. It’s a very cool-looking app, and
provides an excellent way to develop Web content.
Everything you'd expect to see is here, all controlled
under a slick dialog-driven interface. You can
check your code with Weblint and preview

pages in Netscape with single clicks.

Of all the Web development packages
we've seen so far under Linux,

Bluefish is the smartest — and it's not

even finished yel.

XRN

Function: Internet news reader

Download: www.mit.edu/people/jik/

software/xrn.html

senet news may not be as
popular as it once was,
thanks to the Web

explosion, but it is still a superb

way to learn about and discuss
any topic under the sun from

thousands of newsgroups.

To participate, you will need
a reader, which is where XEN
comes in - it enables you to
download, read and reply to
news postings all via a straight-
forward graphical interface.

Sadly, the look and feel is
very dated, harking back to the

most basic X applications. It's a

capable tool, but the old-style look and feel will put
anyone used to modern Linux apps off right from the
start. There are better alternatives, including the news

readers supplied with Netscape and KDE.

DISKDRAKE

Function: disk partitioning tool

Download: www.linux-mandrake.
com/diskdrake/

orking with hard disk partitions

is never an casy task, and one

slip can send you right up the
creek without a paddle. Windows users
have il easy, thanks to commercial
products like PartitionMagic, but Linux
users have to make do with some pretty
arcane text-based console programs.

Linux vendor MandrakeSoft wants to

rectify the imbalance, and DiskDrake is
the result - a fully graphical partition

editing tool, It's still very much a work-in-progress, hut

is potentially very powerful.

DiskDrake can create, delete and formal partitions,
and can also change the partition type. It can resize
Windows FAT partitions, but can’t do the same for Linux
filesystems unless you don't mind complete data loss - a
shame. Siill, it's carly days yet, although you might want

to wail lor the final release version.

XRN is a

competent news
reader, but
suffers badly
from an old-
school X interface
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If you're serious
about solid 3D
modelling, 3DOM
could be worth a
look — but
beware the steep
learning curve
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3DOM

Function: solid 3D modeller

Download: ftp://ftp.cs.kuleuven.ac.be/
pub/graphics/software/3dom/

o gel to grips with 3D imagery and animation, the

first tool you need is a modeller — the program that

enahles you to construct virtual models in 3D
space. If you've played with or seen Windows modelling
software like

If you've ever had
to wade through
an application's
config file by
hand, you'll love
Dotfile Generator

trueSpace or 3D
Studio, you'll
probably be
disappointed with
3dom - il's one of
the most cryptlic
and awkward
pieces of 3D
software we've
used. To be fair,
it's not aimed at
casual dabblers in
3D, and is much
more a technical
or CAD type of package - the documentation mentions
that 3DOM development is now geared towards it being
used for ‘global illumination® calculations.

3dom is only available as source code and relies on
the Ot libraries being present on your system, along with
the OpenGL 3D graphics extension. It was an absolute
pig to compile on our system, continually reparting that
our copy of gee couldn’t compile executables.

DOTFILE GENERATOR

Function: application configuration tool

Download: www.imada.ou.dk/
blackie/doffile/

indows uses the Registry, MacOS the
Preferences Folder, and Linux dotfiles - for

storing confliguration data for individual
applications, that is. Dotfiles, so-called because they're
hidden from general view by beginning the filename
with a full-stop, don't generally follow any specific
syntax and can be hard to fathom out.

Dotfile Generator is a neat program which supports
popular Linux apps such as
Emacs, the Bash shell,
Procmail and more, and
provides a graphical way o
tweak and edit each program’s

know what you're doing as

there's not much help, but it's
a lot easier than fiddling with
a text editor.

This is a very handy
program to have tucked away.

conliguration, You still need to
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NiCQ

Function: Internet messaging and chat
Download: http://nicq.learnrespect.ora/

R
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C0O from Mirabilis is e

ane of the hottest e s R T
G E 1 o i MrLage o Hick Fesi
instant messaging E

[T
applications for Windows 8 Tepe
users, and a number of
authors have created
compatible clients for Linux.
One of the latest is NICQ,
which wants (o make life ’ﬁf’i |

e

easier by performing every

function from a single
window. It works nicely, too — within limits.

While NICQ performs the basic ICQ tasks, it can't do
stuff like direct file transfers. Worst of all, it doesn’t
provide any way to sign up with the ICQ network, and
expects you to have a user ID and password already.
Other Linux clients can do it, so why can’t NICQ? With
better clients available, there's little to recommend this.

MP3 STUDIO

Function: MP3 creation suite

Download: http://hensa.linuxberg.
com/x11htmi/mul_mp3.html
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nless you live in a sensory

deprivation tank or just got back

from Mars, you'll know what an
MP3 is - a tightly compressed, almost CD-
quality format for storing digital audio,
which has taken the world by storm,

MP3 Studio gathers together lots of individual
resources Lo create a suite for MP3 creation, playing and
management. There's a ‘ripper’ to extract the digital
audio from CD without quality loss, encaders and
decoders to convert to and from MP3, a playlist
manager, an MP3 player and more, all controlled via a
graphical front-end. You can pick up the individual apps
separately, but using MP3 Studio is far casier than
fiddling with command-line options. It all works nicely,
and provides a true integrated MP3 solution.

RATINGS

It ain’t very
pretty and, sadly,
NICQ isn’t all that
functional for
more than basic
massaging

A7 A B [ 11 I

Get involved with
the MP3 action
with MP3 Studio,
a full creation
solution for Linux

BLUEFISH AAAD ¥<:

i Qo 4 For more free
::,—S::M —%—%—'Q—— —  Linux software,
DOTFILE GENERATOR 3_56_)_2}_ take a trip to
NIcQ Al ftp://sunsite.unc
MP3 STUDIO AMAD .edu/pub/linux/
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Further reading

Linux Device Drivers

-

There are many books devoted fo Linux but
can they keep pace with its development?

— =y
5 P

As new
concepts are
infroduced,
they are
explained with
the aid of
sample code:

1
1
I
|
I
|
I
|
I
I
I
|
!
I
1
1
1
1
1
1
1
1
1
1

he big advantage ol the Open Source licence is

that you can make your own changes and

customisations to the Linux source code. This

is particularly useful for developing drivers for

picces of your hardware that don’t have
drivers available (or have drivers that aren’t complete).

Documentation is an area that Linux has often been

criticised on, especially for coverage of low-level kernel
work, as there are times when the only way to work out
how a particular feature works is to read the source code
itself, While this might reflect badly on Linux, the only
people who are likely to he working at this level are
probably going to understand the source code anyway.
That said, if you are writing drivers, you will be using a
much higher level API provided by the kernel, which is
well documented.

A good read

O'Reilly has been consistent in providing some of the
best hooks that cover Linux-related topics and Linur
Device Drivers is no dilferent. Aimed at people with
knowledge ol the C programming language and basic
knowledge ol the various system functions provided by a
UNIX-like operating system, it walks you through all the
different concepts you will need to know to
be able to write drivers, starting at the
basics with an example that does nothing
more than print the text ‘Hello World' to
the system console. '

The book is divided well, with each
chapter covering a distinct area in a
suitable level of detail. Topics covered
include ‘char” drivers, which are used with
devices that Linux sees as a file {eg parallel
ports), ‘block” drivers, which are usually
related fo storage devices, network drivers,
memory allocation, interrupt handling and
many others.
¥y 4 As new concepts are introduced, they

are explained with the aid of sample code
(available from O'Reilly's Web site at no extra cost) that
shows the concept in action. There is also a complete
example driver that drives a simple device you can build
yoursell and attach to your parallel port. It doesn’t do
anything useful, but it gives you a clear idea ol what
would be needed for a real piece of hardware.

The only problem with the book is its age (it was
first published in February 1998). While it may not be
old by book standards, the computing world is ever
changing. So, unless documentation is kept up to date it
can become next to useless in a matter of months. At the
time the book was written, the 2.0 series of kernels was

() MENY I BOOKS

ESSANBRO RUBIN

OREILLY & ASSOCINTES INGC,

in use and the 2.1 series was in development (2.1.43
being the latest development kernel mentioned in the
book), but Linux has now progressed to the 2.2 series
(with 2.3 under heavy development for the 2.4 release
cxpected in the New Year). The difference between the
2.0 scries and 2.2 is substantial and most old drivers
have to be at.least modified, if not completely rewritten,
before they will work properly with the latest kernels.

The author was clearly aware of this and there is a
chapter devoted to the changes between the two kernel
series, which should prove useful, but the majority of the
book is still aimed at the older kernels. The official Linux
Kernel mailing list has publicly available archives which
contain information on porting 2.0 drivers to the most
recent kernels.

This book is considered by many of the main Linux
programmers to be the best resource for people new Lo
writing Linux drivers (it was technically reviewed before
publishing by such luminaries as Alan Cox and Miguel

De Icaza) and the author is well versed in the subject
(having worked with Linux since its creation),
Chris Jones

AUTHOR:
Alessandro Rubini
PUBLISHER:
O'Reilly

ISBN:
1-56592-292-1
CONTACT:
www.oreilly.co.uk
PRICE: £19.99
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RATINGS

This book has well-detailed
coverage of Linux drivers
but, although only 18
months old, it's already
showing signs of its age...

sYsYoYeV |

wERAL: A A A 4 A

40

LINUX ANSWERS

Premiére issue



i
|
|
|

M = Lapel badges

- gilt metal
PC case hodges with enamel inlay
25x25mm 2mp M Linux ties
Ml Electric blue
/ Wl pure siﬁ; with
Custom R WR  printed Tux
PC case badges :
with your own
logo
: Keyfobs
. 3D decals 2 varieties
self adhesive backing Leather and Plastic
40mm and 70mm Linux magnets

40mm dia and
g @ - g N W 3mm thick
To buy please visit our on-line shop www.scotgold.com
> ScotGold Products
Crathes, Banchory, Aberdeenshire, AB31 5JJ
Tel: 01330 844663 Fax: 01330 844480 sales@scotgold.com

) Free Definite Linux T-shirt & baseball cap with
every Definite Linux Boxed set purchased!
Linux Answers and Definite Software plc. are delighted to offer readers the opportunity to buy
acopy of Definite Linux 7.0 and get a Definite Linux T-shirt and Baseball Cap absolutely free!

ANSWERS

The Definite Linux Boxed Set contains: source code, Operating System, Star Office 5.1 (for
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DECEMBER ISSUE 0N SALE THURSDAY 28 OCTOBER — ONLY £4.93

Join us on-line at www.pcplus.co.uk with over £2,000 of software*
available for download plus daily news, reviews and discussion forums

PLUS the best

downloadable

HTML Editors,
SCSI and voice recognition
devices, professional multimedia
authoring, Photoshop 5.5,
PagePlus 6, Adobe InDesign and
all you need to know about
upgrading your motherboard!

5 FULL products * s
nonti's 9 GD-ROMS

Borland Delphi 3

The fastest way to develop your own
applications for Windows!

PLUS: Delphi tutorials

75 pages of extra Delphi material on the
CD - become an instant Delphi expert!

The biggest and best office suite for Linux
users — complete and unrestricted!
InaGrid 1.3 component
Add spreadsheet-like functionality to your
Delphi 3, VB or VC++ applications
Netscape Communicator 4.7
The latest and greatest version of Netscape's
browser suite, for both Windows and Linux
New Millennium Encyclopaedia

The complete multimedia reference work for
home, school and business — over 600Mb!

+ All software mentioned is complete and unrestricted, excluding original packaging and manuals. It is nol time limited, save disabled or feature restricted.
Delphi is the complete software, but the license restricts commercial and educational use, and distribution of applications. Magazine and CD contents subject to changea.



Six of the best Linux versions
are put through their paces

Coderoom
superstars

There are amateur Linux
versions, professional
ones, easy ones, hard
ones, big ones, small

ones... argh! Steve

Patient explains how to
choose the right Linux

for you

well-crafted Linux Source licence allows repackaging and

distribution is a thing of reselling, which means many distros are

beauty. Each one contains based on others.

thousands of programs and A reworked distro is not the same as a

scripts, automated cheap knock-off copy on a couple of gold
maintenance utilities, as well as a set of copies disparage the dedicated work of
Linux productivity programs and libraries many people.

Along with the Open Source GNU
long with tf pen Sou iNL Quality and \Vidth
Most programs in a Linux distro are
released under the GNU GPL [General
Public Licence) which requires source code
to be made available. Generally, single-CD

I

1

I

I

I

1

I

I

I
installation routines, configuration and i discs: reworking can add value; knock off
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programs, which make up most ol any !
Linux distribution (aka distro), a boxed |
version usually includes [ree and demo
versions of Linux software, documentation,
a help system, a paper manual and a boot
floppy. It's a load-and-go solution. solutions arc binarics — compiled Linux
programs designed o run on Intel

original distros as there appear. The Open | processors and clones. A distro with two
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BATCH TEST

Coderoom superstars

Getting started

Current commercially-packaged Linux distributions are
becoming as easy to install as any other PC operating system.
It’s one of the reasons the Linux user base is growing so fast.

or more CDs usually includes source code.
Linux doesn’t need the source to run, but
you do need source to recompile new
kernels, for example, and often to compile
programs distributed only in source form.

=

Having the source locally available makes
life simpler, even if you never look at a
line of code.

Linux has no mechanism for cleanly
installing, upgrading and uninstalling
programs, but there are a variety of
program packaging formats that enable
you to do this. Of these, one ol the best,
and the de facto standard, is RPM, the
format of the Red Hal package manager.
IU's also becoming the standard way to
distribule new Linux programs on the Net.

Most distros now support the RPM
format because it enables you to install,
upgrade and uninstall Linux programs
distributed in either binary or source form.

Hardware issues

Few hardware manufacturers supply Linux
drivers for peripherals yet. Despite this,
Linux supports a huge range. of hardware
but lags behind new releases. Most of the
drivers are free, although there are several
commercial Linux driver vendars.

In general, hardware support is more
or less independent of the distra you
choose. Later versions of XFree&6 support
more video cards; later kernels support
more hardware and file systems.

Multimedia is also an issue. A free
sound driver library supporis the most

common ISA
www.4front-tech.com/
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1 sound cards.
]
I SuSE includes a

]

! licensed version of 4Front’s sound drivers,
! which supports almost all ISA sound

! cards, but for PCI sound cards you'll have
i to buy 4Front’s commercial sound library.
i These and other hardware issues make

nstallation issues

If you want Linux on your PC only, most distros are straight-

forward to install. To set up a dual boot system with Windows
and Linux is trickier because of partitioning issues, but easier
than using most other operating systems for a dual boot system.
(See our feature ‘Start here!” for a comprehensive quide to
installing Red Hat 6.0.)

1
1
1
1
I
]
]
]
]
1
]
I
I
I
I
I
I
I
I
I
I
I
I
|
|
|
|
I
|
I
I
|
1
!
I
1
1
1
1
1
1
1
1
1
1
1
[}
1
[}
1
1
[}
1
I
]
I
I
I
I
I
I
I
]
I
|
I
I
I
I
|
I
|
I
I
I
|
I
I
|
I
I
|
|
|
1
I
1
1
1
1
1
1
1
1
1
1
1
1
]
1
]
]
]
]
1
I
]
1
L}
I
I
I
1
]
]
I
I
I
1
I
I
I
|
!
I
I

All good Linux
distributions have a

help system or two

Besources
Caldera Systems

*» Home
» Channel Po

[

QmgLer?®

Linus Information

W Qasghinyr %

0 Thik Computer for Sy ok

built in, but Caldera’s
OpenLinux 2.3 has an
unusually good Web-
based local help
system

HELP

it worth comparing the hardware
compatibility list of the Linux distro
against your machine specs before buying.

If you're a desktop PC user and want a
graphical front-end, you're in luck: Linux
has dozens. More fortunately, most of the
developer effort is coalescing around two:
GNOME, from the GNU project; and KDE,
from the German KDE group. KDE is
currently leading in ease of use, stability
and completeness,

Why use others? Well, al one extreme,
window managers are fast and take up
little memory, while al the other they
concentrate on ease of use and
interaperability at the expense of lots of
processor cycles and RAM.

A lot of holy wars are fought over
window managers, and especially KDE,
This is because Troll Tech's Ot library on
which KDE is based isn't Open Source in
s0 lar as it doesn’t have a GPL. This
sounds an arcane ohjection to a brilliant
GUI (Graphical User Interface), but Linux
didn’t get where it is today by not
insisting on Open Source.

More importantly, while there are lots
of basic window managers such as
Afterstep and Enlightenment, GNOME and
KDE ‘are IDEs, integrated desktop
environments based on objects, They
enable applications written for them to
interoperate, exchange data, support drag
and drop and more which can’t happen in
a simple Linux window manager.

Unless you're running a Linux server
or an extremely old PC with a slow
processor and limited memory, you will
want to run GNOME or KDE. With most

Linux distributions you can try both. The
reason for choosing a distro with a
particular default GUI is because the
vendors fine-tune the default GUI and
ensure system administration works well
from it.

Up and coming

A lot of developer effort is concentrating
on workslation use, which is why many
distros now support TV cards, scanners
and sound by default. Some now arrive
with TrueType font support built in — until
now PostScript Typel fonts have been the
mainstay for graphical work.

A lot of this workstation ctfort is new
and, to a degree, experimental. When it
works, it’s fabulous, but if you have
unsupported hardware or if it hasn’t been
configured sensibly, then it can be
frustratingly unfabulous.

If you're heavily into multimedia and
graphics hardware, you have to check the
hardware support situation to avoid
disappointment. Of course, if you have
programming or documentation skills you

A reworked distro is
not the same as «
cheap knock-off
copy on a couple

of gold discs
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Linux
Mandrake

Linux-Mandrake 6.0

PowerPack Edition
Mandrakesoft

Web: www.linux-mandrake.com
Price: £41 (inc VAT)

UK supplier: Interactive Ideas
Tel: 0181 805 10000

©debian

Debian GNU/Linux 2.1

Debian
Web: www.debian.org

Price: £8 (inc VAT)
UK supplier: Linux Emporium
Tel: 01491 837010

Red Hat Linux 6.0
Red Hat
Web: www.redhat.com

Price: £52 (inc VAT)
UK supplier: Linux Emporium
Tel: 01491 837010

and getting started guide along with five

CDs, a registration number and a
StarOffice personal key number. Unless you
have a PC capable of booting from CD-ROM,
you have to create a boot floppy using the
rawrite utility on a Windows system.

Basically, there’s an image of the boot
floppy on the installation CD in the /dosutils
directory. It's a Windows app you use to create
the Linux boot floppy. Dead simple.

During the elegant and painless installation
process, you can choose workstation, server or
custom. We chose workstation. It correctly
detected and set up most of the hardware,
including the network card.

We told it what graphics card we had and
gave it the monitor specifications. A few
seconds later it booted straight into KDE. It
also enables you to set up a default,
unprivileged user (a Good Thing).

The binaries are optimised for Pentium
class processors. This makes Linux run faster
but means you can't install this version of
Mandrake Linux to an older i386 or i486 PC.

Interestingly, Mandrakesoft claims 99.99
per cent Red Hat compatibility, which is handy
as there are a lot more RPM binaries on the
Net for Red Hat than other distros.

We had one problem: the kpackage
program, used to install and uninstall RPMs,
wasn't installed — only its desktop icon. We put
it on using the older RPM program.
Mandrakesoft says it's a bug in the workstation
install routine. Otherwise, an excellent choice.

T he box contains an installation pamphlet

RATINGS

his is the purest Linux distribution,
T entirely maintained by volunteers and

made only from Open Source programs.
Unfortunately, Debian developers aren’t
concerned with new users — installation is
horrid, takes hours, requires a good deal of
knowledge, and you have to sit through it as
your input is constantly required.

If you want to install other software, life is
trickier. Debian uses its own deb package
format, not RPM, and most programs will have
to be compiled from source.

A paper manual is available from Debian,
but most of the documentation is on disc,
where you won’t be able to get at it until
you've installed everything. What there is
assumes previous experience of computers, and
ideally of UNIX. Unless you're something of a
quru, we wouldn’t recommend installing
Debian 2,1 unaided.

Once installed and with X configured using
XF865etup, you'll be able to run fywm95 along
with a number of other window managers.
Enlightenment (a window manager) is supplied
but doesn’t seem to be installed by default.
You'll need it if you decide to download and
install GNOME (a desktop environment).
There’s a link to a deb packaged version for
slink (the codename for Debian 2.1).

Despite the less-than-optimally-friendly
graphical front-end you get a lot of useful
software including GIMP 1.0.2, Netscape 4.51
and around 2,000 other programs, but no
Office-style programs though. All in all, Debian
is for computer savvy purists.

RATINGS

he retail version of Red Hat Linux 6
T comes with two manuals: installation and

getting started. Both are good but the
latter assumes you will use GNOME. (You can
choose to install KDE if you prefer, but this
isn’'t covered in the supplied manual — see our
cover feature on page 16 for more on this.)

There's a disc of RPM files and one of
source. You also get a disc of commercial
products including free personal editions of
StarOffice and WordPerfect along with lots of
trial programs.

Naturally, installation is almost identical to
Mandrakesoft’s — quick and easy. The main
difference is Red Hat’s decision to make
GNOME the default user interface (it was KDE
and before that it was fvwm).

Red Hat 6 worked immediately without
problems and is straightforward to find your
way around. We could log on to the Net, print
documents and so on.

On the downside, GNOME doesn’t have as
good a collection of utilities as KDE, which
means a lot of the activities you’ll want to try
have to be done with command line programs,
older X apps or apps from the KDE menu. This
is confusing to many new users (and to some
old ones).

We still think Red Hat’s decision to make
GNOME the default interface odd, especially
when the previous version used KDE, and given
the similarity with Linux-Mandrake which uses
KDE, we'd recommend Linux-Mandrake over
Red Hat. Mandrake’s KDE setup is much better
than Red Hat’s.

B1[1), 4 RATINGS
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Coderoom superstars

SuSE

SUSE Linux 6.2
SuSE
Web: www.suse.com

Price: £32 (inc VAT)
UK supplier: Interactive Ideas
Tel: 0181 805 1000

OpenlLinux 2.3

Caldera
Web: www.caldera.com

Price: £37 (inc VAT)
UK supplier: Linux Emporium
Tel: 01491 837010

Xpresso Linux 2000

Xpresso
Web: www.xpresso.org

Price: £15.95 (inc VAT)
UK supplier: Xpresso
Tel: 0208 559 2600

erman company SuSE makes our
G favourite distro. We use SuSE 6.2 daily

(6.0 and 6.1 before) and prefer it,
despite it having a few problems. SuSE
supplies an excellent manual, six CDs, a boot
floppy and 60 days’ phone and email
installation support.

Installation is via the YaST configuration
utility, which needs an update but is still better
than most. With 6.2 the X setup has been
dramatically improved with detection and
support for a lot more video cards — including
those with 3D accelerators.

Once running, you're in KDE 1.1.1 which
SuSE configures well. You can be up and using
it for real in under an hour. Iit's well
documented internally and easy to reconfigure.

SuSE distros are improving rapidly but the
company continues to make silly mistakes. Last
time it got the keyboards wrong. This time it
didn’t include a font server (so no TrueType
fonts) because it said it wasn't stable, but did
include an unstable version of GIMP.

The only other complaint is it still doesn’t
install most of its own help system. This is
tricky to do yourself without the help system.
There’s still a lot of German in the English
files, too, though less with each release.

SuSE 6.2 is more awkward to install than
Mandrake 6.0 and has minor eccentricities. It's
a great choice for knowledgeable computer
users, but not yet one for the naive.

11 [1), 4 RATINGS

Installation 14 Yo 6!
Dmumentaﬁoﬂ 1 i1 Q _6_(5___&_
Configuration Q O Q Q
We_b support (i_\ 6_ 5 Q
overal: A D D L

LiNUX ANSWERS Premiére issue

penLinux 2.2 was the first Linux distro
0 capable of being installed graphically

from Windows. A version of
PartitionMagic for Windows repartitions the
hard drive and Caldera’s graphical installation
soris out the rest. Basically, anyone can install
OpenLinux on a Windows system and it’s just
as easy on a clean machine.

The Lizard (Linux wizard) installer auto-
detects just about everything. You get to test
and confirm its graphics resolution decisions
and card driver. Finally, you get to play a Tetris
clone while it gets on with the installation. Fab!

With 2.3, Caldera has added some
impressive features including the Applixware
Office suite, KDE theme manager, 4Front sound
drivers and endless program upgrades.

Caldera majored on ultra-reliable server
versions of Linux before releasing OpenLinux.
It’s still more concerned with reliability than
version numbers,-which is a good thing. In fact
you can choose from one of several standard
installations or customise it for yourself — so
servers remain well catered for.

OpenLinux 2.3 uses COAS (Caldera Open
Administration System) for configuration. This
graphical (and text) tool is Open Source and
elegant. Unusually, you can use COAS to edit
config files by hand interchangeably.

A neat touch is Kandalf, a friendly wizard
who helps you decide how to customise KDE as
your first action in Linux.

K1) 4 RATINGS
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his is a cut-down version of Red Hat 6,
T but unlike Red Hat 6 it defaults to the

KDE graphical user interface rather than
GNOME. Xpresso comes on a single CD-ROM
with a small, but well-written, booklet detailing
the creation of a dual-boot Windows/Linux
system, installation and a little on usage.

The installation is as straightforward as
Red Hat’s and as easy as you'd expect — fast,
too. It even boots to Red Hat's own graphical
log-in screen. Xpresso claims it's worked hard
to make this the best and easiest Linux distro
available. Not so.

Under Red Hat you use GnoRPM to install,
uninstall and upgrade programs. The equivalent
in KDE is kpackage. However, Xpresso chose
not to include this, so you have to use the
arcane command line RPM program to do it.
Easier? No.

What's more, there’s a font server but no
TrueType fonts and no documentation on this.

Apart from these obvious points, Xpresso
appears to be a pretty standard Red Hat 6.0
distro with some fairly ham-fisted edits such as
putting WordPerfect on the KDE menus
whether it's installed or not.

As for StarOffice, Xpresso provides its own
key and fake registration details rather than
giving you a personal key.

If you want Red Hat, spend the exira and
get the real thing — it's better documented,
more complete and more flexible.

B[1). 4 RATINGS

Installation Q Q Q .,‘& S
bz.urnenla_tlon . _4-_}_._ Q_é_j
Configuration é é é 4

Web support 4 5 4

overai: AD A A A
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package) instead of the stable version

them are major vendor releases while the

RSl |iNUX
Best bird
Editor’s
choice

The standard distribution for
installing a dual boot
Windows/Linux system is Caldera OpenLinux 2.3. It
wins hands down. If installation doesn’t worry you then
Mandrake 6.0 is the one we found to be richest in features and
most fun to use after installation.

could always help - almost all new Most distros make much of having the

I
‘Gogen T mx The default GNOME 2 Rk :
- P ) T e e ) desktop as installed 1.0.4. Use RPM to replace it with a stable
i | Rt R B, E ol by Red Hat Linux 6 version. (See our feature on page 64 for |
e T & & g showing the GNOME details on this.) i
e T Panel, default L
e e & . o e menus, the file i
P Eabnsn e |
w A manager, user guide 2 i
= _EE:‘_’_*MI * s © 1999 by Fed Mo Satrurare s D . Wnesinr and GnoRPM Andg flna“v |I
Kisn2il - . package manager With the core components of most current !
- - <4 - o = e
i B o '-'"'—‘IHI" i v i"""o*"' - - Linux distros remarkably similar, the best '
- 5 4 @ B OE OB
prs 2 e e buy depends largely on who you are and !
R — | [ he Indeed, as s as :
— N ':E pe ® 8 @ what you want. Indeed, as 5001 as you "
" =] - F Byl o2 a1 - “ 3 \ I
s e TN (S o P gain a little expericnce you'll be y
s et et et [ T o B W modifying whatever distro you have (o \
AMBTLIYH Y - Gt Cunid Bl L8 | s s e - : 5 - S '
et e |[AT1E] L.t suit your own interests and needs. f
< o Coeppesnen o Bl ) L . i ;

e eemn S SO S 4o ik ok st Nevertheless, there arc best distros for
I ‘Sattion -_j =1 | 1

it GHOME L - “ T ]I._\ .rk‘
oyva e particular purposes, and here we take a i
— - 4 STl i 2 2 ]
[ Q e S look at six of the many options. Five of !
1
1
1
I
1

hardware drivers are written by those who
need them.

latest kernel, Apache Web Server, XFree86
or GUI version number, the most apps or
best freebies, But the latest software isn'l
necessarily best.

Linux developers release a stable
version and a development version. The

Under development

1
]
1
:
1
i
I
1
;
Linux is always under development with a |
single person or small group managing i latter can be unstable and might contain
(he development of each component of | experimental code only other experts
Linux (most runs on any UNIX, not just { should be using,
Linux, which refers to the kernel). ! Including the latest rather than the
This means the sofiware that goes into | most stable version can be bad news. This
Linux doesn’t march in lockstep: some i doesn’t happen often but commercial
y pressures tempt vendors to go for the
| highest numher.
| SuSE did this in version 6.2 of its
i distro by including developer version 1.1.7
1 of the GIMP (the brilliant Linux graphic

parts progress by random leaps and
bounds; others shulfle or stop as their
champions lose interest or move on.

The version number ol a distro has no
connection with the component versions.

How we tested the distributions

We tested the distros on a home-built PC. It has a Working from the supplied documentation we UNIX experience. We looked at how well the
166MHz Pentium on a Chaintech motherboard, installed each distro. The ease of installation was distro anticipated new user needs with help
64Mb of RAM, 20x Mitsumi CD drive, 1.2Gb noted with special attention to the X Window systems, pre-instalied icons for floppy and
Quantum Fireball hard drive, 4Mb Matrox System — traditionally the trickiest part. It was CD-ROM access, Net access setup and Net
Mystique graphic card, a SoundBlaster 16 important that all the hardware was correctly set utilities, along with productivity software.
compatible card, an ancient 8-bit SMC ethernet up, especially the modem. Finally, we looked at support issues: the
adaptor and a 17-inch DiamondTron monitor. A Our target Linux user for this test runs a quality of the vendor’s Web site support and
generic external modem was attached. workstation on his/her own with no previous personal installation support.

Distribution Mandrake 6.0 SuSE 6.2 Red Hat 6.0 Debian 2.1

OpenLinux 2.3 Xpresso Linux 2000

Default GUI KDE 1.1.1 KDE 1.1.1 KDE 1.1.1 GNOME 1.0 fvwm95-see text KDE 1.1

cds 3 5 6 3 4 1

boot floppy* Yes rawrite Yes Yes rawrite rawrite

Source Yes Yes Yes Yes Yes No

Kernel 2.2.1 229 2.2.10 225 2.0.36 225

XFree86 334 33.3.1 3.3.4 33:3:1 2.0.36 3.3.4 |
StarOffice Yes Yes Yes Yes No Yes !
WordPerfect Yes Yes No Yes (UK) No Yes

TrueType™ No Yes No Yes Yes Yes

Run Windows apps  No WINE VMWare trial No No No

Support 90-day email email 100-day email/phone 90-day email none none

“Is a boot floppy supplied or do you have to make one?  ** Is there a TrueType font server pre-installed?
All Linux distributions can be downloaded from the original vendor online
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The fastest growing website in Europe

Future Online is your gateway fo the most excifing confent on the Net.
Point your browser af www.fufurenet.co.uk and starf exploring...
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Discover the secrets of the Get more from KDE, the K Learn Bash, the command-

GIMP, the Photoshop- Desktop Environment, with line interface (p62), and find
standard image package our 20 top tips (p56) and out how to install software
(p50), and find out how to find out how to customise on your souped-up Linux
recompile the kernel (p66) Linux for speed (p70) machine (p64)

There’s no need to trundle along in L-plate
humiliation around here, well not this month anyway.
Features labelled in green are for you

s Wwith

INUX

Whew, it’s finally installed. Now

ey, 2 {58 for the fun bit — discovering how
Everyone can find out more, even members of the © o °

R;I)Ier—driving Linux aristocracy. Find out how to | exce"ent Llnux rea"y IS...

"~ make your Linux installation better. Look out for red

INTERMEDIATE 4

* Memories of your dull/lecherous/crooked driving
instructor are well behind you. So now what? Time to
stretch your legs on the Autobahn. Blue’s for you

L

Premiere issue LINUX ANSWERS 49



———

WORKING WITH LINUX

the GIMP

Behind its geeky name, the GIMP offers a powerful, Photoshop-
quality image manipulation program. Michael Hammel discovers
its features and capabilities

provide a more cost-effective alternative for
graphic designers, especially those working on
the Web.

inux has grown up in the traditional |
backrooms reserved for other UNIX servers, !
out of sight and out of mind. But unlike its y

predecessors, Linux has a future on the : In this article we take you on a grand tour of

desktop. The X Window System provides the 1 the GIMP, which you can install from our Cover

technical framework upon which graphical, user-friendly i CD. So, grab your hat, your coat, and your

:'

I

I

1

I

I

I

I

1

I

1

1

applications have begun to appear. One of the most Linux desktop - we're on our way!
intriguing of these is the GIMP.

GIMP stands for the GNU Image Manipulation
Program. It is a graphics design package which looks and
feels very much like Photoshop, the popular Mac and PC
application from Adobe Systems. Although not a
complete replacement for its Adobe cousin, GIMP does

IT'S ON
THE €D

e ONU beape Munipedsog Prigram
Michael J Hammel is the S =
author of The Artists’ Guide to the Gimp

1) The GIMP toolbox

Like Photoshop, the GIMP is managed via menus and a Toolbox. Photoshop users will

find the GIMP’s toolhox familiar, but it’s not an exact duplicate.

- - -

| £ perl Contral Center
3|« Perl Sarver

|7 Script-Fu__

_Lo@bs :

. Patterns T A
o 3D Truchet
Wl Webpage themes o o 0 pa00
' “ Flatland

. il
‘Swirly (tileable)
‘Trochold
Truchet
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The Toolbox for the
GIMP looks fairly
similar to Photoshop.
This is the standard

| interface for the

current release of the
GIMP, version 1.0.
Most Linux
distributions ship this
version ready to run
and the interface will
have the same
colourings shown

| here. The Xtns menu

provides access to
features that are not
specific to any Image
Window. Here, an
Image Window is
shown with a
colourised photo of
some 1940s dancers

1.0 (RGBE)

The forthcoming 1.2 release, due out at the end of the year, adds
many new features (download it from www.gimp.org). Here you see
a unique trait of the GIMP - a user-configurable interface. Using
‘themes’, you can add colours, shading, even 3D effects to the
program’s interface. The toolbox gives you quick access to the
dialogs for the brushes and patterns via the small buttons at the
bottom of the window. The Image Window now provides a Quick
Mask feature, like Photoshop’s. The small red box on the lower left
corner of the Image Window toggles the Quick Mask on and off



NNER

L

Layers in the GIMP work just like layers of clear acetate - stack them on top of
each other to generate the final image. Channels provide direct access to the red,
green and blue components of an image, or user-generated masks. Paths let you
draw and edit curved lines. Layers and channels in 1.0 and 1.2 work pretty much
the same way. Paths, however, are new to 1.2.

Now click on the
Channels tab in §§

the dialog. Here you see
the three standard
channels, one each for
red, green and blue. If
you click on the eye icon
in the blue and red
channels, you can turn
them off. This results in
the original image being
displayed with only its
green component visible

Using the developer’s
release for 1.2, we've
clicked on the Paths tab in the

Layers and Channels dialog.
Here we can create Bezier
curves ~ lines with control
points that allow us to change
the shape of the curve between
the points. The curves can be
stroked using the current brush
and drawing tool. Here, we've
created a few curves over the
background of the original
image (with some of the
original layers turned off) and

| then stroked them with a

Il gradient brush. The Gradients

| dialog enables us to choose or
edit the gradient, while the
Brushes dialog, in the upper
right, lets us select a brush and
some of its characteristics

Open the Layers and Channels dialog box by selecting

the correct menu option from the File > Dialogs menu in
the Toolbox, or by typing CTRL-L in the Image Window. The
dialog follows the active image in the 1.2 version, so just click
on another image and the dialog updates automatically. The
dialog shows which layer is active, and here you can group
layers for move operations, toggle their visibility on and off or
blend them with lower layers using one of many blend modes.
Here GIMP 1.2 is shown using the BlueSteel theme. You'll see
various themes throughout our tour

3) Selections & masks

One of the GIMP's key features,
like other tools of this ilk, is that
you can process regions of an
image selectively. The GIMP
provides many tools for creating
accurate selections, even
selections of complex shapes
with non-continuous
houndaries. We're using GIMP
1.0 here with the BlueSteel
theme, so this is something you
can ry out now.

We start with a scanned

photograph of a balloon launch
over a lake. Our goal is to extend the
colour contrast to change the mood
of the image. We create a selection
using the Select By Colour dialog.
Press the right mouse button in the
Image Window to open the menu,
then choose the Select By Colour
menu option. Set the Fuzziness
Threshold level to 112 and click in
the Image Window over an area of
the balloon that is partially lit. The
Select By Colour dialog shows a
greyscale representation of the
selection. White areas are fully
selected, black are not, and shades of
grey are partially selected

-
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Secrets of the GIMP
3) Selections & masks (cont.)

Save the selection to a channel by first choosing

Edit > Copy. Create a new channel by clicking
on the New Channel button (lower left of the
Channels page). The new channel will be active, so
use Edit > Paste to create a floating layer. Floating
layers are created whenever you paste into an Image
Window. Click on the Anchor icon (in the Layers
page) to anchor the floating layer into the new
channel. Now choose Image > Colours > Levels.
Adjust the middle triangle in the bar below the
histogram most of the way to the left. This increases
the white levels. Adjusting the left or right indicators
will change the black and white points, respectively,
enabling you to set the true range of colours in an
image. By adjusting the middle indicator, we have
effectively created a more solid (but not completely
solid) mask from the original selection

Apply the Auto Levels
feature of the Levels dialog
to the selection. Right-mouse click

Duplicate the original layer
(fourth button from left,
Layers page). Click on the

Channels page again. Right-
mouse click on the name of the
channel you just created to open
the Channels menu. Select
Channel to Selection. Feather
the selection by about 45 pixels
(Select > Feather in the Image
Window menu). This gives a
much more complete selection of

in the Image Window to open the
menu, then select Image >
Colours > Levels. Click on the
Auto Levels button. Without
closing the dialog, adjust the
middle indicator to the right
again. Did you see the colour
ranges change? Click on OK to
apply the changes

the balloon, plus some of the sky
and lake. The feathering will
smooth the operations we're
about to perform along the
edges of the selection

To see how the mask could be used, right-mouse click on the duplicate balloon

layer and select Add Layer Mask. Choose a white mask from the dialog prompt.
Now, go back to the Channels page and click on the new channel to make it active.
With the mouse cursor in the Image Window, type CTRL-A to selecl the entire channel.
Select Edit > Copy from the Image Window menu (remember, right-mouse click in the
Image Window to open that menu). Click on the layer mask you created a moment ago
to make it active. Now choose Edit > Paste and anchor the new layer into the mask.
Turn off the visibility of the original layer by clicking on its eye icon. What you have left
is the duplicate balloon layer with the only visible portions being those corresponding
to the white areas of the mask. The grey checkerboard pattern is displayed to show
transparency (although you can change this look using the File > Preferences menu
option in the Toolbox)

Now, for comparison’s sake, let's take a look at the original, the channel

we created from it, and the mood-adjusted version, What started with a
photograph of an early morning balloon launch has changed to an early
evening scene
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4) Gradients & gradient brushes

To the uninitiated, gradients might seem o [ T R s ik e Double-click on the Paintbrush tool to

HECTECTN (Yo i e i 3 open its Tool Options dialog. Click on
the gradient toggle. Open the Gradients
dialog (Dialogs > Gradient...) and select
Incandescent — or one of the many
predefined gradients available. Now click on
the brush button In the Toolbox (bottom row
of Toolbox, on the left) to open the Brush
Selection dialog. Select a brush. Now start
painting in the Image Window. lust hold
down the left mouse button and drag it
around. The colour of the brush stroke
changes according to the gradient selected
and the type (which defaults to Loop
Triangle). To get a stroke that looks more
like a real brush stroke on an artist's
canvas, try adjusting the spacing in the
Brush Selection dialog. When you're happy
with the design, just stop painting

mundane. They are, after all, just
variations on coloured bars that line up
one after another that may or may not
merge smoothly. But gradients are the
hasis for many special effects: 3D balls,
shadows, soft borders, and many others.
Gradients are also commonly used to
generate tiled backgrounds, as this
example demonstrates. Gradients are
available in both 1.0 and 1.2, but we'll be
using a new feature of 1.2 in this
example: gradient brushes. Notice that
we've switched themes - this one is
known as “Odo”.

To tile the pattern, select Image Displace the Image using Filters > Map
> Channel Ops > Offset from > Displace. Keep the default settings
the Image Window menus. Click on for an image that’s about 400x400. Offset
Offset by (x/2), (y/2) and make sure the image again. There will probably be
that the Wrap-Around toggle button is some measure of non-uniformity in the
| set. Then click on OK. The edges of image through the middle horizontally
| the original image will now be lines and/or vertically. To clear this up, use the
that cross the middle from top to Clone tool (the tool that looks like a rubber
*| bottom and left to right. Paint over stamp in the Toolbox) with a brush that is
these lines to hide them. To make sure not uniform in shape (something like
you get the new edges right, offset “Galaxy, Small”). Set the brush opacity to
| the image again and double-check about 75. In the Image Window, hold down
| that the middle of the image looks the Shift key with the mouse cursor over an
smooth. Add some random noise to area about halfway from the centre of the
the image: Filters > Noise > Neisify. image to any corner. A cross-hair displays when you do this. That's the source
Turn off the Independent toggle and location. Now release the Shift key. Move the mouse over the straight-lined portions
move the red slider forward a bit to of the offset image, hold down the left mouse button and drag the mouse around. The
add more noise, If you don’t turn off pixels from the source region are merged with the area under the mouse, removing
the Independent toggle, you'll get the linear aspect of the image. You might need to reset the source location as you

noise with a red tint to it move near the edges of the image. Offset the image again and verify (or fix if

necessary); all the edges are no longer visible

Blend modes enable you to combine pixels
between two objects. They are most often used
with layers as they can create interesting effects

We start with a

scanned photo of
some balloonists over a
nearly uniform blue sky

without changing any pixels. Blend modes are also backdrop. Create a
used with brushes, enabling you to blend brush second image with the
tiled gradient like we

strokes with existing image pixels.

Blend modes can generate many visual effects.
One of the most uscful is to bring out the highlights
in an underexposed scan. In the following two
examples, we'll look at using blend modes to
generate an interesting visual overlay to an image,
and to fix an underexposed scan.

did with our example on
gradient brushes
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Secrets of the GIMP
5) Blend modes (cont.)

L

-ﬁiﬁiiii‘ii';si

2 With the mouse cursor in the tile image, type CTRL A to select the
entire image. Choose Edit > Copy. Move the cursor back to the image
of the balloonists. Select Edit > Paste and convert the floating image this
creates in the Layers and Channels dialog into a new layer. This is done by
choosing New Layer from the Layers menu (right-mouse click on any
layer’s name). You now have the tiled image layered above the balloonists,
but only the tiled image is visible. Left-mouse click on the tile layer's name
to select it, then choose Colour from the Mode menu. The colouring of the
tile layer Is now combined with the entire balloonist layer to generate the
effect shown

3 k-
<V

4 To show how a blend can fix an underexposed scan,
we start with the bad scan. Note that the background
in this image is fairly well lit, but the subject in the
foreground is exiremely dark. Despite the appearance,
there is plenty of information in this region of the image.
We just need to bring it out

Premiére issue

Duplicate the layer and desaturate

that duplicate (Image > Colours >
Desaturate). Type CTRL-A to select the
entire duplicate layer. Choose Edit >
Copy from the Image Window menu.
Next create a layer mask for the
duplicate. Click on the mask to make
sure it's active, then choose Edit =
Paste and anchor the floating layer
into the mask. Choose Image >
Colours > Invert for the mask. This
makes the dark regions of the image
show through and masks out the light :
regions. Enhance the mask using Levels (Image > Colours > Levels) and/or Brighiness-
Contrast (Image > Colours > Brightness-Contrast). Now Gaussian Blur the mask. The
larger the blur, the softer the effect of bringing out the details in the dark region

The last step is to change the

blend mode for the duplicate
layer to Screen. This enables you to
add the grey regions of the duplicate
which are not masked out to the
original layer, and this then makes
them become lighter and more
detailed. Depending on the image you
start with, you may want to use |
Overlay instead of Screen. The white
regions of the mask need to be the
regions you want to bring out, but
you can perform the opposite -
operation (overexposing the scan) by not inverting the mask. You can generate many other
effects by either inverting or not inverting the mask and by choosing one of the many
blend modes available

Tumn off the

visibility of the tile
layer temporarily (click
on its eye icon). Create
a layer mask of the
balloon and its
occupants with the
Fuzzy Select tool. If
you're using the 1.2
version, you'll be able
to set the Fuzzy
Threshold level to about
4 or 5, something pretty
low. In 1.0, you might
have better luck with
the Select by Colour . - - i
dialog. Using a low threshold is poss:b[e hecause there is a high r.olour
variation between the sky and the rest of the image. You should be able to
get a very good selection of the sky with an image like this. Select Edit >
Copy. Creale a layer mask for the tile layer and click on it to make it active.
Select Edit > Paste and anchor the floating layer into the mask. Note how
the effect from the previous frame is now only applied to the balloonists.
The effect is more dramatic if you made the selection with Fuzzy select
because it won’t have any semi-transparent pixels (grey pixels in the mask)
in the middle of the image. Select by Colour might, but you can adjust the
levels in the mask to fix this




6) Interface design

Filters, which we've just touched on when we used the Displace filter in
the gradient brush example, are the workhorses of special effects in the
GIMP. These are all external programs, although a large collection of
them are standard with any GIMP distribution. Here we'll create a
funky 3D metal plate, something you might do while working on a
multimedia application.

Let’s start with a black-and-white image. The outline was hand
drawn, scanned, contrast enhanced, blurred and enhanced again. Then
the inside was selected, feathered and filled with black

ol Xl =0, 0.4

Cancel

Working on a duplicate layer (we'll need the original later), we blur the entire image

to create soft edges. The wider the soft edges, the more dramatic the 3D effect. Open
the Filters > Map > Bump Map dialog. A linear mapping, possibly inverted, will probably
work best, depending on the shape and amount of blur applied. Increasing the elevation
and depth will change the height that the edges appear to sit above the layer. The azimuth
will change the direction from which the light shines. Play with these until you find
something that looks acceptable. Click on the OK button when you're done

What's left? Well, you can add a black to

white gradient layer that has the original
layer applied as a layer mask and set this
layer’s mode to overlay. The new layer is
placed between the bump-map layer and the
tile gradient layer. This will produce the dark
to light highlight you see running across the
face of the plate. The background is another
layer, below the other visible layers, that was
created by generating some noise (Filters >
Noise > Noisify), masked with some Solid
Noise (Filters > Noise > Noisify), and
coloured with multiple gradients. Of course,
the way the light shines on this plate, out in
space, means either that there are two light
sources or the plate has some strange
properties! But you can see how easy it is to
create some complex effects with the GIMP!

Returning to our tiled gradient brush example, copy the

entire tile image (Edit > Copy). Paste it into the bump-
mapped image and make it a new layer. Choose Scale from the My Lapests
Layers menu if you need to make it fit the current image. i
Select the original layer (click on its name), type CTRL-A, and
choose Edit > Copy. Duplicate the bump-mapped layer and
add a layer mask to the duplicate. Click on the mask to make
sure it's active and choose Edit > Paste. Anchor the floating

New Layer copy copy

layer into the mask by clicking on the Anchor icon. Turn off H H

the visibility on the original layer and the bump-mapped layer. N ow tu ke 0 "I p tO our WED s”e OT

Now click on the tile layer and change its blend mode to 5 -

Overlay. You may find the effect works better with a different www.linuxanswers.co.uk fo find out
blend mode, depending on the colours used and brightness of

the tile layer 4 about distortion and rendering filters
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) Clean up your
rkspace

20 ways to make the most of KDE

Know your way
around KDE but
want fo get more
from it? Matt
Kynaston gives you
some tips.on how to
customise your
desktop environment

ow that you've successfully installed
Linux, you can start to customise your

@ ¢ EENTT S | | The KDE task
% Ede BemshRae 0 Help manager busily
at work (see tip

desktop environment. KDE is easy to get Frocessss Lt | Partmance Mater | iy
to grips with, especially if you're used to [ - Bunniog Processes ~ kni;mg;'u""’ s %
5 - - - . u wan
a GUI like Windows. Here are 20 tips to ||| ams | pio {useric | cpu. | i | hica | Statss | Raamory| iasiaant |55,
k | @ Hop 2025 matt 310% 001 GRun 5872 4076
help you find your KDE feet: &regt  2004mat  000% 000 OSkop 6168 4200
&kﬂeh(‘lp 1877 mat 000% 002 O Sleap 8212 Hrd4
& kedn B43 matt 000% 003  035leep 8208 4296
Help is at hand | @ ksnapshot Ragmam  1310% 006 OSeep %212 7048 |
E . grmvﬂ!&l SB3 malt nonw oo 0 Slewp 1832 L1 |
You'll find a lot of excellent documentation || % kogndwm  S4Sman  000% 002  OSlesp  BZ80 3832 |
s o PR rl el K kpanel 544 matt o0.00% 0:.07 0 Slesp BO48 4158 |
with KDE itself. Click the hook icon on your @ ook S43mar  000% 000  OSmep  ESen 3882
panel to launch KDE ht‘]p_ t? Kim 542 matt 014% 020 n.‘:l]nen 4792 7438 ,_fJ
1
I™ | Show Tree O procassed ri Rutrash Now Kall task

Not every program on your system is

available on your K menu. To add them all,
run K = System = Appfinder. This puts them all in K
> Personal > Red Hat Linux. You may want to move
them to more useful places later (see ‘Adding
Netscape to your panel’ for an intro to KMenuEdit).

51 Processes Memory: 118836 kB usod, 11190 kB froe - Swap: 318 kB uzed, 136228

2 Add all your programs to the K menu

and upload from FTP
KFM, KDE's file manager, displays FTP sites
Jjust like folders on your local drive. Just go online

3 How to use KFM to download
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and then type fip:// followed by the address into the
address bar. If you're working on your Web page, or
using another site with a username and password,
simply type ftp://<ftpsite-username>@ followed hy
the ftp address, and KFM will prompt you for the
site's password.

Browsing Web pages

with the File manager

KFM moonlights as a Web browser, too. Just
type a URL into the address bar, and off you go. This
is great, but if a folder on your local drive contains a
file called index.html, when you open i, KFM will
display that page. To see the [iles, select View and

uncheck HTML View.
5 Has Netscape died on you? Well, don’t
despair! KDE's task manager is the equivalent
of the Windows three-fingered salute (Ctrl-Alt-Del),
and it's available from K > System. Sclect the
program and click Kill Task. You can also hit Cirl-
Alt-Esc, then click with the skull-and-crossbones
cursor on the misbehaving window to kill it, Unlike
Windows, this won't mess up other programs that are
running or bring your whole system down!

Ctrl-Esc — Switch to another open application
Alt-Tab - Traverse windows on current desktop
Ctrl-Tab - Traverse virtual desktops

Ctrl-F[n) - Switch to virtual desktop ‘n’

Alt-F& - Close current window

How to kill programs

Keyboard shortcuts
Is your mouse giving you tendonitis? Well,
try out these wrist-savers:

But remember, this is Linux, so you can change
these or make your own. To do so, go to K > Settings

> Keys > GlobalKeys.
’ Do you need to launch an application quickly
but don’t want to open a terminal just for

this? Hit Alt-F2. Note: you can't use this for
commands that give a prompt such as su root.
8 Want a program to run at startup? Just make
a kdelnk to it (copy program from the
Templates folder to your desktop and edit the
properties — see ‘Adding Netscape to your panel’ for

an example). Now drag it into the Autostart folder on
your desktop.

The mini command line

Running programs at startup

Window trickery

Windows users will find the three buttons at

the top-right of a window familiar: Minimise,
Maximise and Close. But KDE does more than this.
Try double-clicking on the title bar of a window.
Everything but the title bar disappears - this is a (rick
known as ‘shading’ that any Mac user will know well.
Now try clicking on the Maximise button with your
right and middle mouse buttons (if you're emulating

BEGINN

e

three buttons, click both buttons at once for middle).
You'll also notice a pin on the top-left of the window.
Click it and the window will ‘stick’, and then appear

in all your virtual desktops.

1 This is the place to go for KDE-wide
configuration and system information.

Open it up and have a poke around. Try playing with

the following:

The KDE Control Centre

Applications > File Manager
Change the colours and fonts for KFM
Applications > Panel > Disk Navigator tab
Click Ignore case when sorting if you can never
rememher if you're looking for .Xdefaults or
xdefaults
Desktop > Desktop Icons
Check Transparent Text... to make the background
show through icon text. Try doing that in Windows!
Information > Partitions
Examine your drive selup
Windows > Titlebar
Change mouse action if you want the titlebar to
iconify instead of shade when double-clicked

Do you want to print a file quickly? Put

1 1 an icon on your desktop on to which

you can drag and drop files. First you need to know
what your printer is called. If you chose the defaults
during printer setup, it will be called ‘Ip To be sure,
check K = Utilities > Printer Queue. The printer
drop-down list shows the name you seek. Open the

Prag-and-drop printing

Jargon busters

-

Not au fait with all the terms we've used? Well here’s a guide to some of the

tricky terminology:

K > Utilities > Konsole
Click on the K menu at the lower left of your screen, then click on the

Utilities menu item to see those choices, and then click on the Konsole

menu item

$HOME/Desktop
This means the desktop folder in your home directory, in other words

/home/<username>/Desktop. In the K file manager, it’s known as My -
Home. In the terminal, type SHOME and it will work out what you mean

Alt-Tab
Hold down the Alt key and hit the Tab key

<your password:>
Type whatever is indicated, without the <...>

Virtual desktop
By default, KDE has four desktops. Quickly switch between them using
Alt-F1 to Alt-F4

Edit the file...

There are a number of different programs you can use for editing files.

KEdit

is probably the easiest. If clicking once on the file doesn’t open KEdit, right-

click, choose Open with... and type kedit in the box
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Templates falder on your desktop and drag and drop
Right-click on it to select Properties. On the General
tab, change the name to Printer.kdelnk. Go to the
Execute tab, If your printer name is the default Ip,
type the following in the first Execute texi hox:

lpr %f
If your printer name is anything else, type:

Ipr -P<your printer name> %f

Now select an icon by clicking the big wheel

hutton, then click 0K,
12 an't remember which bin (binary file)
you were just in? KFM, the file

manager, has a handy bookmark feature - use it to
go to your favourite hacking zones quickly.

Find a shortcut

Bookmark the spot

the Program icon to your desktop, then choose Copy.

Kc€harset: wrona charset!
13 If you launch an application from a

terminal, you'll sometimes see this
puzzling message. It's only a warning and nothing to
worry about. If you're fed up with it, though, open K
> KDE Control Centre and select Languages under
Desktop. Make sure the first, second and third

language options are all the same,
Got a small screen and need more

1 l space? Go to K = KDE Control Panel

and select Applications > Panel > Panel tab. In the
Taskbar box, select hidden. This hides the bar across
the top ol the screen. You can still access all the open
programs via the Windowlist button on the panel at
the bottom of the screen. Next, go to the Options tab,
and check Auto-hide Panel. Now the panel at the
bottom will hide itself. To get it back, just move your
mouse to the bottom of the screen. And don't forget,
you can have all the virtual deskiops you need.

Making space in your desktop

How to add Netscape to your panel

Like all things Linux, there's more than one way to do this. The method we
describe is a little long winded, but it takes in a couple of other tricks, too.
Once you’re done, you’ll have shortcuts on your desktop, in all users’ K
menus, and on your own panel.

First let’s put a .

Netscape shortcut on |§
our desktop. Click on the [2£
Templates folder on your
desktop and drag the
Program icon to your
desktop. Select Copy
from the popup list

Right-click on the

icon and select
Properties. Under the
General tab, change the
filename to
Netscape.kdelnk. Under |
Execute, type:

nefscape %f

into the Execute text box,
then click on the wheel
button to change the icon

for the shortcut. There’s a lot in there, but scmll down until you find the
Netscape symbol, click on it, then click OK.

Now go to the Application tab and, under Name, type Netscape. Click
OK to close the Properties window. You should now have a Netscape icon on
your desktop.
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Now we need to add Netscape to all users’ K menus. As this involves
? changing more than just your personal settings, you'll need to be root.
Click on the Terminal icon on your panel and type:

$ su root
Password: <enter root password>
& kmenuedit

KMenuEdit is a program for editing menus. You'll see your K menu displayed
on screen. Select the Internet group to open it. Now drag the Netscape icon
from your desktop on to the open Internet group.

We don’t want
Netscape
hidden down at the

bottom of the list.
Right-click on the
menu entry and
choose Select item
for moving. Then
drag the Netscape
entry up to the top.
Once you're happy
with the order, save
your handiwork
with File > Save,
then quit. Back at
the Terminal window, type exit so you're no longer root.

The last step is to add Netscape to your panel for even faster access.
Select K > Panel > Applications. The entire K menu will open. Select
Internet > Netscape.

That done, you now have four ways of launching your Netscape browser.
You can type netscape in a terminal, click on (or drag an HTML file on to)
the icon on your desktop, start Netscape from your K menu or launch it from
your panel.



Rodent angst

Getting your wheel
mouse to work

Getting yeur wheel mouse to work with KDE is just a question of a quick
hack and a simple installation, provided you have a supported mouse. Most
of the common ones — MS Intellimouse, Logitech and MouseMan — work
fine. Even so, wheel-mouse support isn’t universal — the program must work
with them in the first place (like StarOffice), be integrated into an
environment that understands wheels, or be tweaked by you. Netscape falls
into the last category, so we’ll show you how to make it reinvent the wheel.

But first a bit of hacking. Log off, then log back in as root. Open your
file manager, switch to Tree View, and then navigate your way to the
/etc/X11 directory.

Find XF86Config, right-click and select Copy. Then right-click on a
blank part of the directory and save it as something like XFConfig.bak — this
file contains all those precious monitor settings, so you don’t want to lose it!

Now click on the file. It will open in KEdit. Scroll down until you find:

Section “Pointer”
...bunch of stuff...
EndSection

This is where your mouse setup resides. If during installation you chose
‘Emulate 3 buttons’, you'll have a line Emulate3Buttons... among the stuff.
Put a # at the beginning of the line to comment it out — wheel mice don’t
like emulating anything.

Next, find the line Buttons ... and change it to read:

Butions 5
ZAxisMapping 4 5

Save your handiwork and close KEdit. For GNOME; this is all you have to do,
but with KDE it's not quite so simple.

Put the Linux Answers CD-ROM in your drive and mount it by clicking
the icon on your desktop. Then, from a type:

rpm -Uvh /mnt/cdrom/extras/wheel-mouse/imwheel*

This installs the imwheel program. Log off, then back in as yourself, hit
Alt-F2Z to open up the mini-command line and type:

imwheel

You should now find that you can scroll windows using your mouse
wheel. However, you don’t want to have to type imwheel every time you
login. To make it run automatically at startup, place a link to it in your
Autostart directory. You can do this by typing the following in a terminal:

In -s /usr/X11R6/bin/imwheel SHOME/Desktop/Autostart

Unfortunately, Netscape doesn't take any notice of this. If you want to
surf with your wheel, you’ll have to do some more hacking. Take a look on
the Linux Answers CD-ROM in extras/wheel-mouse, and you'll find a file
called imwheelrc-netscape. Open this in a text editor and cut and paste it
to the end of /etc/imwheelrc.

Restart imwheel, then give it a try. Try holding down the Shift key while
you wheel. If you've got Netscape set up as your newsreader, try holding
down the Windows key to move between messages.

For more information on imwheel, hit Al-F2 and type man:imwheel or
visit hitp://solaris1.mysolution.com/~jcatki/imwheel/. See the
‘Essential Web sites’ box over the page for more wheel mouse info.

Read the manual
The manual pages give every detail of all
the commands you can type in a terminal

15

window. To read them in a KFM window, Alt-F2 and

type man:<commands>
1 6 If you want to hack some system files and
need root access (o them, you can open a
special file manager as root. Go to K = System > File
Manager (Super User Mode). You are prompted for your
root password, then the file manager opens. Select File >
Terminal if you need a root terminal to work in. Be very
careful, though, you can do serious damage to your

system when you're root!
1 1 Tired of your blue background? Right-click
on it, select Display Properties and choose

some colourful wallpaper. If you have a favourite image

you want to use, you can put it in fusr/share/wallpapers
1 8 resolution and colour depth

You control screen resolution and colour
depth via X, not KDE. Bul if you specified more than one /
default resolution when you set up X, you can toggle
between them using Ctrl-+. Colour depth is a little
trickier. If you don’t have a graphical login, type:

Edit your system Files

€hange your wallpaper

]
'
E |y
&
]
2]
&
nE
3
g
w
|
=
)
W
1

€hanging screen

starix — -bpp <colour depth>

where <colour depth> is 8, 16, 24 or 32. For a more

permanent solution, either run XF86Setup again and

change your defaults there or manually edit XFa6Config.
graphical login

1 9 If you've setl up your system so that it

boots into the standard text login and now want to make
it boot to the Red Hat graphical login, you must edit
[ete/inittab. To do this, you must be rool. Note: il you
get this wrong, you may not be able to log in at all!

Go to K > System > File Manager (Super User Mode).
You'll be prompted for your root password. Open the [etc
directory and copy the file inittab to something like
inittab-backup, then open the original in a text editor.
Find the linc:

Adding or removing the

id:3:initdefault:
and change if to:
id:5:initdefault:

Then scroll down to the hottom of the file and make sure
the last line is:

x:5:respawn:/etc/X11
/prefdm -nodaemon

Note: if you've installed GNOME or KDE separately
since you sel up your system, this last line might be
different, so you'll have to figure out where it should

s 3
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point to. Save your handiwork and type init 5 from
the console to test your new setiings.

Removing your graphical login is just the
reverse, Find the id:5:initdefault line fete/inittab
and change it to id:3:initdefault. Next time you
reboot, you'll get the classic text login.

How to change your desktop
environment
Switching desktop environments is

easy, as long as you have another installed. Go to K
> System > Desktop Switching Tool and choose
GNOME. Logout to restart X. If you want fo use
GNOME by default, open $HOME/.XClient-default
in a text editor. Change the line:

exec kde-session

exec gnome-session

Your key to the K Desktop Environmet

Finding out more

Need a quick K fix? Then take a trip to one of these handy Web sites

.dedicated to the K Desktop Environment:

www.uk.kde.org
The UK mirror of the KDE pages. Vital reading

hitp://lists.kde.org
Massive searchable archive of the KDE mailing lists. If you've got a problem,
chances are the answer’s here somewhere

www.inria.fr/koala/colas/mouse-wheel-scroll/
Everything about wheel mice and Linux

hitp://kde.themes.org
Customise your desktop. Thousands of themes to download

http://monitor.blvk.ch/eure/
All you ever wanted to know about displaying the Euro symbol in KDE

KDE at a glance

Windows users shouldn’t have too many problems
getting to know KDE, but there are lots of subtle
tricks tucked away behind the buttons:

Taskbar — all your running programs show R

Deskin

Iconify — send the window up to the Taskbar. sl | 18 Lo
It’s the same as ‘Minimise’ in Windows e |

up here. Clicking on one takes you to it, no i & colors
matter which desktop it's on 4 ¥ Faonts

Maximise — make the window fill the whole

screen. Try dicking with the middle and right
mouse buttons

Close - closes the window and terminates
the application

Pin — click to make this window appear in all
your virtual desktops

Window Options — choose ‘To desktop’ to
send the window to another virtual desktop

Clock applet — lets you know it's 3am when
you're still trying to figure out KDE

Terminal - enables you to launch a
terminal window quickly

Virtual Desktop selectors — click on one of 1 Find — use this to hunt down that

these to go to another virtual desktop elusive file

1 o Logoff — end your session 1

Hiad Pravious Table pf C jmie

KDE Frequently Asked Questions

- mm-ﬁuemwmwzo- tips
P 0§ noot | |
= [F my Home

= 8 20-tps
b @ images
GF Deshiop
g man
T} autesave

0 tute-fagy
@} nsman

0 obd-dasd
5 reanst-6.0
Deskdop

gGvvvvwww

KDE Control Centre — this is where you
can customise your environment

1 1 K menu - like the ‘Start’ menu in
Windows, here’s where you'll find all
your applications

1 Hide the panel — click here to get it out

1 Lock — locks the screen. Requires your 1 Home - launch the K File Manager in Ny
password to revive it. Great for keeping your home directory 1 9 Panel — home to useful shortcuts and
i i lets
avaythe prying. eyesiof cworkers 1 Windowlist ~ quickly go to any window 1y apute
1 KDE Help — all the manuals at your on any desktop. Handy if you want to 2 Menu — completely customisable. See
fingertips hide the taskbar ‘Adding Netscape to your panel’
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Don’t know your ISP from your KDE? Look no further...

Gobbledegeek

Big endian and little endian: the sequence in
which a processor stores bytes of data. In big-
endian architectures, the most significant bytes
are stored in the lowest memory address. In little-
endian-based architectures, the least significant
hytes are stored in the lowest memory address.
Most UNIXes and the Internet are hig endian-
based. Intel processors are little endian-based.

Bit mask: a pattern of binary values. See
‘netmask’

Daemon: (pronounced demon or damon). A
process that runs in the background and performs
a specified operation at predefined times or in
response to cerlain events. Typical dacmon
processes include e-mail handlers and print
queues. The term comes from Greek mythology,
which describes daemons as guardian spirits.

DNS: short for Domain Name System. The
Domain Name System provides mappings between
domain names and [P addresses. A domain name
server converts names to addresses and addresses
to names.

Ethernet: a networking hardware standard.
Ethernet is by far the most common network
hardwarc, It usually consists of cables, network
cards, and possibly a hub or switch.

Firewall: a firewall is a break point between
networks where all traffic is examined and
accepted or denied based on a set of rules. They
are used to grant some measure of security in a
network. By placing a firewall between a home
network and the Internet, you block connections
originating ffom the Internet to your home
machines while still allowing all your machines to
use the Internet.

FTP: File Transfer Point. A typical protocel used
on the Internet for downloadable files.

GNU: a complete free software system that is
upwardly compatible with UNIX. GNU stands for
‘GNU's Not UNIX

GUI: short for graphical user interface.

Header files: in C, header files define basic
functions such as printing to the screen and
writing data to disk. They save programmers work
by allowing them to use the headers rather than
writing each function hy hand.

IP Address: short for Internet Protocol Address.
A unique address assigned to each computer on a
TCP/IP network (such as “205.160.0.817).

IP Routing: Short for Internet Protocol Routing.
The process of receiving an IP packet addressed to
somewhere else on one network and sending it on
its way via another network.

ISP: short for Internet service provider. A facility
that sells Internet services to consumers/businesses.

KDE: a powerful graphical desktop environment.
KDE is an Internet project and truly open in every
sense. Development takes place on the Internet. No
single group, company or organisation controls the
KDE sources. All KDE sources are open to
everyone and may be distributed and modified by
anyone subject to the well-known GNU licences.

Kernel: the basic functions of any operating
system, like Unix or Linux.

LILO: LInux LOader. Program used to hoot Linux,
and used as a bool manager as well.

Module: a module includes software that can be
loaded and unloaded as needed while your
operating system is running. The module is loaded
when the kernel is asked to perform a task that
requires that module, Kernels that are compiled to
use modules are known as modular kernels.
Kernels that are compiled with all software built in
arc known as monolithic kernels.

Netmask: a 32-bit bit mask which shows how an
Internet address is to be divided into network,
subnet, and host parts. See ‘bit mask.

PAP: short for Password Authentication Protocal.
With a PAP login, a PPP session is started before
the username/password is transmitted. PAP is a
password authentication scheme supported by PPP.
Conversely a clear-text login would deal with
passwords (in clear-text;) before the PPP is started.

Ping: a program used to send an echo packet over
a nctwork. The Ping program is typically used to
determine if there is connectivity between two
machines on a network.

PPP: short for Point-to-Point Protocol, A popular
protocol used to transmit data packets between
two points.

pppd: short for Point-to-Point Protocol Daemon.
By far, the most popular UNIX implementation of
PPP. This program deals with connecting the PPP
protocol directly and has many slick little features
such as the ability to run scripts upon initiation or
completion of a PPP session. Not only can pppd
run as a client, but it can also run as a server, so
in theory you could be your own ISP!

RISC: Short for Reduced Instruction Set Computer.
A chip architecture that reduces chip complexity
by using simpler instructions. In short, RISC helps
make the CPU faster. Note: Intel processors aren't
RISC; they use an instruction set called CISC
(Complex Instruction Set Computer), which
inevitably slows them down. Operating systems
must be wrilten differently to run on these
different architectures.

Shell: another term for user interface. Operating
systems and applications occasionally provide an
alternative shell to make user interaction with
programs casier. A ‘command shell is the
command processor interface, the program that
executes operating system commands.

SMP: short for Symmetric Multiprocessing, a
computer that's equipped with more than one
CPU. SMP provides faster performance by making
multiple CPUs available to complete individual
tasks simultaneously.

SPARC: short for Scalable Performance
ARChitecture, a family of 32-bit RISC-based CPUs
developed by Sun Microsystems.

SSH: short for Secure Shell, a program developed
by SSH Communications Security that lets you log
into another computer over a network o execule
commands in a remote machine and to move files
from one machine to another, SSH includes strong
authentication and secure communications over
insecure channels.

Subnet Boundary: [P addresses can be grouped
into subnets of some size, usually evenly divisible
by 8. A subnet boundary is a limit between two
subnets. You could figure out where your subnet
boundary lies by looking at your netmask and
nf’lW(]Tk numbers.

UNIX: an operating system developed by ATE&T
Labs in 1969. Used mostly by government and
academic agencies, UNIX is one of the first, true
nelwork operating systems.

WINE: Literally stands for "Wine Is Not an
Emulator”, a program used to run some Win32
apps under X-Windows.

X Windows: A graphical user interface for UNIX
and UNIX-like systems.
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The real power of Linux
is accessed through
Bash, its command
line inferface. Vince

Veselosky shows you
how to use it

ou've finally got Linux installed and it's
booted into KDE. You've explored the
desktop and come across something
called Konsole (it's under the K menu in
the Utilities folder). This enables you to
type in Linux commands directly.

There are a few simple commands that you will
need to know if you want to survive the Linux
command line interface.

Linux is case sensitive. This fact cannot he
stressed enough. A file called ‘myfile.txt’ is not the
same as ‘MyFile.txt" or ‘MYFILE.TXT Linux sees all
these as distinct from one another, and you could
have all three in the same directory without conflicts.

The commands you type are also case-sensitive,
so watch out for that Caps-Lock key. The secand
thing to trip up new users is file permissions.

Since Linux is designed as a multi-user system,
the file system keeps track of what files belong to
what user.

If you are the owner of a file, you may designate
who is allowed to read and write that file by granting
permission. The Linux system and configuration files
are owned by the user ‘root’, the system
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Command Line
Survival Guide

How to take control of Bash

administrator. If you are logged on as root, you have

=1z

access to all these files. IT you are logged on as
another user, you cannol change these files. For this
reason, you should never log in as “root” except to
perform system administration lasks). Normal users
are prevented from doing stupid things like erasing
every file on your system (it only takes one
command). The root user has no limits.

Some other things to watch out for: il a command
succeeds, it will usually report nothing, and simply
return you to the prompt.

Command options on Linux arc preceded with a
dash - rather than a slash / as in DOS. This is
hecause Linux uses the slash [ as a directory
separator, where DOS uses the backslash \. Both
Linux and DOS have a PATH environment variable
that tells you where to search for programs when you
type their names at the prompt.

However, DOS always searches the current
directory first, and then the PATH. Linux does not
look in the current directory at all.

To run a program that is in the current directory,
precede it with the full path name, or with ./
(shorthand for “current directory’).



Getting help

Your Linux system has an online manual that you
will need (o consull from time (o time. You use the
command man fo access it. For example, il you want
to learn more about the Is command, type man ls.
This displays a help screen describing the program
and its usage.

Man pages, as they are known, are formatted on
the fly from special source files, and are displayed
using Lhe program less. less is a simple display
program similar to more, allowing you to view files
that are longer than a single terminal screen, but it
allows more liberty in scrolling.

You can scroll back and forth line by line with
the arrow keys or whole screens using the PgUp and
PgDn keys. When you're done reading, press Q to
quit (the escape key will not get you out of less) and
you'll get back to the command prompt.

Man pages are stored in a categorised database.
These are the standard categories (you can think of
them as sections of the manual):

(=

User commands

2. System calls

3. Subroutines

Devices

File formats

Games

7. Miscellaneous

8, System administration

Sometimes you will need to know this (o (ind the
man page you are looking for. For example, there is a
user command passwd that can be used to change
your login password. If you type man passwd you
will get the man page for this command, since it is in
section 1. However, there is also a file called
“passwd" that stores the password database on your
system. The format for this file is explained in a man
page in section 5, File Formats. To get to it, you need
to type man 5 passwd so the man command will
look in section 5 rather than starting at section 1.

Man pages are often very detailed and might tell
you far more than you wanted to know. If you just
want a quick idea of what a command does, use the
whatis command. For example, whatis grep returns:

grep, egrep, fgrep (1) - print lines
matching a pattern

This shows you that grep, and its related
commands egrep and fgrep, have man pages in
section 1, and are used to “print lines matching a
pattern”. If you were searching for a command to
copy files, you would know that this isn't it and you
could move on. Or you could consult the man page
for details on using these commands.

Related to the whatis command is apropos, which
searches the whatis database lor keywords. If you
know what you want to do bul don't know the
command, apropos will give you list of related
commands. For example, if you want to copy files,
try apropos copy and get:

copy byte strings
copy data to/from a class from/to a
Unix file

copysign (3) - copy sign of a number

cp (1) - copy files

cpio (1) — copy files to and [rom archives

dd (1) - convert a [ile while copying it

dvicopy (1) produce modified copy of DVI file

fcopy (n) - copy data from one channel to another
Your list will probahly he much longer than this,

but by reading through it you will find that the
command you want is cp for copying files.

If the apropos and whatis commands don’t work
on your system, it may mean thal the whatis
database has not been created or is corrupl. You can
rehuild it by running fusr/shin/makewhatis as the
system administrator (root). Note that the apropos
command will accept only one parameter. You cannot
search for multiple keywords. If you try, only the first
will be used. The whatis command will accept
multiple search words, but searches for them
individually rather than as a group (in other words,
combining them with OR rather than AND).

For broader documentation, check the
directory [usr/doc on your syslem.

Table 1: DOS to Linux translation

DOS/Windows = Linux equiv. = What it does

command

od od Change the current directory. Similar
syntax :

ds’ clear Clear the terminal screen '

copy cp -i Copy files. Similar syntax, Without the
-i, cp will not prompt for destructive
actions like file replacement

delerase rm -i Delete files. Without the -i, rm will
not ask for confirmation

deltree rm -R Delete a directory and all its contents,
including subdirectories |

dir Is List the files in the current directory, |
or a named directory

md mkdir Create a new subdirectory. Similar |
syntax

mem free -t Display a summary of current
memory usage and availability

more moreless Display the contents of a file one
page/screen at a time. The less utility
makes scrolling back and forth easier

move my Move a file. Similar syntax .

rd rmdir Delete an empty subdirectory. Similar |
syntax

ren my Rename a file or folder

type cat Display the contents of a file

ver uname -sr Display the name and version of the

0S kernel
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With Linux now
happily on board,
you need to know
how to install and

run applications.
This is a little tricky,
but luckily

Vince Veselosky is
here to help

ven though most Linux distributions

contain hundreds or even thousands of

programs, you will eventually find that

there is some program you want that is not

included. Installing new software is not
quite as straightforward as slipping in a disc and
clicking “Next" several times, but it is not a difficult
skill to master, either. Here are the basics.

First, installing software is normally a task for the
root user. It requires write access to areas of your
system that normal users should not touch. For this
reason, you will normally need to become Super-User
to install new software,

You can do this by logging on as the user root or
by using the su command. Then download the
software you are looking for, or copy it from the CD
you are using, into the root directory.

Most software for Linux will be wrapped in some
kind of “package” which needs to be unpacked and
installed on your system. There are several different
package formats to choose from (Linux is all about
choice). For Red Hat Linux, the preferred package
format is RPM, the Red Hat Package Manager. The
RPM format is also used by other Linux distributions
such as Caldera OpenLinux, TurboLinux, and SuSE

Premiere issue

Applications for
~all occasions

How to install new software with RPM...

Linux. The command line utility RPM can be used to
install these packages.

RPM in action

Let's say you have downloaded a new game called
Widgeteer in RPM [ormat. It comes in a file called
widgeteer-1.0-1.i386.rpm. The name of an RPM file
can tell you a great deal. Here we can see that the
package contains Widgeteer version 1.0. The -1
indicates a version of the RPM package, rather than
the program contained therein. The i386 means this
is a binary package that has been compiled for the
Intel 386 architecture.

To install Widgeteer from the command line or
from a shell window in KDE, type the following:

rpm -ivh widgeteer-1.0-1.i386.rpm
The command options used are:
i - tells RPM to install the package
v — use verbose mode, so that RPM will tell you

what it is doing
h —.print hash marks as a progress indicator



Like most Linux commands, RPM is quiet by
default. Verbose mode helps Lo give some feedback,
s0 that you know whether the operation succeeded. If
this output still seems sparse to you, you can try
adding a second v to the command options. This will
cause the command to be doubly verbose, and it will
tell you more than you ever wanted to know, The
hash marks make a convenient progress indicator on
slower systems, but it is perfectly all right not to use
this option.

The RPM utility can also be used to upgrade an
existing package. Say, for example, that you got the
new Widgeteer 1.1 package to fix some bugs.
Upgrade with this command:

rem -Uvh widgeteer-1.1-1.i386.rpm

The U option tells RPM to “Upgrade” the package.
Trying to use “Install” mode would fail, because the
package is already installed. Install mode will not
overwrite an existing package (unless forced to do
s50). Upgrade mode checks the version of the existing
package, and if it is older than the one being
installed, the older package is removed and the new
one installed. If the package is not already installed,
Upgrade mode will install it as if using Install mode.

Suppose you play with Widgeteer for a while and
decide that it just isn't for you. The RPM utility can
remove it for you with this command:

rem -ev widgeteer

The e option to RPM puts it in “Erase” mode for
removing software, Note that when removing a
package, you only need to give the name of the
package, not the name of the RPM file it was
installed from.

The RPM utility has many other uses as well. For
example, you can see a list of all the packages
installed on your system with the command:

rem -ga

Read the man (manual) page for RPM (o learn
more, or visit www.rpm.org. There are also some
graphical tools available that act as a front-end to
RPM. In particular, look out for “Gnorpm” for the
GNOME desktop and “kpackage” for KDE.

Getting to grips with tar
The name “tar” is short for Tape Archive. This is the
least common denominator in packaging. All Linux
distributions can read a tar file, as can any version of
UNIX or its kin. A tar file is just a bunch of files
appended end to end into one big file to make
transfer and archiving to tape easier. Usually the
output is filtered through the GNU Zip program gzip
to reduce its size, since there is no compression built
into the tar format.

To unpack the tar archive “software.tar”, use the
following command:

tar xvf software.tar

If the archive has been gzipped, it will have a .gz
extension appended to it. You will need to unzip it
with gunzip before running tar, or you can let tar do
the work by adding the z option:

tar zxvf software.tar.gz

Once the archive is unpacked, look for a file
called README or INSTALL. This will tell you what
needs to be done next. Sometimes you can simply
run the program from the place where you unpacked
it. More often, though, there will be a shell script or
program to run that installs the files where they
belong on your system.

Occasionally you will find that a binary package
is not available for your particular system. The
archive that you download will then contain source
code for the program you want. You will need to
compile the source code to generate the program files
needed to run the software.

Almost all source code archives you will find for
Linux use the GNU Autoconf tools lo make compiling
the software on new systems much easier. Always
check the README file first, but most packages can
be compiled and installed using the following three
simple commands:

J/configure

The “configure” script does a check of your system
for libraries and such like, and generates a ‘make’ file
based on what it finds.

make

The program ‘make’ is used by programmers-to
automate compiling source code into binaries. The
instructions for make are stored in a makefile.

make install

After make has heen used to compile the source code
into binary program files, it is called again, this time
with a new parameter, to install those files where
they belong on your system. Again, the instructions
for make are stored in the make file, this time in a
special section called ‘install’

For most software packages, that is all it takes.
You should now be able to run your new program!
Good luck - why not try a few of the
programs on our Cover CD?

To install and
uninstall from
GNOME, use
Gnorpm
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WORKING WITH LINUX

“Nurse! Scalpel!
I’m going in!”

How to install and compile a new kernel

New Linux kernels appear all the
fime, so when it’s time for @
change, you need to know how
to install it. Rob Fenwick dons
his surgeon’s gear and scrubs
up for a heart transplant...

he name ‘Linux’ really only refers to the

kernel, the heart of the operating system,

and it's one of the most frequently updated

components in Linux. But fear not, you

don’t have to be a top heart surgeon to
upgrade your kermel. You do have (o keep your wits
about you while you're performing surgery as this is
not an operation to be attempted lightly.

Before we dive into the technicalities of how to
install a new kernel, ask yourself the following
question: “Do | have a legitimate reason to upgrade
the heart of the 0S?” One is the appearance of a new
kernel update - however if you're just mucking
around, there's a chance you could do some real
damage to your system; at worst, you could end up
with an unbootable Linux partition.

While we'll do everything possible in this tutorial
to ensure that this doesn't happen, there are so many
hardware configurations out there that it's possible
beginners could damage their Linux installation, so
be warned.

For the purposes of this article, we are assuming
that you are running a PC with an Intel/AMD/Cyrix/ -
Rise/Winchip 386 or above processor and that you
want to install kernel 2.2.10 (the most recent stable
kernel available at the time of writing). These
instructions are valid for any kernel in the 2.x.x
series — the only thing that differs is the filename of
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the kernel ‘archive’ itself. The final thing that we
assume is thal you are booting your system using
LILO (LInux LOader). This tutorial gives instructions
on how to install a new kernel on both SuSE and Red
Hat Linux systems.

The kernel is available for download at
fip://fip.UK kernel.org:/pub/linux/kernel/v2.2/.
Download the file named linux-2.2.10.tar.gz and
store it somewhere on your Linux partition, in the
[root directory. (For more information on partitions,
see our feature ‘Start here!" on page 16.)

Under the knife

We're going (o move our new kernel to a folder
called /newkernel. Naturally, to do this, we need to
create the directory, newkernel.

Login to Linux as the root user and use the
system console or load a command prompt in X -
whichever method you prefer. You need to be at a
command prompt.

Enter the following commands:

cd /
mkdir newkernel

If you are on a Windows system, you would just
have created a directory called C:\newkernel — under
Linux it's called /newkernel.

Now change directory to wherever your kernel
ZIP file is. As our new kernel ZIP file is stored in
[root, we'd type:

cd /root

And here’s our new kernel ZIP file - linux-
2.2.10.tar.gz is the file we're after here.
Move the file to /newkernel like so:

myv linux-2.2.10.tar.gz /newkernel

Note at this stage that the filename changes with
each release of the kernel. If you are not installing
kernel 2.2.10, you should substitute the filenames
given here for those appropriate to your version of
the kernel.

Now change directory to the /newkernel directory:

cd /newkernel
Next, type the following command:
gunzip < linux-2.2.10.tar.gz | tar xfv -

This unzips our compressed ZIP file kernel - it
can take some time.

Attach the arteries

The command that you've just entered will create a
folder called fnewkernel/linux, from which various
other directories siem.

When your file is unzipped, and you are returned
to a command prompt, type:

cd /linux
followed by one of these:

1. If you are running in X, Linux’s graphical
environment (similar to Windows), type:

make xconfig

2. If you are running in console mode, Linux's text
console environment (similar to DOS), type:

make menuconfig

If either, or both, of these fall over and return you
to a command prompt, then you have a problem
compiling on your computer.

Probably the casiest way to remedy this is to re-
run the Linux setup and select everything in sight to
do with development/programming. Or, if you know
more specifically which files are missing, try
downloading them from the Internet and installing
them with an application such as glint or YaST (these
come with Red Hat and SuSE respectively).

Decision time

So, assuming the ahove has worked successfully, you
should now be looking at a screen thal presents you
with a series of options. You need to choose which
options are correct for your PC and the hardware you
have. So what you have to do is go through each
category and decide what your new kernel should
supporl, what it should support in a modular fashion,
and what it should not support.

For example, your system may not require
support for SCSI devices, or if you want to run
‘sndeonfig’ under Red Hat o configure your sound
card, you need to enable modular support for your
sound system - (rial and error is the name of the
game here.

In Xconfig or Menuconfig:

Y supports a device

M supports it in a modular fashion

N means there will be no support for that device in
your new kernel.

If in doubt, select "N’ and return to it later if it all
falls over. If you select everything in sight, your new
kernel will probably be too big for LILO to hoot, and
an unbootable kernel is not exactly useful.

Once you've finished choosing which parts of
your new kernel you want to be included in the final
build, exit the configuration tool.

You must now do one of the following (Option A
or Option B}:

OPTION A
Enter the following commands in sequence:

make dep
to make dependencies

-
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Installing a new Linux kernel

make clean
to clean up

make modules
to make all the kernel modules

make install
fo install the new kernel files

make modules install
to make each of the modules install

make bzlmage
to make the kernel image file itself

Each step takes a while.

OPTION B

Type:

make dep;make clean;make modules:make
install;make modules_install;make bzimage

This is all one long command. This will do exactly
the same as option A, taking the same length of time
(it automates the process slightly). Both options, in
fact, take some time. (On a 200MHz system it takes
30 minutes.)

After-care service

The final step is to move your new kernel to the
[boot folder under Red Hat, or the top level folder
under SuSE, and configure LILO (v recognise il. Type:

cd /newkernel/linux/arch/i386/boot

Your new kernel is in this folder, called bzlmage.
For Red Hat, type:

myv bzlmage /boot
or, for SuSE users, type:
myv bzilmage /

What you do next also depends on your
distribution. Under SuSE, load YaST and select
‘System Administration’ Proceed to boot options and
select LILO configuration. Add a new LILO image, and
specify that the kernel image can be found at
[bzlmage - call this new boot confliguration
linux210. Save and exit YaST.

Under Red Hat, open a command prompt window
and type:

linuxconf&

Next, under boot mode, select a new kernel and

Premiére issue

You have already a working LILO
and you wani lo upgrade your kemnal
Kemel image file [mnnvhrlmagc
How it boots « New defaull boolable setup [
« replace the curreni bootable selup ||
~ gelectable setup
Label line<210
Where lo copy the kemel filej/buol
Cptions |
rool partifion |rdevmuaz ]
|| Ramdisk size (oph |
l boot mode I~ Read only
VGA mode normal 7
Bool options
Initial ramdisk{opt)
Password (opl)
_| Resfricted access
[ = . =
Accept Cancel | Help |

complete the form as in the screenshot above. (Note:
{dev/hda2 may be different on your system, so just
put in whichever partition is relevant. We use
/dev/hda2 because Linux is located in the second
partition on our hard disk. If yours is on the third,
say, you'd type [dev/hda3, or on a SCSI system
[dev/sda3).

Now click Accept, then when asked if you wish
to update LILO, select Yes followed by Quit.

If Linuxconf asks you to activate the changes, do
s0, then quit.

You are now almost ready (o start using your
new kernel. Simply proceed to a command line and
type the following:

reboot

When LILO loads at startup, type linux210
followed by [Return]. If all is well, your new kernel
will boot.

Success or failure?

If your new configuration seems to have gone belly
up, you can most likely return to your original kernel
by typing linux at the LILO prompt, and repairing
your broken 2.2.10 kernel by starting this tutorial
again from the top.

However, if your system boots without any
difficulties, congratulations doctor, your heart
surgery patient has made it through a very tricky
operation! Run the system for a while, and when
you're certain everything is as it should he, return to
YaST or linuxconf, and make linux210 the
default boot image to.conclude the setup. LINUX

@ You can find Rob Fenwick enline at
http://nbsrfen.hypermart.net

Once you've filled in the
form, simply click
Accept to proceed and
your new kernel is
nearly ready to roll...
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Lmux engine

How to have a faster, quicker Linux

Everyone wants the best performunce
possible from Linux. Mike Saunders shows
you how to fine-tune it to perfection

nlike the various other flavours of TINIX
and recent versions of Microsoft
Windows, Linux’s system requirements
are modest. You can squeeze the
operating system into an old 386 box
with just 4Mb of memory.

However, most modern distributions are not sei
up to give maximum performance; instead they are
designed to provide support for a wide range of
hardware and fit the average user’s requirements. As
such, many Linux systems are not achieving their full
potential, and valuable resources like memory are
being eaten by programs that never get used.

We'll take a look at some of the things you can
do to give your Linux box a performance boost.
Memory is also very important to the performance of
Linux, so we'll concentrate on tips {o free up more

Premiere issue
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RAM. We'll also look at a few ideas for increasing
speed in the X Window System.

Sort out your RAM

Before you start tinkering, it's best to check that
Linux is working well with your RAM. Kernel
versions 2.0.36 and before could have problems
identifying the amount of memory in your machine.
This appears to have been resolved with the recent
2.2.x kernels, but if you're running an older version,
or are still having memory difficulties, then you need
to pass an extra parameter to the kernel (using your
hoot loader, eg LILO aor LOADLIN).

Check your startup messages — or view them
when booted using the ‘dmesg’ command - and you
will see a line showing the amount of memaory



How to figure out memory usage

You can find out the current state of your system’s memory using the ‘free’
command. Here’s the output on our Linux box:

=] Toxt oditor = %
Ells  Edit  Oplions Help
HO0FE Mk S 2

total used free shared buffers cached 'h
Mem: 30584 27000 3584 10704 276 13076
-+ buffers/cache: 13648 16936
Bwap: 12256 Josz Loaong
_____ BT s M5 [Uine: 7 Cal 3

At first this can seem alarming — we’re only running a text editor on our
32Mb machine, yet there’s just 3.5Mb left! However, it isn't as bad as it
seems. ‘Buffers’ refers to the amount of memory that’s being used as a
temporary store for disk-write operations, so it won't take any available

space away from applications. Similarly, the ‘cached’ column shows the
memory held by Linux’s performance-boosting features such as read-ahead
(reading data off the disk which may be needed next). So this can be added
to your remaining available memory, too — see the results in the +/-
buffers/cache row. The 16.9Mb it shows is a more reassuring figure.

You may also have noticed that the ‘total’ memory it displays is
30,584K, when 32Mb is actually 327,68K. The missing memory is being
used by the kernel itself and some extra space it requires. To see the details
in another form, use the command line options -b (bytes) or -m
(megabytes). Adding -s n, where m is a number, will keep updating and
displaying the memory information every n seconds.

recognised. If this is lower than it should be, add the
‘mem’ parameter when booting. For example, in LILO
you would enter:

linux mem=64M

to tell the kernel that all 64Mb should be used.
Replace the ‘64" with the amount of RAM you have.
Sometimes systems run slower because extra
memory isn’t being cached properly. This is usually
due to the type of matherboard or BIOS. This is rare,
but if you do have problems, see if you can cache the
extra memory in the system’s BIOS setup program.

Set your swap space

Swap space can have a significant effect on the
overall performance of your system, particularly
when running many applications. The general
consensus is that your swap space should be 2.5
times the amount of RAM in your Linux box. So, a
32Mb machine should have 80Mb of swap space, 1T
your swap space is over 128Mb, you need to make
two separate partitions and split it up.

Partitioning is still the fastest way of using swap
space. Linux will swap to a file in the same way as
Windows, but it's less efficient than a partition and
you may notice a drop in speed. Writing to a swap
file involves far more work and time than a dedicated
partition, which is separate from the main filesystem.

Remove unused consoles

Removing unused virtual consoles is an excellent way
to free up more memory and speed up your system,

The major Linux distributions such as Red Hat and
SuSE provide six consoles as default. If you do most
of your work in the X Window Sy'slcm, then text-
mode consoles just use up more memory. See ‘How (o
disable virtual consoles’ on page 83 for more details.
We removed three consoles, and kept three. This
reclaimed about 1.5Mb of memory. Don't go
averboard, though - X needs one free virtual console
to run on, It's also best to have another one available
in case of an emergency — such as killing X if your
window manager freezes. If you ever need to create
maore consoles, just reverse the procedure in the
boxout. The pattern of the lines is pretty clear.

Get rid of unwanted daemons

Another good way to gain more free memory is to
cut down on the number of background processes
running. The ‘top’ command shows a constantly-
updating list of the processes and their memory
usage. Most of these are in the form of daemons -
small programs that stay in memory and perform
tasks depending on certain conditions.

Most Linux packages have a lot of these set up by
defaull, but many of them may not be used. ‘Top’
shows the amount of physical memory they're using
(look under the 'RSS’ column), so you can pick out
the ones that may be slowing things down. To decide
whether they are started or not, use Red Hat's
linuxconf" utility (‘setup’ in 5.x versions) or SuSE’s
YaST tool (under ‘Change configuration file’). Here
are some OF t}]ﬁ' MOore Cominorn ones:

Under Red Hat 6,

n[—ll I;nrs x aunts Fiter cantrol Linuxconf lets
orma z
User accounts The list of users is long, s you you choose which

Graup detiniions may want 1o fiter It 3 b by providing services are
Change rool password A prefix to search. An emply prefix means to show ried
B-Special accounis aﬂpuserg bk sta in Rch
PFP accounis : runlevel
(—SLIP accounts via normal Ig Login Prefix
—LIICP accounts Full rrame prafied
POP accounts (mall only) g
b Virual POP accounts (mall uID From o
- Email aliasas uiD To 85535
uter alases | graup =T

wvirtual domain user allases

Policies

(—Password & account polick

(—Availahle user shells
Avallable PPP shells

+— Avallable SLIP sheils

—Message of e day

[3=Fiia tyetems

local drive

Ace ap_q Eancelf A Hlg|

]

sendmail - this memory-hungry daemon is
responsible for routing email. If you deal with your
messages by dialling up and using Web-based clients
such as Yahoo! Mail, you can safely disable this.

cron - as discussed above, this starts jobs at specific
times. With some packages, eg SuSE, it's best o leave
this running as it starts a clean-up and configuration
script every day. Of course, you can choose not to
run it and execute the daily script by hand.

Ipd - the printer daemon. If you never print from
your Linux box, then you can stop this.

i
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nfsd - this is often started by default on many
distributions. It's the Network Filesystem Daemon, so
unless you need to mount and work with NFS
filesystems, you can safely turn this off.

inetd - inetd is used in servers or systems that can be
contacted using programs like Telnet. If you don’t
need to access any ol your computer's services
remotely, then you can disable this.

You may find other daemons running on your
system. Press F1 in Red Hal setup or F2 in YaST to
find out mare information on a service and whether
it’s safe to remove it. Be careful, though: daemons
beginning with 'k’ are usually important kernel
services, so it's best to leave these running. They
include ‘kswapd’, ‘kerneld’ (in 2.0.x kernels) and
‘klogd: ‘syslogd’ should also be left activated, as it
provides critical system logs.

Build your own kernel

Perhaps the best way to give your machine a speed
boaost is to build a new kernel. Il you're a competent
Linux user and you're still running the kernel
supplied with your distribution, we recommend that
you install the kernel source code and compile your
own (see page 66). Recent kernels are supplied with
simple graphical setup programs to make tweaking
and tuning very casy indeed.

By building a new kernel you can cut out a lot of
the device drivers, protocols and other bloats that are
built into the packaged ones. This not only makes the
kernel smaller and saves memory, but it also boots
and runs faster, needing less CPU cycles.

Choosing to compile many drivers and functions
as modules seems like a good idea initially, as the
kernel will be smaller and take up less memory.
However, the downside is that modules take longer to
load than built-in kernel functions. The loading delay
is small and won’l be immediately obvious, but if
you've chosen modules for a lot of drivers and use
them frequently, you may find them sluggish.

The best compromise is to compile drivers you
commaonly use directly into the kernel and leave the
others as modules. For example, we only dial up our

Tune-up information on the Web

There's plenty of information on the Web for fine-tuning your Linux box.
Take a look at these sites:

www.linux.com/tuneup/
Linux.com features reader suggestions for many categories including
networking and X, and these are mainly specific to individual applications.

tunelinux.com
This dedicated site is also arranged into sections and has useful links to
newsgroups and other pages.
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Tune up your Linux engine

ISP once or twice a day, so we've compiled PPP
support as a module.

Be ruthless

Many distributions include RAM disk support as
standard with their out-of-the-box kernels. Luckily,
the RAM disk doesn’t allocate a chunk of memory
and wail for it to be used - it grows dynamically as
more space is required - but it still adds weight on
the kernel. It's unlikely you'll need support for this,
as it's mainly used for loading installation/rescue
disks when the hard drive can’t be accessed.

Being ruthless and chopping unwanted leatures
out of your kernel can make a noticeable difference
to your boot time and overall system performance.
Go through every item in the ‘menuconfig’ or
‘xconfig’ programs and decide if you'll ever need it.

[38] make xconfig

provides a simple
graphical

| interface for

tweaking kernel

configuration

The online help with these configuration tools gives
typical situations where a feature would be needed,
which helps you to get a good idea on its suitahility
for your machine.

Boost performance

The X Window System uses up a considerable
amount of system resources, and it too can be tuned
to give better performance. Before doing anything,
though, check that your X setup isn't providing more
than you need. If you've got a 32- ar 24-hit colour
X server setup, but you don’t do any detailed
graphics work, you can frec up a lot of memory by
opting for a lower colour depth.

You can also save memory by setting the virtual
screen size to be the same as the viewport. Take a
look at the fete/XF86Config file. If you spot a
‘Virtual® entry in the ‘Display’ subsection of the
‘Screen’ entry, your X display will show a small part
of a larger area.

This means that X has to keep track of graphics
oulput that isn’t even on the visible screen and, in so
doing, uses up extra memory, Utilising your window
manager’s virtual desktop/workspace functions is a



much more resourceful way of gelting some valuable
extra screen space. The [etc/XF86Config file also
holds the hardware configuration, including monitor
refresh rates and video card memory. Graphics
hardware varies too much so we can't be specific
here, but if you've got an esoteric graphics card or
monitor and the standard setup tools (like XF86Setup
or SuSE's SaX) can't set it up properly, then editing
this file may get your X server performing to its best.

Give Linux a kick-start

How to disable
virtual consoles

It may seem like an unusual idea, but disabling virtual consoles can give you
a small performance boost, especially if you are running Linux on older
hardware. Follow our three-step guide:

Find alternative software
Of course, the software you use will be responsible
for depleting your system resources. Changing some
of your common Lools for lighter replacements is
initially a simple idea, but the trouble usually lies in
finding suitable alternatives.

A change of window manager is definitely a

el e |

Buffers Files Toolz Edit Search hule Help

# getty-programs for the normal runlevels
m {idy:{runlevels? :{action? :{proc

# The "id" fleld MUET be the cam
® charactere of the doviee (after

b |
|
A
.4
o
&
7
0
|
b |

1123 :recpaunsebin/mingetty --noclear ttyl

] SPo tey2
il ttu3 7 AL
respasn Ttys good start. The variation in memory usage between

T
1123 :reepawn:/sbin/mingetty ttycll

different WMs can be drastic — especially when
taking into account the recent desktop environments
like GNOME and KDEL. They're hoth very powerful
and feature-packed, but most of us don't need all the
features they offer (and the memory they usel).

If you like the Windows 9x style, IceWMne is one
of the best alternatives. It's small, fast and themeable
and includes Win9b, 05/2 and FVWM styles. For a
truly different desktop, try Window Maker, which is
also fast and has a small memory footprint.

"
"
# Hote: Do not use tty? in runlevel 3, this vietual line |
Wi
"

is occupied by the programm xdm,

lines that launch ‘getty’ terminal programs, eg

1 Load /etc/inittab into any text editor and look for
2:123:respawn:/shin/mingetty tiy2 |

ol s
Bufferz Filox Toole Edit Search Mule Help

getty-programs for the normal runlevels
{1dri<runlovelo? i<actlon? r{process?

Try lceWM for a
fast and small

The "ia” field MUST be the same as the last
characters of the device (after "tty”).

¥
3

|

|

|
1123 1roapawn t/sbin/mingetty —noclear ttyl |
i

E o F il alternative to the
2:123 :respawn:/sbin/mingetty tty2 dar - 2 memory—hungry
3:123:respawn:/sbin/mingetty toy: S

desktop

environments like
GNOME and KDE

Hot Do not use tty7 in runlevel 3, this virtwal line
is occupied by the programm xcm. |

EsE==

# This is for the package xemsc, after installing and |
#and tion you should chara

Starting from the bottom, remove a line for éach
console you want to disable. The number straight after
tty identifies the console

] e A [ e S (Wi e | |

Tovrusiinid

LK, buff
cachod

Tune your window manager to cat up less
memory. The canfiguration files for many window
managers have options to turn off icons, cut down
on the number of colours used and so lorth.
Disabling dithering and using a plain or tiled
background is much more resource friendly than a
[ull-screen image.

For other software alternatives, Lynx is a good
text-based Web browser that needs far less memory
than Netscape. It also runs considerably faster, partly
due to it never having to load images. Arena is X-
based, but is still quite small and flast (and has very
powerful HTML checking).

Emacs is usually installed by default on most
machines and while its power and features are
superh, for many simple editing chores it can be
cumbersome (particularly on older hardware). Some

replacements could be Joe, Jed or Pico LINUX
the last based on Pine's message composer.

3 Save and reboot. Now try switching to the disabled

console — there should be no legin: prompt. The
process list here shows our three remaining
mingettys running
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Dave Coulson is one of
the UK's top Linux
problem-solvers. Catch
him online on the
pcplus.linux newsgroup

Vrooming up Linux...

5 ways to make your Linux
installation that little bit faster

Use an optimised compiler

Installing a compiler, such as egcs, which
has been enhanced for your CPU, will produce a
small increase in speed.

Don't run services you don't use

Most distributions install servers such as
Apache and sendmail. If you don’t need these,
remove them with the package manager.

Use more minimal programs
If you're short of memory, run a more

Got a problem? Linux guru Dave
> Coulson is your man with the answers

Networking made easy

How to set up a simple peer-to-
peer network
I have two dual-boot Windows/Linux
boxes which are on a network when in
Windows. I'd like to be able to share files
between the two when hooted into Linux.

First, check your IPs are correct. If you want

to access the Internet with your network up,
you'll need to ensure that the IPs you use are from
one of the three classes of internal IPs.

192.168.0.0 - 192.168.255.255
172.16.0.0 — 172.31.255.255
10.0.0.0 - 10.255.255.255

minimal window manager to stop your box using
swap space. |

|
Use mtrr (PPro/PII/PIIl only) ‘
Enabling mtrr for your video card can
result in a 20% speed increase in X Windows. I
Build your own kernel
Not only can you include extra options which
will speed up specific system parts, but you can
also build the kernel with an optimised compiler.
& You'll find more speed tips on pages 70-73.
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Usually, 10.0.0.x netmask 255.255.255.0 is used,
so you can call your two boxes 10.0.0.1 and
10.0.0.2 and you’'ll know you won’t have to
reassign them later.

You'll need to know the exact model name of
your network card so you can compile drivers for
it. If you're not sure, compile a few as modules and
see which one works. Booting into Windows will
help you identify the IRQ and 1/0 base used by
your card.

Reconfigure the kernel (see page 66),
preferably with modular ethernet support, build
and install the modules. Then run ‘depmod -a’ to
create the dependencies for the new modules. You
will then be able to ‘modprobe’ the module for
your card (the linux/Documentation directory will
have documentation about the exact options
needed for your card).

Once it's initialised correctly, you need to
assign an IP to it. You can either use the same IP
as you did in Windows or you can pick another one
specifically for Linux.

ifconfig eth0 10.0,0.1 netmask
255.255.255.0 up

This will auto set up a route for the subnet, so
you can now ping that IP. If the other box is set up
correctly, also try to ping that system. If it doesn't
work, you may have to change jumpers on the card
or use a different module.

For file sharing you have two options. You can
either install SSH (Secure SHell) on to both
systems and copy files between the two or you can
use NFS (Network File System) on both systems
and mount remote directories. You'll need to install
portmap as well as the nfsd and the nfs client
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Linux at work

Building an Apache intranet

How to compile Apache modules

After looking at various sites, it seems that Php
Q and Apache would be the best option for my
intranet server. My problem is: how do | compile
Php as a shared module for Apache so that | can
upgrade it more easily?

If you've already got Apache installed,

remove It either with RPM or by deleting the
directory that holds the Apache binaries (usually
/usr/local/apache).

If you want to add Php to a current copy of
Apache, you can skip to step 3, but check you
have the latest version of Apache installed and
that it has mod_so compiled into it.

To check for mod_se, run ./hitpd -1 from the
binary directory of Apache. If it lists mod_so.c,
then you don’t need to recompile it.

Step 1. Configuring Apache

Download the latest version of Apache (1.3.9 at
the time of writing) from www.apache.org and
untar it:

tar xvzf apache 1.3.9.tar.gz
cd apache_1.3.9

If you want to have SSL (Secure Socket
Layer) or any other non-DSO (dynamic shared
object) extension, now is the time to run its
configure script. Before configuring Apache,
check www.apache.org/ for any extra options
you may want to add. However, the minimum
options should be:

./configure —enable-module=so

This will enable the Apache module, which
allows the loading of DSOs at runtime.

Step 2. Building Apache
A simple

make && make install
as root will install Apache. You can then run it by:
/usr/local/apache/bin/apachectl start

and trying to connect to hitp://127.0.0.1/ with
Netscape or Lynx. Continue if all is well; other-
wise check any error output to see why it's died.

Step 3. Configuring Php3

Download the latest version of Php3 from www
.php.net (3.0.12 at the time of writing) and then
untar it:

tar xvzf php-3.0.12.tar.gz
cd php-3.0.12 tar.gz
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Now we need to find the location of the ‘apxs’
binary. If you compiled It, it is usually located in
/usr/local/apache/bin/apxs, but it could also
be in /usr/apache/sbin/apxs. A quick locate
apxs | grep apache should find it for you.

The exact configure options for Php depend
on the database you use (if you're using one) and
any libraries you want Php to use. The minimum
should be:

./configure —with-apxs=/usr/local/apache/
bin/apxs --without-gd \

—enable-sysvsem --enable-sysvshm - enable-
track-vars \

—enable-memory-limit --enable-safe-mode

Step 4. Building Php
A quick:

make && make install

will build Php and copy the .so to
/usr/lecal/apache/libexec (or wherever
Apache was installed). It should also add a

LoadModule php3 module
libexec/libphp3.s0

line to httpd.conf.

Step 5. Adding extra options for Php
to httpd.conf

First, we need to tell Apache which file types to
parse out for Php content. In your htipd.conf (or
whichever configuration file has the MIME type
configurations) add:

AddType application/x-hitpd-php3 .php
AddType application/x-httpd-php3-source
.phps

Obviously, you may want to use .php3 or
.phtml, so either alter or add to the list.

Run /usr/local/apache/bin/apachect]
start and Apache will start up with php support.

Step 6. Testing Php

A quick .php file in /usr/local/apache/htdocs/
should be enough to test Php, but if you've got
support for databases or image libraries, you
may want to check each of them.

<?php print “This is in php”; ?>

If it prints the string, all is well. If not, View
Source for the page and see If it parsed out the
<?php ?> tags, as your extension may not match
the httpd.conf configuration.

Good luck!
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packages. For example, if you want to mount
/home/users/mp3 from the 10.0.0.1 box on the
10.0.0.2 box, you would put the following line in
/etc/exports on the .1 system:

10.0.0.2/home/user/mp3(ro)

then restart the nfsd (by running the
/etc/rc.d/init.d/nfs restart script or killall -HUP
rpc.nfsd). We have set it to be read-only, but it
could have been mounted read/write (man five
exports for more options). Then, on the other
system, do:

mount 10.0.0.1:/home/user/mp3 /mnt/mp3s

and then you can use that directory as if it were
local to the system.

Mail handling

How to get unlimited e-mail addresses
with Freeserve and fetchmail
I use fetchmail to fetch my mail from
Freeserve's POP3 server, which works fine.
However, | want to make use of the unlimited
e-mail addresses provided.
I'd like it to work like this:

@ Addresses are in the form
<localname=@<uscernames.freeserve.co.uk
@® 1 want to pick up all messages for
<username> - this happens okay

@ | want to split to separate recipients on
<localname>

@ T want local aliasing to be invoked when
delivering to <localname>

@ I want undeliverable <localnames=> to go
to root

As you can fetch all the mail from that
account, your copy of sendmail must have
been configured properly, so collecting the mail
must be a fetchmail issue.
At the moment, you'll be using a line in your
~/ fetchmailrc similar to:

poll pop3.freeserve.net protocol pop3
username <username>.freeserve.co.uk
password <password> to <localuser>

which will deliver all mail from that single account
to the user <localuser>. Change it to:

S04 QUICKIES

Separating commands with && will
stop execution if one of the

' commands fails

set postmaster “root”
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p. poll pop3.freeserve.net nodns with proto

pop3 localdomains
<username>.freeserve.co.uk user
<username>.freeserve.co.uk there with
password <password> is * here

The set postmaster line sets the default user for

mail, if the username doesn’t exist locally, although

you'll probably want to alias root to your personal
account, so you don’t have to be root to read the
mail it gets.

The poll line is very similar to the original, but
we've set a local domain for the users.

This makes fetchmail deliver the mail to those
users as if they were local to the server.

The ‘nodns’ addition stops it looking up
hostnames for mail which is not for that specific
domain name. '

System administration
How to get root access when you forget
your password

I've just installed Linux, but I can't
Q remember what I put in for the root
password, Is there a way to reset this password
because | don't want to go through the process
of reinstalling the whole thing again.

You can get root access by typing the
following at the LILO prompt:

linux 1
and once the system has booted up, you'll be

presented with a root prompt from where you can
run ‘passwd’ and change it or edit the /etc/passwd

How to configure sound cards

Sound in Red Hat 6.0

| am using a SoundBlaster 16 (the one wilh the Wave port on it). | used to have it in the kernel but | was
wondering if the support is in a module in the default install of RH6.0?

With a standard SB16 card, you need to compile ‘Sound Blaster’ support as a kernel module, which
will give you an sb.o module (if you don’t reboot, remember to run depmeod -a). You may also
want to build the opl3.0 module for synth music. To initialise the module, simply:

modprobe sb io=0x220 irg=9 dma=0 dma16=6 mpu_io=0x300

insmod opl3 io=0x388

Obviously, you'll have to enter the correct values for your card. To check that everything’s worked
out properly, do cat /dev/sndstat. A good place to turn for sound information is /usr/src/linux/

Documentation/sound

Rather than quoting files with spaces
or apostrophes, use \ to escape the

( Space

file with a text editor and remove the password for
the root user (you probably won’t be able to run
X in runlevel 1 as the only partition that is
mounted is /).

Obviously, you don’t want people doing this
sort of thing, so adding the following lines to your
/etc/lilo.conf will prevent this:

restricted
password=somepassword

Just remember to rerun /shin/lilo after altering
this file. This will make LILO ask for a password
when you iry to pass options to it, so they can’t
make the system boot up in different run levels.
Make sure this file is owned by root.root and it
only has 600 permissions:

chown root.root /etc/lilo.conf
chmod 600 /etc/lilo.conf

Drive mounting

How to mount MS-DOS partitions

[ dual boot Windows and Linux, but [
Q have to mount my DOS partition each
time | boot up. How can I make it mount the
partition automatically when I boot up?

You need to add a line to /etc/fstab, similar to
the following:

/dev/hdal /mnt/des vfat
auto,noexec,umask=0002 0 0

That means, mount /dev/hdal (usually C:) in
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GMC provides you with a simple, graphical way to
organise your files

3

/mnt/dos using the vfat filesystem so you get long
filenames. The list of options forces it to be
mounted on boot; now set the exec bit on any files
and make files readable and writable by the root
user and the root group.

If you'd like other users to write to the drive,
add gid=103 where 103 is the group of users you
want to allow write access to.

Partitioning methods
How to partition a drive effectively

I have a 4.2Gb IDE drive which has three
Q FAT partitions on it. [ want to install
Linux into the last two, leaving 2Gb for
Windows, but I don’t know if I should create
more than (wo partitions. What's a good
partitioning strategy?

Depending on what you are going to do with

the installation, the partitioning methods can
change, but overall it’s best to create more than
two partitions, so you can keep your home
directories, mail and downloaded items should you
ever reinstall. Given 2.2Gb to play with, the
following partitions should prove adequate

50Meg = /
100Meg = /tmp
64Meg = /var

600Meg = /home

Distribute the rest between swap and /usr
depending on how much RAM you have in your
system, but 128Mb of swap won’t go amiss. You
may also want to create a small (10Mb or so)
/boot partition, which resides at the start of your
hard disk if you think you'll have problems

booting beyond the 1,024 cylinder limit.
31114 QUICKIES
Use shutdown -rnf 0 to reboot

[ without checking the partitions
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Linux and the Internet

How to create a Web site header using GIMP

How can | quickly create a simple, yet attractive, title image for my Web site
using Linux?

Step 5. Adding extras to the image
Before adding extras, create another layer
on your image, so you can manipulate the
parts without moving anything that you're
happy with.

For our first extra, we added a simple

The ideal tool for creating graphics is GIMP, which you'll find on our CD-
ROM (also see pages 50-55 for a tutorial).

Step 1. Decide how large you |&° iy text object of the domain name of our site.

want your title to be [ - After anchoring it, we reduced the

Depending on how your page is | s '—’J I transparency of it to around 50 per cent. We

structured, you may want a small ! ewk‘:?nem et 2 10 i then moved the main part of the title to the

square title or logo for a corner or a Test Giring W ; front, obscuring the extra slightly. Next, we | L -
central rectangular textual title. Once || Font 82 (pirels) fiog = ' added a ‘Layer Mask’ to our main logo layer,

you've got a rough idea of size, create | mm Harnul | setting the ﬁefault as white. ﬂj@ﬂ@ a | !
an image in GIMP using the File > A s | ' |
New menu, but make the image Starfing Bierd T Step 6. Create a radial blur

slightly larger than the final image will | ", . =~ - — Then, using the gradient tool, we created a

be so you've got a little room for : radial gradient, with the centre in the middle

experimentation. ' — % of the logo and in white, and the outer in a

Step 2. Pause to admire what you've just created
If you did the above, you should now have something that looks like the
fo[lowmg It’s now time to fancy it up a little.

light grey and ending at the horizontal edge i G
of the image. Experimenting with various B FalosG(Re) i |
types of gradients and colours will eventually ||Gradent: i £2] |

produce the result you want. We then applied Fepeat: None = I
the mask to the layer. EJMWM e .g... 1

Step 7. Adding some graphics

We added two more layers and then created
an ellipse-shaped object in the lower layer
and coloured the selected area. An identical
ellipse was created in the upper layer but
coloured in white.

Then, ensuring we'd selected the upper layer and the Move tool, we
moved the white ellipse up and slightly to the right, giving an effect similar
to that in the example. Adjusting the transparency for the coloured layer can
produce a softer feel to the graphic.

[~ [aso oo 0% ] S

Step 3. Pick the colours
If you've got a
plain coloured
background,
simply flood fill
the image with
that colour;
otherwise pick a -
base colour from o 7.0 (Rue) 100% I

Step 8. Producing the final image

At this stage you’ll probably want to save your creation as a .xcf, which is
the image format used by the GIMP when you want to retain the layers and
masks, so you can adjust individual layers in the image with ease later.

When you're sure your creation has been saved, Layers > Flatten
your tile. Image and either save it as a .jpg or go to Image > Indexed and then save
it as a .gif. |
Step 4. Add the central object 1 = e N
This could either be the main name of your site or a logo. If you want P B 0 A e e T e B

something a little more interesting, have a look at the Script-Fu options
(Xtns > Script-Fu > Logos) to see if anything there helps you. For our logo,
we use the ‘Textured’ script with
100pt Harquil font text. If you don’t
have the Harquil font, it's available
from www.gimp.org. Now the reni
image has been created, remove the
lower layers using the Layers >
Layers + Channels menu (right- | e o b 4 s
click on the image), then Merge the — '

Visible Layers using the menu on |
the Layers + Channels window. W C
After adding a channel to what . ¢

will become our Web site logo, paste |

the created text into it, then anchor
it using Ctrl-H. [Sesi=—

T
ssf 1|
iiiﬁ.-
Fi
[ ._

EACET T
_] = ot -0.0{RGH) 100% [ m

Your final Web-ready image — easy, eh!

.oo.o-.---ccoo..oooooocoooooooo.o..cooooooo..ooan-oo.o-o
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M System security

How to avoid always being root

If 1 want to shut down or reconfigure a
Q network card, 1 either have to su to root or
login as root, Although this works, I know it’s
considered bad practice to be root for too long.
Is there a way to do things as root without
actually logging in?

Option 1:

Rather than suing to root, and then running
the command, run the command through su, as
follows below:
su - -¢ “shutdown -h 0"

and this will shut down the system.

Option 2:

A far more expandable and secure method is to
use ‘sudo’, which is available from
www.freshmeat.net. With this you can allow
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specific users or groups to run selected programs
as root. One of the main reasons this is more
secure is that you don’t have to type in your root
password to use it.

Once you've downloaded and installed sudo,
either run the visudo program or, if you think that
no one will use your system while you’re editing
the file, you can use another program to edit
/etc/sudoers. The example sudoers file is very well
commented, so you should have no problems
setting it up, but be sure you know who is in a
specific group if you allow an entire group to run a
set of programs (although you can deny access on
a per-user basis). Also, if you want to use programs
such as shutdown or ifconfig, you will need to add
the paths /sbin and /usr/sbin to your PATH
variable, like this:

export PATH=“$PATH:/usr/shin:/sbin”

TrueType fonts
How to use TTF fonts in Linux

I have a large collection of TrueType fonts
Q in Windows and [ would like to use them
in Linux. Is there a way to use TTF fonts in
X Windows?

The simplest way to do this is to run a second
font server called ‘xfstt’ obtainable from

Logging in without the command line

How to configure a graphical login

Until now, I've been running X using startx from the command line. |'ve noticed
that many systems let you login from X, so you don’t have to mess with the

command line. How do you do that?

You need to configure your system to run a display manager at boot time.
There are many available, including xdm, gdm and kdm. Here we’ll
concentrate on xdm as everyone is bound to have it.

Step 1. Check xdm runs

Kill off X if it's running and type xdm at the command line as root. If X
starts up and you get a big window in the middle asking for a username and
password, then it works. If not, examine the error messages to find out why.

Step 2. Make it pretty

The default xdm looks pretty horrible, so you probably want to spice it up a
bit. Edit the /etc/X11/xdm/Xsetup_0 file, which is executed when you run
xdm. You either need to set up a PATH variable or use absolute path names in
this file. Remember, at each stage you can run xdm to see what it looks like.
Once you've decided which programs you want to execute at runtime,
you'll need to edit /etc/X11/xdm/Xresources to change the colours and
fonts used in the login window. You can either use a hex colour triplet or an

X colour name for defining colours.

Step 3. Set Linux to run it at boot time

Now open your /etc/inittab and find the line that executes xdm -

nodaemon.

x:5:respawn:/usr/bin/X11/xdm -nodaemon

39

a
-

id:3:initdefault:
and change it to

id:5:initdefault:
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www.freshmeat.net. Once you've downloaded and
installed it, copy all your TrueType fonts to
/usr/ttfonts, but you can have them somewhere
else using the --dir=/path/to/tifonts option. Once
that is done, do:

xfsit —-sync
xfstt &

then in X, do:
xset fp+ unix/:7100

From now on, the fonts will be available from
any X application, such as Netscape or
WordPerfect. If you want it to use xfstt fonts all the
time, add the following line to your XF86Config file
in the ‘Files’ section:

FontPath “unix/:7 100"
then restart X to check it’s worked.

Alternatively, if you run Red Hat 6 or another
distribution that uses xfs with the TrueType
patches, you can just add the directory of ttf fonts
to your /eix/X11/config/fs file, cd to that
directory and run ‘ttmkdir’. Then do a In -sf

fonts.dir fonts.scale and, finally, restart
xfs with /etc/rc.d/init.d/xfs. LiNUX

| Even if you
don’t use
GNOME,
gdm makes
a rather
simple
display
manager

The 5 means that line is used for runlevel 5, so
further up your inittab find a line similar to:

It may be runlevel 4 on distributions other than Red Hat.
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I'd like to connect to the Web but...

How to troubleshoot a dodgy Net connection

I've been unable to get my Internet connection working under Linux. I've tried
with Red Hat 5.1 and 5.2, but to no avail.

A variety of applications are available for configuring your Internet

connection, including kppp and ezppp, but we’ll be doing it by hand so
we know exactly what’s going on. We've set it up for Freeserve, but similar
rules apply to nearly all ISPs that use PPP (Poini-to-Point Protocol), so
altering the scripts to fit shouldn’t be too difficult.

First, we need a /etc/ppp/options file. This contains all the command
line options you would normally pass to pppd such as which device to use
and which script to run for a dialler.

/etc/ppp/options:

connect ‘/usr/shin/chat -v -f /etc/ppp/chat-script’
asyncmap 0

criscts

defaultroute

modem

lock
miu 542
mru 542
115200
/dev/modem

:

|

|

i

:

i

1

Il

i

i
Ensure that /dev/modem is symlinked fo the correct /dev/ttySx device i

— this is a lot easier than changing all your configuration files later if you !
move your modem to a different com port. !
Next, we need a dialler script — you will need to adjust this for your ISP :
i

i

I

i

i

|

i

i

|

i

/etc/ppp/chat-script

ABORT ‘NO CARRIER’
ABORT BUSY

“ ATF1

OK ATDT08450796699
CONNECT ¢

ogin: USER.freeserve.co.uk
word: PASSWORD

A chat script is a list of expect and replies. For example, once we have
received OK, we will send the dialling command to the modem. With
Freeserve you use USER.freeserve.co.uk for your username; others will
just use your username. You could try connecting to the ISP using minicom if
you're unsure of what method your ISP uses, or you could ask your ISP for
some information about manually connecting to them.

The last file you need is used for authentication. Most I1SPs use PAP
(including Freeserve), but some such as BT Internet use CHAP
authentication. The only difference you need to worry about is that PAP
seitings go in /etc/ppp/pap-secrets and CHAP in /etc/ppp/chap-secrets.
The format for both files is:

USERNAME SERVER PASSWORD
So, for your Freeserve account, you would use:
USER.freeserve.co.uk * PASSWORD

We have to use * as a wildcard, as at this point we won’t have DNS working
S0 we can’t use *.freeserve.co.uk or similar. You also probably want to

900900 OPOPOOPOPOPOIOEOOOEOEODNOEOEODTOODOREOEO®

chmod all the /etc/ppp files that contain passwords to 660, so normal
users on your system can’t find out what your passwords are.

At this point, you should be able to connect to your ISP by running pppd
as root. Once we know the connection works, we need to configure DNS, so
we can resolve domain names. ppp-2.3.8 and higher support the automatic
setting of name servers from ISPs that tell you the server IPs when you
login, which Freeserve does. If you don’t have an ISP with that facility or you
have an older copy of ppp, you will need to set up your /etc/resolv.conf '
(that’s resolv, without an ‘e’) for your ISP

The first line of your /etc/resolv.conf should be a list of domains to
search. Unless you know what you're doing, you’ll similarly want:

search .

to make it search everything. Next, you will need to set your domain name.
For Freeserve, you would use

domain freeserve.co.uk

Now we have a list of nameservers. You can specify up to three
nameservers, but you must ensure that you use the correct IPs. The
nameserver configuration for Freeserve would be:

nameserver 194.152.64.35
nameserver 195.92.193.8

If you encounter problems when trying to connect to your ISP, do tail -f
/var/log/messages as root and it will log all the PPP operations, although
if you have an error in your chat script, you will need to edit
/etc/syslog.conf to log chat.* to /var/log/messages. You may also see it
trying to load modules such as ppp-compress-21 and similar. You need to
add the following lines to /etc/conf.modules:

alias ppp-compress-21 bsd_comp
alias ppp-compress-24 ppp_deflate
alias ppp-compress-26 ppp_deflate

You may also get a char-major-108 module error when using ppp-2.3.9 on
a 2.2.x kernel, so add the following line to /etc/conf.modules:

alias char-major-108 off

Obviously, you don’t want to type pppd every time you want to connect to
the Internet, so you need a simple dialler application. Before you start
looking for one, you will need ppp-on and ppp-off scripts. These probably
came with your ppp installation package, usually in the documentation
directory (/usr/doc/ppp-2.3.”).

If they are there, copy them to /usr/bin as root. You should now be able
to start and stop your ppp connection as root by simply typing ppp-on and
ppp-off, which is what the diallers usually expect.

However, if you want to start and stop ppp as a normal user, you will
need to SUID your pppd binary. As root, issue the following command:

chmod +s ‘which pppd’

You can now start pppd as any user on the system, but you can only stop it |
as either that user or root. For a dialler, | use the GNOME panel dialler |
applet, which is a simple pair of buttons which you click to start and stop |
the connection. Another option is to use a window maker dockable applet, |
such as wmppp, to do it.
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Your complete
Linux starter kit

Quit wondering if Linux is for you — load it
and see for yourself. Matt Kynaston explains
how to run these great applications

IT'S ON
THE €D

1
I
1
I
!
i
1
[}
1
]
1
1
1
I

ow that you've installed Red Hat 6.0
from our Cover CD by following our
“Start here!” guide on page 16, it's time 1o
discover some of the many applications
that come bundled with it such as the
GIMP image-editing toolkit and Apache Web server.
Sce the installation guide on our CD for details of
how to choose which of these you want. This also
incorporates all the official updates that have been
released by Red Hat.

In addition to Red Hat, we've added a few extra
programs. They're in the [extras directory on the CD.
In the root of the CD there's a file called index.htm,
which gives a hasic introduction to the contents of
the CD and outlines what you'll find and where.

but you'll need to he root to do
it, and this quickly becomes a

chore. Far better is to run =
linuxconf (just type that at a \ %
terminal - you'll need to be root), | s 7=\
Then navigate the tree to File /

Systems/Access local drive. Click
on the /dev/cdrom entry, select the Options tab, and
click the User. mountable box. Click the Accept
button, then Quit. Activate the changes, then click
Quit again.

Now any user can mount the CD-ROM drive.
Before ejecting the CD, unmount it by Lyping:

Mounting your CD

Unlike Windows, in Linux you have to mount your
CD-ROM by hand, to access the files on it. You can
do that from a terminal window by typing:

mount -t is0926460 /dev/cdrom
/mnt/cdrom

umount /mnt/cdrom

Plus this top software

in Linux. Please remember,
it’s still under active
development - it won't run
absolutely everything, and
it might even crash on you
- but if there's a Windows
program or game you can't
live without, it's worth
giving WINE a try.

[ter squeezing WordPerfect on to the CD, we
found we still had a couple of megabytes to
spare. Rather than let them go to waste, we've filled

Missing a
Windows game
now that you've

Linux? Here’s
Unreal running
under WINE in

Linux

They're all in RPM format, so arc casy to install. Be
sure to check the software’s home page for extra
information and instructions.

1 WINE

Dir: extra/wine

I
1
I
I
|
I
switched to | them with a few of the utilities we use every day.
:
I
I
|
I

Web: www.winehq.com Licq Penguin ciat
| WINE stands for ‘Wine Is Dir: extrallicq with Licg.
Not an Emulator. Clever, Web: www.licg.org i“’“ I“’“ %
i 4 . e e S magine the
perhaps, but not ferribly ICQ (pronounced “I Seek You") is an Internet chat conversations

informative. If you really

{ must know, it's a Linux
replacement for the
Windows APIL. More
importantly, it enables you
to run Windows programs

protocol. And if you're a chatty type, Licq is well
worth exploring. Get one-on-one advice from a Linux
guru, ask what the weather’s like in Moosejaw or
trade salacious quips with mysterious strangers. But
do remember, this program is still under development
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Imwheel

Dir: extra/imwheel

Web: solaris1.mysolution.com/jcatki/imwheel/
In our KDE tips article (p56), we mention a program
called imwheel that enables you to use your
wheelmouse with Linux. Well we've saved you the
download by including it on the CD. See the article
for instructions on its installation and use.

More RPMs than an LP!

You will find all the Red Hat apps (over 600!) in the RedHat/RPMS folder |
on the CD. To install one, mount your CD-ROM drive, then type:

cd /mnt/cdrom/RedHat/RPMS

find the name of the package you want, then type:

rpm -Uvh <package name>

RealPlayer

Dir: extra/realplayer
Web: www.real.com/

RealNetworks' G2Player.

Wish you could get streaming media over the Net
from Linux? You can with this version of

to install it. You can abbreviate the package name using the * wildcard to
save typing out all the version number. For example:

rpm -Uvh xtrojka*
installs xtrojka, a Tetris-like game. See page 64 for more details.

How Corel makes Linux easier to use

Corel WordPerfect 8 for Linux

Corel’s WordPerfect word processing program has
garnered much respect from the Windows
community for its power and ease of use. Earlier
this year Corel made it available on Linux, and it
has since become the word processor of choice
for many Linux users. We've included it on the
Linux Answers CD-ROM, and you can find it in
the /corel folder.

Installing WordPerfect 8

WordPerfect doesn’t come as an RPM package,
which makes it slightly trickier than usual to
install. There are two parts to the program — the
core files, which you must install first, and
various language modules, installed second. In
this example, we’ll install the main program and
the UK English language module.

There are also language modules for French,
Dutch, Italian and German on the CD (more are
downloadable from http://linux.corel.com/).

Open a terminal window and create a temp
directory in your home directory with the
following command:

mkdir SHOME/tmp

Now mount your CD-ROM and go to the /corel
folder on the CD:

mount /mnt/cdrom
cd /mnt/cdrom/corel

Copy the main part of the program to your home
directory, then move there with these commands:

cp guilg00.gz SHOME/tmp
cd SHOME/tmp

The files are compressed in a format similar
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With WordPerfect, Corel has brought its world-class
word processor to the Linux desktop. Woo hoo!

to Windows ZIP files. Uncompress them with the
following commands:

gunzip guilg00.gz
tar -xvf guilg00

Now run the installer:
./Runme

You'll be asked whether you've unzipped the
files you've downloaded. Hit y for yes. After
accepting the licence agreement, you'll be
prompted for a directory to install it to. Type
/usr/local/corel in the dialog box. Next you'll
be asked for a ‘Pattern Directory’. As you haven't
installed WordPerfect before, leave the box blank
and click OK.

Click OK to accept the defaults in the
following windows, until you’re prompted to
select a printer. Find yours in the list, click on it,
and then click OK.

Software problems

Unfortunately, due to the complex nature of the software on
this CD, we are unable to provide technical support. If you do
have problems with the software, visit the peplus.linux
newsgroup. Alternatively, consult the extensive collection of
HOW-TO files on the CD or visit www.linuxcare.com, which
specialises in providing support for the Linux community.

Any comments!

Send your comments and suggestions for improvements to
Linux Answers, Future Publishing, 30 Monmouth Street,
Bath, BA1 2BW.

Defective CDs
In the unlikely event of your CD being physically damaged,
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To launch WordPerfect, you'll need to type the
following command:

/usr/local/corel/wpbin/xwp

But that’s a lot of work. If you’re using KDE
for your desktop, follow the directions in the KDE
tips article on page 56 for adding Netscape to
your desktop but create a shoricut to /usr/
local/corel/wpbin/xwp instead of Netscape.

Once you're finished, you can delete all the
files in your tmp directory with this command:

rm -f $HOME/tmp/*

Now we can install the UK Language Module,
following the same basic steps:

cd /mni/cdrom/corel

cp guilguk0.gz SHOME/tmp
cd SHOME/tmp

gunzip guilguk0.gz

tar -xvf guilguk0

./Runme

The prompts are almost exactly the same as
in the original installation — be sure you specify
the same directory to install to as you specified
above: /usr/local/corel. Once you're done, open
the KDE link you created on your deskiop, and
add the following to the Program section:

/usr/local/corel/wpbin/xwp -lang uk

Now WordPerfect will always use the UK
Language module.

Note: this version of WordPerfect is free for
personal use, but requires registration. If you do
not register within 90 days, it will cease to work.

we'll send you a new, working version within 28 days. Send
your defective disc — complete with your name, address, and a
description of the faull - to:

Returns Dept
Bluecrest, 272 Field End Road, Eastcote,
Ruislip HA4 9NA.
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Au revoir...

Reader feedback

We need
your help!

e're only a wee stripling of
a magazine and il we're
going to take root and
grow into a mighty oak,
we need some
nourishment, which is where you can help.
We need you to tell us what you like and
dislike about the magazine. Have we got the
balance right? Is there enough of the type of
stuff you want to read about? Is there too
much stuff you don’t want to read about?
Do let us know. :
Either fill in the short coupon below and
send it in, or fill in the form at
www.linuxanswers.co.uk. Many thanks!

And what of the future!?

We hope, if this issue does as well as we
believe it will that we'll be back after
Christmas in one form or another. So get

those responses in. Tell us what you want together and hopefully we'll be back soon
from us in future, visit our Web site, get with more!

your mates to buy this issue and we'll be Please send your completed form to:
back! Thanks to all those members of the Linux Answers, Future Publishing,

Linux community who helped put this mag 30 Monmouth Street, Bath BA1 2BW.
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TR b et i ot R S Ol TR W S B TR Y !
JobRitez i i iamasbaes !
Would you:buy another 1SsUel ...t aiiiniiin vt it nsirasssinees I
What do you hate most about the Magazine?.............c.c.ccouvereiviiirniicsereessesseeesesesesens !
What do you like most about the magazine? ............ccccociiiiiinneniiiisiessessensesrensseeesen l
Please tick the sections below: I
More Just rlgi_ll _I_ess_ : _Hore l_ufl r_i_ghll *_Less. .
CD software _ [ | | GIMP project || _ | [ | :
Mission Critical | | | | | KDE tips _ M- 190
The source | | [ | Linux tutorials [ I . I (}
User groups | || | Recompile the Kernel ' _ i
Paul Ferris . l Get more from Linux tips |
Previews | | Technical help .
Reviews _ | I8 Overall beginner’s- .
Batch test L1 | || | typeinformation :
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Open the Window and

nothing's there: IT fable

g nce upon a time there was an emperor who insisted that
everyone should live in a fancy palace behind huge gates
with a gaudy door and elaborate window.

Every time the emperor changed, everybody else had to change -
especially the way they worked.

Then one day a penguin came along that didn’t know how important
the emperor was supposed to be. The penguin walked right
through the big gates and entered the fancy palace but there was
nothing inside. The penguin peeped behind the gaudy doors but
all the cupboards were bare.

Just to make sure, the penguin peered through each elaborate
window. But there was nothing worth looking at.

Moral; there’s more to IT when you follow the penguin.
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Xinit make Linux work for your business Or contact us @

Xinit Computer Systems
327 Whitechapel
Technology Centre

65 Whitechapel Road

Tel: +44 (0) 207 247 4761

‘ ‘ Fax: +44 (0) 207 247 1428
We offer a wide range of x-86 based systems, to handle just about any E-mail: sales@xinit.co.uk

computing task. All our systems are rigorously tested to ensure perfect pu @

working order belforne shipping. For details please visit our web site: . N / . -
http://www.xinit.co.uk o LML;!—

Xinit make Linux work for your business by dedicating our business 100%
to Linux unlike those whom offer Linux as well. We also understand
that you might not want to go the whole way initially. So we will
support it as part of your multi-operating systems environment if you
prefer supplying and installing it alongside Windows, Unix or Mac.
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